Active Technologies, EDA, EDA/SQL, FIDEL, FOCUS, Information Builders, the Information Builders logo, iWay, iWay Software, Parlay, PC/FOCUS, RStat, Table Talk, Web390, WebFOCUS, WebFOCUS Active Technologies, and WebFOCUS Magnify are registered trademarks, and DataMigrator and Hyperstage are trademarks of Information Builders, Inc.

Adobe, the Adobe logo, Acrobat, Adobe Reader, Flash, Adobe Flash Builder, Flex, and PostScript are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Due to the nature of this material, this document refers to numerous hardware and software products by their trademarks. In most, if not all cases, these designations are claimed as trademarks or registered trademarks by their respective companies. It is not this publisher’s intent to use any of these names generically. The reader is therefore cautioned to investigate all claimed trademark rights before using any of these names other than to refer to the product described.

Copyright © 2018, by Information Builders, Inc. and iWay Software. All rights reserved. Patent Pending. This manual, or parts thereof, may not be reproduced in any form without the written permission of Information Builders, Inc.
## Contents

**1. Creating Content** ............................................................. 13

- Generating Sample Content .................................................... 13
- Generating Sample Content Overview ........................................ 14
- Analyzing Sample Content ....................................................... 17

- Creating Reports .................................................................... 23
  - Choosing a Report Output ..................................................... 24
  - Downloading InfoAssist Report Data to Excel (CSV) Format .......... 25
  - Using Procedure Settings .................................................... 26

- Creating Charts ..................................................................... 32
  - Chart Outputs. .................................................................... 35
  - Binning. ............................................................................. 35
  - Binning Values in a Histogram. .............................................. 40

- Using Insight to Analyze Dynamic Charts ..................................... 43
  - Working With Charts in Insight ........................................... 46
  - Searching for Fields ......................................................... 51
  - Changing Summary Operators for the Field ............................. 51
  - Filtering in Insight ............................................................ 53
    - Types of Filters. ............................................................... 54
    - Adding a Filter ................................................................. 57
    - Removing a Filter ............................................................. 58
  - Using the Options Toolbar .................................................... 58
  - Using Insight in Phone Mode .............................................. 63
    - User Options in Phone Mode .............................................. 64
      - Filtering ................................................................. 64
      - General Usability ......................................................... 65

- Selecting a Chart Type .............................................................. 65
  - Bar Charts. ....................................................................... 65
  - Bar Chart Types. ................................................................. 67
  - Pie Charts. ....................................................................... 67
  - Pie Chart Types. ................................................................. 68
  - Line Charts. ..................................................................... 69
  - Line Chart Types. ............................................................... 70
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Multi-Page Documents</td>
<td>111</td>
</tr>
<tr>
<td>Creating Multi-page Documents</td>
<td>112</td>
</tr>
<tr>
<td>Creating a Multi-page Active Technologies Dashboard</td>
<td>112</td>
</tr>
<tr>
<td>Navigating the Page Menu</td>
<td>113</td>
</tr>
<tr>
<td>Using the Active Cache Option</td>
<td>114</td>
</tr>
<tr>
<td>Enabling Active Cache Through InfoAssist</td>
<td>114</td>
</tr>
<tr>
<td>Building Visualizations</td>
<td>114</td>
</tr>
<tr>
<td>Creating a Visual</td>
<td>115</td>
</tr>
<tr>
<td>Changing the Visual Type</td>
<td>116</td>
</tr>
<tr>
<td>Selecting a Visual</td>
<td>117</td>
</tr>
<tr>
<td>Grids</td>
<td>119</td>
</tr>
<tr>
<td>Bar Charts</td>
<td>121</td>
</tr>
<tr>
<td>Line Charts</td>
<td>123</td>
</tr>
<tr>
<td>Area Charts</td>
<td>125</td>
</tr>
<tr>
<td>Pie Charts</td>
<td>126</td>
</tr>
<tr>
<td>Ring Pie Charts</td>
<td>128</td>
</tr>
<tr>
<td>Scatter Charts</td>
<td>130</td>
</tr>
<tr>
<td>Bubble Charts</td>
<td>131</td>
</tr>
<tr>
<td>Matrix Marker</td>
<td>133</td>
</tr>
<tr>
<td>Treemaps</td>
<td>134</td>
</tr>
<tr>
<td>Gauges</td>
<td>135</td>
</tr>
<tr>
<td>Heatmaps</td>
<td>136</td>
</tr>
<tr>
<td>Interacting With Visualizations</td>
<td>137</td>
</tr>
<tr>
<td>Minimizing or Maximizing a Visual</td>
<td>143</td>
</tr>
<tr>
<td>Renaming a Visual</td>
<td>144</td>
</tr>
<tr>
<td>Using Paper-Clipping to Group Values in a Visual</td>
<td>145</td>
</tr>
<tr>
<td>Using Multi Drill in Visualization Mode</td>
<td>152</td>
</tr>
<tr>
<td>Creating Matrix Charts</td>
<td>153</td>
</tr>
<tr>
<td>Using Active Technologies</td>
<td>158</td>
</tr>
<tr>
<td>Active Technologies Report Overview</td>
<td>158</td>
</tr>
<tr>
<td>Security Features</td>
<td>161</td>
</tr>
<tr>
<td>Handling a Large Amount of Data</td>
<td>162</td>
</tr>
<tr>
<td>Distribution and Viewing Considerations</td>
<td>162</td>
</tr>
</tbody>
</table>
Contents

Usage Notes for Active Technologies ........................................ 164
Creating an Active Technologies Report .................................... 167
Active Technologies Report Menu Options ................................. 167
Active Technologies Cell Menu Options .................................. 171
Configuring Active Technologies Report Options ....................... 172
  General Tab ......................................................... 173
  Menu Options Tab ................................................ 173
  Colors Tab .......................................................... 175
  Advanced Tab ...................................................... 176
Freezing Column Headings in Active Reports ............................... 177
Creating an Active Technologies Chart ..................................... 180
Active Technologies Options for Charts ................................... 181
Creating an Active Technologies Dashboard ............................... 184
Active Technologies Dashboard Prompts ................................... 184
Target Reports ........................................................ 185
Using Multiple Reports as Targets and Sources ......................... 186
Using Navigation Options for Reports ..................................... 194
Creating Maps to Illustrate Trends ......................................... 195
  InfoAssist and Esri Integration .................................... 197
  Configuring an Esri On Premise Environment ......................... 200
  Creating and Customizing Maps in InfoAssist ......................... 202
Customizing the List of Geographic Roles .................................. 220
Customizing the List of Basemap Definitions ............................. 230
Adding a Custom Basemap ............................................... 230
Building InfoMini Applications ........................................... 234
  Understanding InfoMini Applications ................................ 234
  Using the InfoMini Button ........................................ 235
  Understanding the InfoMini Layout ................................ 236
Creating an InfoMini Application ......................................... 237
Viewing Data Behind Visuals ............................................... 238
  Creating Multi-Y Axis Comparative Visuals .......................... 240
Creating HOLD Files .................................................. 242
  Valuable Applications of HOLD Files ................................ 242
Storing HOLD Files ............................................................. 242
Output Formats for Reports ..................................................... 242
Creating Hold Files ............................................................. 243
  FOCUS Format Index Fields ................................................ 246
Creating a Subquery Filter Using a HOLD File.............................. 246
Working With Alerts ................................................................ 247
Alert Reporting ...................................................................... 247
Components of an Alert ........................................................ 248
  Alert Assist Overview .......................................................... 250
  The Life of an Alert .............................................................. 254
Creating and Scheduling an Alert ................................................. 256
Checking Scheduled Alerts ...................................................... 262
Using Sample Data to Create and Schedule an Alert ...................... 262
Creating Reporting Objects ..................................................... 269
Reporting Object Tool .......................................................... 270
  Running a Reporting Object From the Browser ......................... 273
    Expected Behavior of Running a Reporting Object .................. 274
  Properties of a Reporting Object ......................................... 274
  Components of a Reporting Object ...................................... 275
Preprocessing Other Component .............................................. 275
Joins ................................................................................. 277
Virtual Fields (DEFINE Statements) .......................................... 279
Filters ............................................................................... 281
Selection Criteria (WHERE Statements) ...................................... 284
Report Component ............................................................ 285
Chart Component .............................................................. 285
Postprocessing Other Component ........................................... 286
Creating Shortcuts and URLs .................................................. 287
  Creating Shortcuts ............................................................ 287
  Creating URLs .................................................................. 288
Creating Blogs ...................................................................... 290
Working With Portal Pages .................................................... 291
  Page Designer Overview ..................................................... 292
Page Designer Interface .................................................. 293
Page Templates.......................................................... 294
Application Menu......................................................... 295
Quick Access Toolbar ..................................................... 295
Ribbon. .................................................................. 296
Layout Tab. ................................................................ 296
  Preview Group...................................................... 296
  Page Group. .......................................................... 297
Insert Tab. ................................................................ 297
Style Tab. ................................................................ 298
  State. ................................................................... 298
  Background. ............................................................. 298
    Image. .................................................................. 298
    Repeat. ................................................................. 299
    Position. ............................................................... 299
    Background Color. ............................................... 299
    Reset Background. ............................................... 299
  Border. ................................................................ 299
    Style. .................................................................. 299
    Width. ................................................................. 300
    Color. ................................................................. 300
    Reset Border. ..................................................... 300
  Font. .................................................................... 300
    Color. .................................................................. 300
    Reset Font. .......................................................... 300
Canvas.................................................................. 301
Properties Panel.......................................................... 301
Breadcrumb Trail ......................................................... 301
Page Components........................................................ 302
  Portal Page Properties............................................... 302
  Columns. ................................................................ 303
  Containers. .............................................................. 303
  Panels. .................................................................. 304
Series Tab. ............................................................... 410
Ribbon Commands for Visualizations. ............................................. 411
Home Tab. ............................................................... 411
Format Tab. .............................................................. 413
View Tab. ................................................................ 415
Field Tab. ................................................................ 416
Series Tab. ................................................................ 417
Creating Content

Create reports, documents, charts, and interactive visualizations using the available features and functionality.

In this chapter:

- Generating Sample Content
- Creating Reports
- Creating Charts
- Using Insight to Analyze Dynamic Charts
- Selecting a Chart Type
- Creating Your Own Chart Types
- Building a Document
- Creating Multi-Page Documents
- Building Visualizations
- Creating Matrix Charts
- Using Active Technologies
- Using Navigation Options for Reports
- Creating Maps to Illustrate Trends
- Building InfoMini Applications
- Viewing Data Behind Visuals
- Creating HOLD Files
- Working With Alerts
- Creating Reporting Objects
- Creating Shortcuts and URLs
- Creating Blogs
- Working With Portal Pages
- Working With the Business User Edition Portal
- Using WebFOCUS Designer
- Creating Report Queries With InfoAssist
- Ribbon Command Reference

Generating Sample Content

This topic describes how to generate sample content from uploaded or existing data using the Samples Generator. It also provides information about how to interpret and analyze the sample content.
Generating Sample Content Overview

The Samples Generator automatically generates a suite of analytic content based on uploaded Excel workbooks, CSV files, or existing single-segment Master Files in your repository. The Samples Generator populates your directory with sample charts, reports, and dashboards. Additionally, the suite contains charts and reports that provide quick and easy navigation through the levels of each available hierarchy. You can view, edit, or delete this content, or use it as a starting point to create new dashboards.

The Samples Generator feature is useful to the novice user, because it introduces all major analytic content types in the InfoAssist toolset. Depending on the structure of your source worksheet or synonym, the Samples Generator automatically creates the following items:

- **Active dashboards:**
  - Initial Dashboard
  - Initial Dashboard by Year

  **Note:** This item is only generated if your source dataset includes an eligible date, which contains data for minimum three unique months.

- **Reports:**
  - Auto-drill report starting at the top of each identified hierarchy
  - Overview accordion report
  - Overview active report

- **Charts:**
  - Pie chart
  - Bar chart
  - Line chart

  **Note:** Line charts are only created if your source dataset includes an eligible date, which contains data for minimum three unique months.

The dashboards, auto-drill reports, overview accordion report, and overview active report are stored in the Analytics folder. All other items are placed in the folders that are named after the measures for which they are created. The content may vary depending on the structure and size of your synonym.
To see the most complete suite of analytical content, it is recommended that you use a data source that contains at least four measures, six dimensions, and data for a minimum of three unique months. Additionally, a record count called Trans appears in the sample content, if there are not sufficient measures available for analysis.

**Note:** Virtual fields, such as COMPUTE and DEFINE, are not eligible for selection as dimensions or measures in the generated content.

The following image shows an example the suite of sample content generated from a synonym on the Home page.

![WebFOCUS Home page](image)

**Note:** If you generate sample content more than once from the same source worksheet or synonym in the same location, the Samples Generator creates a new folder with an underscore and number appended to the title. For example, if a retail_sample folder already exists in a domain or folder, a new folder with the new set of content is created and titled retail_sample_1. The number is incremented each time you repeat this action.

You can generate sample content from one of the following ways:

- By navigating to the Sample Content option on the Home page, for access to existing data.
- By uploading an Excel spreadsheet or CSV file and selecting the Gain Insight option at the end of the upload procedure.

**Procedure:**  **How to Generate Sample Content From the Home Page**

1. On the Home page, select a domain or folder, and then click *Sample Content*.

   The Open dialog box opens.
Note: Only single-segment Master Files are displayed for selection.

2. Locate a single-segment Master File that you want to use for generating sample content and click Open.

The new folder with the same name as your Master File appears in your chosen directory. It contains sample charts, reports, and dashboards.

Procedure: How to Generate Sample Content From the Upload Wizard

1. Upload a spreadsheet, as described in Uploading and Appending Spreadsheets.

After the Upload procedure is complete, a selection screen opens, as shown in the following image.

![Selection Screen](image)

Note: Generating sample content on Master Files uploaded to a temporary folder, such as FOCCACHE, may produce unexpected results.

2. Click Automatically generate content from your data.

The sample content is generated in the same folder that you selected for your upload.
Analyzing Sample Content

The following section provides a closer look at each content type, and explains how this content is generated. These examples have been generated using the retail_data_extract.xlsx spreadsheet that is provided with your installation.

Initial Dashboard by Year

The Initial Dashboard gives you a quick overview of your data. It is comprised of three charts and one report, as shown in the following image. Additionally, it displays a drop-down menu, which allows you to narrow down your results to a specific year. The Initial Dashboard by Year is only generated if your source worksheet or synonym includes an eligible date, which contains data for a minimum of three unique months.

The bar chart is generated from the first measure and first dimension in the source spreadsheet or synonym. It shows the Top 10 values.

The first pie chart is generated from the second measure and second dimension. It shows the Top 5 values.
The second pie chart is generated from the third measure and third dimension. It shows the Top 5 values.

The active report shows an overview of all measures and dimensions in the source worksheet or synonym.

**Initial Dashboard**

The Initial Dashboard is identical to the Initial Dashboard by Year, with the exception that the year drop-down menu is not displayed.

**Auto-drill reports**

The auto-drill reports are generated for each of the identified hierarchies in the synonym. For example, if your data set contains three hierarchies, the Samples Generator automatically creates three auto-drill reports and one overview auto-drill report. In each auto-drill report, the first four measures in the data set will be summed up by the dimension values in the hierarchy. The report also features data bars and grand totals for each dimension in the hierarchy. The name of the hierarchy is reflected in the title of the report. For example: Dimension_Auto_Drill_Report.fex where Dimension is the top level of the hierarchy. The following image shows an example of an Overview Auto-Drill Report.

<table>
<thead>
<tr>
<th>Country</th>
<th>Year</th>
<th>Product Category</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>2012</td>
<td>Accessories</td>
<td>3,957</td>
<td>2,653</td>
<td>1,314</td>
<td>15</td>
</tr>
<tr>
<td>Camcorder</td>
<td>4,057</td>
<td>2,503</td>
<td>1,554</td>
<td>15</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Computers</td>
<td>4,315</td>
<td>2,917</td>
<td>1,398</td>
<td>17</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Player</td>
<td>11,656</td>
<td>9,053</td>
<td>2,603</td>
<td>35</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>13,152</td>
<td>9,431</td>
<td>3,721</td>
<td>51</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Production</td>
<td>1,698</td>
<td>1,205</td>
<td>493</td>
<td>7</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| Year | Accessories | 149,408 | 102,379 | 47,029 | 577 |
| Camcorder | 151,166 | 96,371 | 54,795 | 538 |
| Computers | 154,166 | 114,529 | 40,637 | 599 |
| Media Player | 293,922 | 225,838 | 67,184 | 949 |
| Stereo Systems | 323,902 | 229,324 | 94,578 | 1,214 |
| Televisions | 81,027 | 61,986 | 19,038 | 94 |
| Video Production | 58,771 | 40,569 | 18,212 | 220 |
Click one of the links to drill-down to the lower level, as shown in the following image. You can use the breadcrumbs to navigate back to the original report.

### Overview Accordion Report

The Overview Accordion Report provides a way to control the amount of sorted data that appears on a page with the expandable views of data for each vertical sort field. It contains up to three dimensions and the first four measures that are found in your source synonym. The report displays the total values for each measure. The following image shows an example of an Overview Accordion Report.
Overview Active Report

The Overview Active Report contains one BY field for each dimension. The report displays a maximum of six dimensions and four measures. The total values are displayed for each measure. Each field features a drop-down menu, where you can access active report options. The Overview Active Report is always generated and resides in the Analytics folder. The following image shows an example of an Overview Active Report.
Pie Charts

The Samples Generator uses the first four measures to create Pie charts, by pairing these measures with up to three different dimensions found in the source synonym. Each pie chart shows the Top 10 values. The number of pie charts may vary depending on your synonym structure. The following image shows an example of a pie chart created by the Samples Generator.
Bar Charts

The Sample Generator creates bar charts for each measure paired with up to three different dimensions. Each bar chart shows all values in the dataset for that dimension. If there are more values than can be displayed on the screen, a scrollbar appears. The number of bar charts may vary depending on the structure of your synonym. The following image shows an example of an automatically generated bar chart.
Line Charts

Line charts are only generated if your source dataset includes an eligible date, which contains data for a minimum of three unique months. If this data is present in the dataset, a line chart is created for each measure. The following image shows an example of a line chart.

Creating Reports

You can use the following procedures to create a basic report.

Procedure: How to Create a Report From the Portal

After you have signed in to WebFOCUS Business User Edition, you can work with an existing Domain folder, or create a new Domain folder on the Home page to store your reports.

1. On the Home page, select a folder or domain where you want to create your content.
2. On the actions bar, click Report.
   InfoAssist opens.
3. From the Open dialog box, select the data source that you want to use, and click OK.
   The data source that you selected appears in the Data pane.
4. Drag fields onto the canvas or into the Query pane to begin building your report.
Procedure: How to Create a Report From the Application Main Menu

1. In the upper-left corner of the InfoAssist interface, click the IA button to open the Application Main Menu.

2. From the Application Main Menu, click New.
   The InfoAssist splash screen opens.

   The Open dialog box opens.

4. From the Open dialog box, select the data source that you want to use, and click Open.
   The data source that you selected appears in the Data pane of the Resources panel.

5. Drag fields onto the canvas or into the Query pane to begin building your report.

Procedure: How to Create a Report From the Quick Access Toolbar

1. On the Quick Access Toolbar, click the New icon.
   The InfoAssist splash screen opens.

   The Open dialog box opens.

3. From the Open dialog box, select the data source that you want to use, and click Open.
   The data source that you selected appears in the Data pane of the Resources panel.

4. Drag fields onto the canvas or into the Query pane to begin building your report.

Procedure: How to Create a Report From an Existing Chart

1. Open the chart that contains the data that you want to present in a report.

   The data is presented as a report.

Choosing a Report Output

The following output types are available for reports:

- HTML
- active report
- PDF
Excel

PowerPoint

Note: When you create a report in Document view, you have access to Excel only.

When you create a report in Live Preview or Query Design view, you have access to the following Excel output types:

- **Excel (xlsx)**. Outputs the report in Excel 2007 (and higher) format.
- **Excel**. Outputs the report in Excel format.
- **Excel Formula (xlsx)**. Outputs the report, using Excel formulas that calculate and display the results of any type of summed information, such as column totals, row totals, and subtotals. This format is for Excel 2007 (and higher).
- **Excel Formula**. Outputs the report, using native Excel formulas for totals and computed values.
- **Excel (csv)**. Outputs the report to .csv format. This enables you to capture your data and work with it in an external program, such as Microsoft Excel.

### Downloading InfoAssist Report Data to Excel (CSV) Format

When working with data in a report, you can download it into Excel (CSV) format. This enables you to capture your data and work with it in an external program, such as Excel.

When you use the File option to create a HOLD file from your report the output file is placed on the WebFOCUS reporting server. For users who do not have access to their reporting server this approach allows the data to be delivered directly to their desktops.

**Note:** You can select the Excel (CSV) output format in User Preferences, if you want to make this output format the default for each time you enter InfoAssist.

**Procedure:** How to Download InfoAssist Report Data to Excel (CSV) Format

1. Open InfoAssist in Report mode.
2. Create a report.
3. On the ribbon, in the Output File Format list, click the right arrow next to Excel (xlsx) and then select Excel (csv), as shown in the following image.

4. On the Quick Access toolbar, click Run to run the report. The CSV will be presented for download using the standard interface of your specific browser interface.

Using Procedure Settings

Procedure Settings, also known as SET commands, enable you to specify and control items for inclusion in a procedure. If you want to include a Procedure Setting in a procedure (.fex), select the relevant check box to include that setting in the procedure (.fex). Procedure Settings are available in Report, Chart, and Document mode.
You can access Procedure Settings from the Quick Access toolbar. When you click Procedure Settings, the Procedure Settings dialog box displays, allowing you to select the options to apply to your procedure, as shown in the following image.

![Procedure Settings dialog box](image)

Options include:

- **Collation Sequence (COLLATION).** Establishes a binary or case-insensitive collation sequence. Options include Code Page (default), Binary, Case-Sensitive, and Case-Insensitive. This value will not be written into the procedure (.fex), by default. Therefore, you must select the check box to prompt this action.

- **Summary Lines (SUMMARY LINES).** Allows you to combine fields with and without prefix operators on summary lines in one request. Options include New (default value), Old, and Explicit. This value will not be written into the procedure (.fex), by default. Therefore, you must select the check box to prompt this action.

- **Missing Value (NODATA).** Specifies the missing data characters to be printed in a report. This is a text box with a default value of period ( . ). Common entries include N/A or NONE. In addition, this field has a limit of six characters. This value will not be written into the procedure (.fex), by default. Therefore, you must select the check box to prompt this action.
**Note:** You can use amper (&) variables in the Missing Data field to allow the entry of values at run-time. In general, valid values include any string or amper (&) variable, which will print automatically. You can use &xx to activate autoprompt. For example, you can use &NONE to specify a value at run-time. In Live Preview, this value is set to _FOC_NULL or as many characters that will fit in the width as defined by the existing values in a column. Global variables (&&x) should not be entered as they do not activate autoprompt. Mixing strings with amper (&) variable can result in Focus error messages. For example, &&&&N& or &nn&n&).

- **Decimal Notation (CDN).** Ensures the correct display of currency for the target language. Radio buttons include On and Off (default value).

- **HTML Encode (HTMLENCODE).** Controls whether HTML tags are encoded when these tags are stored within the actual data or when they are created using a DEFINE or COMPUTE command. Radio buttons include On (default value) and Off. This option is selected for inclusion in the procedure (.fex), by default (the check box is selected), as it is not a default setting of the Reporting Server.

- **Empty Report (EMPTY REPORT).** Controls the output generated when a TABLE request retrieves zero records. Radio buttons include On (default value) and Off. When set to On, an empty report (column headings with no content) is generated. When set to Off, no report is generated. This option is selected for inclusion in the procedure (.fex), by default (the check box is selected), as it is not a default setting of the Reporting Server.

**Note:** In Report mode, all settings apply. In Chart mode, only Collation Sequence (COLLATION), Decimal Notation (CDN), and Empty Report (EMPTYREPORT) settings are applicable. In Document mode, Procedure Settings apply to the whole document. These settings are currently unavailable in Visualization mode.
Procedure: How to Create a Procedure Using the Missing Value Option

1. Create a report with a dimension, a measure, and an across sort field that shows missing values, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Month</th>
<th>3 Revenue Per Sq. Ft.</th>
<th>4 Revenue Per Sq. Ft.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Charger</td>
<td>1,973</td>
<td>6,204</td>
<td>$63.63</td>
</tr>
<tr>
<td>Headphones</td>
<td>4,245</td>
<td>13,463</td>
<td>$1,190.61</td>
</tr>
<tr>
<td>Universal Remote Controls</td>
<td>3,340</td>
<td>10,639</td>
<td>$750.19</td>
</tr>
<tr>
<td>Camcorder</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Handheld</td>
<td>4,575</td>
<td>14,636</td>
<td>$548.54</td>
</tr>
<tr>
<td>Professional</td>
<td>242</td>
<td>755</td>
<td>$602.19</td>
</tr>
<tr>
<td>Standard</td>
<td>3,510</td>
<td>11,263</td>
<td>$1,049.08</td>
</tr>
<tr>
<td>Computers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Smartphone</td>
<td>3,622</td>
<td>11,413</td>
<td>$734.88</td>
</tr>
<tr>
<td>Tablet</td>
<td>3,102</td>
<td>8,134</td>
<td>$619.59</td>
</tr>
<tr>
<td>Media Player</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Blu Ray</td>
<td>12,623</td>
<td>40,707</td>
<td>$3,762.71</td>
</tr>
<tr>
<td>DVD Players</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Streaming</td>
<td>1,264</td>
<td>4,107</td>
<td>$111.49</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Home Theater Systems</td>
<td>7,405</td>
<td>23,315</td>
<td>$1,300.07</td>
</tr>
<tr>
<td>Receivers</td>
<td>2,767</td>
<td>8,730</td>
<td>$857.60</td>
</tr>
<tr>
<td>Speaker Kits</td>
<td>4,542</td>
<td>14,332</td>
<td>$1,691.64</td>
</tr>
<tr>
<td>iPod Docking Station</td>
<td>5,863</td>
<td>18,348</td>
<td>$859.48</td>
</tr>
<tr>
<td>Televisions</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Flat Panel TV</td>
<td>1,709</td>
<td>5,427</td>
<td>$1,156.59</td>
</tr>
<tr>
<td>Video Production</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Video Editing</td>
<td>3,744</td>
<td>11,881</td>
<td>$920.19</td>
</tr>
</tbody>
</table>

Note: The highlighted area indicates the default ( . ) for missing values.

2. On the Quick Access toolbar, click Procedure Settings.

3. Select the Missing Value check box.

4. In the Missing Value text box, enter the characters to be used to represent missing values in your report. For example, NONE.

Note: By default, this is set to ( . ). However, common examples include N/A or NONE.

5. Click OK.
Fields with missing values are indicated by the word NONE, in this case, as that is what was specified. This value is shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Month</th>
<th>3</th>
<th>Revenue Per Sq. Ft</th>
<th>4</th>
<th>Revenue Per Sq. Ft</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>1,973</td>
<td>6,204</td>
<td>$43.63</td>
<td>1,747</td>
<td>$5.50</td>
</tr>
<tr>
<td></td>
<td>Headphones</td>
<td>4,245</td>
<td>13,463</td>
<td>$1,160.61</td>
<td>3,483</td>
<td>$12,178</td>
</tr>
<tr>
<td></td>
<td>Universal Remote Controls</td>
<td>3,340</td>
<td>10,639</td>
<td>$760.19</td>
<td>2,995</td>
<td>9,581</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>4,657</td>
<td>14,696</td>
<td>$848.54</td>
<td>4,256</td>
<td>13,490</td>
</tr>
<tr>
<td></td>
<td>Professional</td>
<td>242</td>
<td>756</td>
<td>$882.19</td>
<td>216</td>
<td>748</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>3,610</td>
<td>11,263</td>
<td>$1,049.08</td>
<td>3,291</td>
<td>10,409</td>
</tr>
<tr>
<td>Computers</td>
<td>Smartphone</td>
<td>3,622</td>
<td>11,413</td>
<td>$734.85</td>
<td>3,178</td>
<td>10,291</td>
</tr>
<tr>
<td></td>
<td>Tablet</td>
<td>3,102</td>
<td>8,134</td>
<td>$819.50</td>
<td>3,368</td>
<td>8,858</td>
</tr>
<tr>
<td>Media Player</td>
<td>Blu Ray</td>
<td>12,623</td>
<td>40,707</td>
<td>$3,762.71</td>
<td>11,421</td>
<td>36,130</td>
</tr>
<tr>
<td>DVD Players</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td>Streaming</td>
<td>1.364</td>
<td>4,167</td>
<td>$111.40</td>
<td>1,314</td>
<td>3,696</td>
<td>$93.69</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>7,405</td>
<td>23,315</td>
<td>$1,360.07</td>
<td>6,599</td>
<td>21,120</td>
</tr>
<tr>
<td></td>
<td>Receivers</td>
<td>2,767</td>
<td>8,730</td>
<td>$857.80</td>
<td>2,477</td>
<td>8,080</td>
</tr>
<tr>
<td></td>
<td>Speaker Kits</td>
<td>4,542</td>
<td>14,332</td>
<td>$1,661.64</td>
<td>4,620</td>
<td>13,117</td>
</tr>
<tr>
<td></td>
<td>iPod Docking Station</td>
<td>5,883</td>
<td>18,348</td>
<td>$869.46</td>
<td>5,147</td>
<td>16,836</td>
</tr>
<tr>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>1,709</td>
<td>5,427</td>
<td>$1,165.50</td>
<td>1,591</td>
<td>4,992</td>
</tr>
<tr>
<td>Video Production</td>
<td>Video Editing</td>
<td>3,744</td>
<td>11,881</td>
<td>$920.18</td>
<td>3,317</td>
<td>10,774</td>
</tr>
</tbody>
</table>

6. Save the procedure.

**Procedure:** How to Create a Procedure Using the Empty Report Option

1. Create a report with one or more measures and two dimensions.

2. Add a filter to create an empty report by filtering on a value that does not exist in the dimension that you select.

**Note:** The addition of a filter condition causes your report to have no records, and the default behavior (EMPTYREPORT=ON) displays the heading and column titles.
The following image shows an empty report.

3. On the Quick Access toolbar, click Procedure Settings.
   **Note:** This option is selected, by default. Notice that Empty Report can be set to On or Off. When enabled and set to On, the shell of the report (headings and titles) will be displayed. If the setting is turned off, the environment default will be used.
5. Click OK.
   When the Empty Report check box is cleared, no report is generated, as shown in the following image.
6. Save the procedure.

Creating Charts

On the Format tab, the Chart Types group provides buttons for each of the five most commonly-used chart types. These include Bar (default), Pie, Line, Area, and Scatter. You also have access to Esri Choropleth and Proportional Symbol maps. A button labeled Other gives you access to the complete chart library of advanced charts.

The Chart Types group is shown in the following image.

![Chart Types](image)

When switching between chart formats that use a different syntax, you are prompted with a message that allows you to proceed with the change, or cancel your request. This message is shown in the following image.

![Chart Attributes Modified](image)

On the Chart Attributes Modified dialog box, you can click Yes to accept the changes or click No to save the changes to a different file and preserve the originating procedure (.fex).

**Procedure**: How to Create a Basic Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.

   The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

**Procedure:** How to Create an Advanced Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click Other.
   The Select a chart dialog box opens. The chart types, depicted by icons, display on the left side of the dialog box.
2. To display the name of a chart type, hover over the chart type with the mouse.
   From top to bottom, the chart type categories are Bar, Line, Area, Pie, XY Plots, 3D, Stock, Special, HTML5, Map, and HTML5 Extension.
   **Note:** For streamgraphs, which are in the HTML5 category, the tooltip has been enhanced to display specific information, by data point, depending on the underlying data source.
3. Click a chart type.
   All supported variations of the chart type appear as thumbnail images in the dialog box.
4. Click an image to display a detailed description of that chart type.
   If you are not familiar with a chart type, be sure to read the description carefully before finalizing your selection. Some chart types require a certain number of data values, or a certain type of data values. If your data does not satisfy the requirements, the chart will not accurately represent the data.
   You can also hover over an image with your mouse to display the chart type name.
5. In the Select a chart dialog box, click OK to finalize your selection and close the dialog box.
6. Populate the chart with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

**Procedure:** How to Create a Combination Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.
The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

3. Change a series type in one of the following ways:
   - **Ribbon:** On the Series tab, in the Select group, select the series that you want to display in a different chart type. Then, in the Properties group, from the Type drop-down menu, select the chart type.
   - **Shortcut Menu:** Right-click the series that you want to display in a different chart type, point to Series Type, and click the chart type.

   The series appears in the new chart type.

**Procedure:** How to Create a Dual-Axis Chart

When you create a dual-axis chart, you assign one data series to the Y1 axis and another data series to the Y2 axis.

**Note:** This applies to charts in HTML format. If you are creating a dual-axis chart in HTML5 format, the field containers are labeled Vertical Axis 1 and Vertical Axis 2. If your chart is horizontal, the field containers are labeled Horizontal 1 and Horizontal 2.

1. Create a chart.
2. On the Format tab, in the Chart Types group, click Other.
   - The Select a chart dialog box opens.
3. Select a dual-axis chart, such as dual-axis bar, and then click OK.
4. Drag one field onto the Y1 field, and then drag another field onto the Y2 field.

**Procedure:** How to Create a Multi-Axis Chart

When you create a multi-axis chart, you assign one data series to the Y1 axis and another data series to the Y2, Y3, Y4, and Y5 axes (as needed).

**Note:** This procedure is specific to HTML format.

1. Create a chart.
2. On the Format tab, in the Chart Types group, click Other.
   - The Select a chart dialog box opens.
3. Select a multi-axis chart, and then click OK.
4. Drag fields onto the Y1, Y2, Y3, Y4, and Y5 fields, as needed.

Chart Outputs

You can create charts using one of the following output formats:

- HTML
- HTML5 (default)
- active report
- PDF
- Excel
- PowerPoint

The HTML5 output format allows you to render a chart in the browser using a built-in JavaScript engine. Charts with this output format utilize the very latest capabilities of the HTML5 Web standard, including animation, high-quality vector output, and attractive alpha-channel and gradient effects.

Note: Not every chart type can be output in every format listed here. To make sure that the chart that you are creating can be output in the format that you want, please see the topic for that particular chart type.

Binning

Binning is a powerful tool for analyzing your data using ranges that you define.

Binning enables you to determine the frequency of values across the entire range of values. It is used for analyzing a frequency distribution. With binning, you can create discrete buckets of continuous data that control how groups of your data display. In addition, binning gives you the ability to review trends and spot outliers.
For example, you can review the range of expenses incurred by households. In the following example, these ranges are represented by bins that are grouped by $1000. In this case, you can see that the largest number of households had the smallest expense (16) while the trend declines as the bin size gets larger. With binning, you can see the frequency of how often values in a range appear across the different groupings, as shown in the following image.

In InfoAssist, bins are automatically created for Histograms. You can change the size of your bins to meet the requirements of your data. For example, if your data has very large values (for example, in billions) you might want to create larger bins. You can also create bins manually in Vertical bar charts and reports.

**Note:** When creating a bin, the format of the bin and the value set for the Width of Bins must be compatible. If the Width of Bins is a large decimal value, define the field format to match the format of the field being converted so that the bins can be successfully generated with the appropriate numeric precision.

Binning is available for the different output types, including reports, charts, and visualizations, depending on how you choose to display and analyze your data.

**Procedure:** **How to Use Binning in a Vertical Bar Chart**

1. Open InfoAssist in Chart mode.
2. In the Query pane, right-click the chart component and change Sum to Count, as shown in the following image.
3. Add a measure, such as Households, to the Vertical Axis field container.

4. From the Data Pane, right-click the same measure and click Create Bins.

5. In the Create Bins dialog box, accept the default bin value and click OK.

6. From the Data pane, drag the bin into the Horizontal Axis field container.
   The chart displays showing the bins along the x-axis, as shown in the following image.

7. Save the chart.
   You can edit the bin size to meet your requirements for grouping and display.

**Procedure: How to Edit an Existing Bin**

1. Open a report, chart, or visualization that contains a bin.

2. From the Dimensions group, in the Data pane, right-click the existing bin and click Edit Bins.
   The Edit Bins dialog box opens, as shown in the following image.

   ![Edit Bins dialog box]

   **Note:** If you are working with a report, chart, or visualization where the bin is specified and therefore displays in the Query pane, the position of the Edit Bins field in the shortcut menu appears in a different location.

3. Optionally, change the name of the field for the bin, and click Format to edit the formatting that you want to change (for example, currency).

4. In the Width of Bins field, specify a value that meets your display requirements.
5. Click OK.

**Procedure:** **How to Create Bins for Reporting**

You can create bins in reports, which lets you view the detail behind a chart or histogram. You can optionally switch between report and chart as you perform your analysis. This allows you to review the actual values that fall into each bin.

1. Create a report.

2. In the Query pane, on the Report component, change Sum to Print, as shown in the following image.

3. Right-click the measure on which to bin, and click *Create Bins*.

4. In the Create Bins dialog box, set the width of the bins and change any formatting options (for example, currency).

5. Click *OK*.

6. In the Data pane, double-click the bin to add it to your report.
The report displays showing the bin assignments per value, as shown in the following image.
7. Optionally, you can change the Print and By field assignments to view the Households values by bin, as shown in the following image.

### Binning Values in a Histogram

Histograms graphically represent the distribution of numeric data. They facilitate the identification and discovery of the underlying frequency distribution within a set of continuous data. You can use histograms to identify trends and illustrate categorizations, or groupings, also known as bins. For more information, see [Binning](#) on page 35.

Histograms use bins to group data. Bins allow you to establish a range of values for your data. For example, you can review how the bins are designated when you consider the age of everyone in your company. In the first table, you can review the bins (using the default value of 10) and counts for each bin.

<table>
<thead>
<tr>
<th>AGE</th>
<th>COUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-9</td>
<td>0</td>
</tr>
<tr>
<td>10-19</td>
<td>5</td>
</tr>
<tr>
<td>AGE</td>
<td>COUNT</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>20-29</td>
<td>26</td>
</tr>
<tr>
<td>30-39</td>
<td>351</td>
</tr>
<tr>
<td>40-49</td>
<td>460</td>
</tr>
<tr>
<td>50-59</td>
<td>310</td>
</tr>
<tr>
<td>60-69</td>
<td>285</td>
</tr>
<tr>
<td>70-79</td>
<td>22</td>
</tr>
<tr>
<td>80-89</td>
<td>3</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1462</strong></td>
</tr>
</tbody>
</table>

In the second table, you can review the same data for the bins (with a bin width of 15) and counts for each bin. Notice that as the bin size gets larger, more employees fall into these different ranges.

<table>
<thead>
<tr>
<th>AGE</th>
<th>COUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-14</td>
<td>0</td>
</tr>
<tr>
<td>15-29</td>
<td>31</td>
</tr>
<tr>
<td>30-44</td>
<td>611</td>
</tr>
<tr>
<td>45-59</td>
<td>510</td>
</tr>
<tr>
<td>60-74</td>
<td>296</td>
</tr>
<tr>
<td>75-89</td>
<td>14</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1462</strong></td>
</tr>
</tbody>
</table>

When you create a histogram in either Chart or Visualization mode, a bin is created automatically for the measure you select. When working with bins, you can change the width of the bin by editing it. In the Query or Data pane, right-click a bin field and click *Edit Bins* to change the value that dictates the width or format of the contents of the bin.
The bin value is designated as a dimension field, since it is a limited field with a discrete set of possible values that was created from a field with an unlimited, continuous range of values. The measure displays as a count (.CNT) field and the related bin is created in the Query pane. It is also placed in the Data Pane for future use.

**Procedure:** How to Create a Histogram with Automatic Binning in Chart Mode

1. Open InfoAssist in Chart mode.
2. On the **Format** tab in the **Chart Types** group, click **Other**.
3. In the Bar group of charts, click **Vertical Histogram**.
4. Click **OK**.
5. From the Data pane, drag a measure into the Measure field container in the Query pane. A histogram is automatically created using the measure you selected along with a generated bin, as shown in the following image.

![Histogram in Chart Mode](image)

**Note:** This process produces the same results as if you had created the histogram manually, however it automatically converts the measure to a count (.CNT) field. It also creates the bin for you, placing it on the x-axis, accordingly.

**Procedure:** How to Create a Histogram with Automatic Binning in Visualization Mode

1. Open InfoAssist in Visualization mode.
2. On the **Home** tab, in the **Visual** group, click **Change**.
3. In the Select a Visual dialog box, click **Histogram**.
4. From the Data pane, drag a measure into the Measure field container in the Query pane.
A histogram is automatically created using the measure you selected along with a generated bin, as shown in the following image.

You can optionally edit the bin to change its width or format. For information on building a histogram manually, in Chart mode, see *Binning* on page 35.

**Using Insight to Analyze Dynamic Charts**

In InfoAssist, you now have access to a number of visualization tools: Chart mode, Visualization mode, and Insight. Each tool offers different options for you as you visualize your data.

Insight is a new visualization tool that allows for the interactive selection of measures and dimensions, so you can create dynamic charts that refresh as you make changes. This feature is available in HTML5 Chart mode only.

With Insight, you can build a chart that shows the data fields that you choose in real-time. It even rebuilds as you select additional fields or specify filters.

Similar to Visualization mode in InfoAssist, you can make quick decisions regarding your data with Insight. Using logical menus and simple filtering, you can build charts interactively to suit your needs. As you select additional fields and create filters, your chart refreshes instantly, letting you see the results of your data choices as you use the tool.

In Visualization mode, you can create and work with multiple charts in a single visualization. All charts in the visual are linked to the same data source. You can use the filter prompts to narrow the data that displays.
Insight lets you build filters, as needed, to customize the data that displays. You can add and remove fields, at any time and in any pattern, to enhance your chart. You can take advantage of the customization options that are available to you right from the toolbar.

With Insight, the chart type determines the field containers that display. For example, if you are working with a pie chart, you can specify values for the following field containers: Measure, Rows, Columns, Color, and Size. In many cases, these field containers mirror the field containers that display when working with InfoAssist.

Available fields are organized into applicable Dimension and Measure categories. You can use the plus sign to add additional fields to your chart. For example, if you want to create a bar chart that plots Gross Profit, Revenue, and MSRP for each Product Category, click the plus sign to add fields using the drop-down field selector. Once you choose the fields that you want to include, you can rearrange them by dragging and dropping them into the order that you prefer.

The resulting bar chart displays, as shown in the following image.

![Bar Chart Example](image_url)

You can use the navigational arrows in the interactive header to move between the available field containers in your chart. The following image highlights these arrows, which shift the focus of these field containers to the right or left.
All charts support a field container for Color, which adds contrast to your chart. Some charts also support the Size field container, which binds a measure to the size of the markers rendered on the chart.

Once you have added fields to the relevant field containers, you can use the Sort arrows adjacent to each field to sort the data in ascending or descending order. This helps identify trends and priorities within your data. You can only sort one field at a time. Ascending order sorts your data from the smallest value to the greatest value, while descending order sorts your data from the greatest value to the smallest value, as shown in the following image.

When you select a sort order for a field, the field arrow changes color, appearing bolder than the unsorted fields. In the image below, a sort order was selected for MSRP, so the field arrow appears black.
You can specify measures and dimensions for your chart in InfoAssist before using Insight. This pre-loads the Insight user interface (UI) with those selections. Optionally, you can use Insight without selecting any fields. In this case, the field selection options are broad, meaning that all fields will be presented. An example of an empty canvas is shown in the following image.

---

**Procedure**: How to Enable Insight From InfoAssist

1. Open InfoAssist in Chart mode.

2. On the Format tab, in the Run with group, click the Insight icon.

3. On the Quick Access toolbar, click Run.

   The Insight interface opens, and you can begin building your chart.

**Working With Charts in Insight**

With Insight, you can choose individual fields for the field containers that you add. Whether you added fields into the Query pane before running Insight or you added fields to the existing field containers (or field containers that you add), creating a chart in Insight is streamlined to allow you to easily create a dynamic chart in real time. It also provides you with the flexibility of interactive comparison as you change your data selections rapidly and adjust the options for display.
You can use the default vertical bar chart or you can specify a different chart type using the Chart Picker in the Options toolbar.

In addition, you can re-order the display of field containers in your chart. This allows you to change the placement of a particular field, giving you control over where the data for this component displays in your chart.

**Procedure:** How to Create a Basic Bar Chart Using Insight

1. Click the plus icon under the Vertical Axis field container.
2. Choose a measure field from the drop-down list.
3. Click the plus icon under the Group field container.
4. Choose a dimension field from the drop-down list.

Your bar chart displays, as shown in the following image.

![Bar Chart Example](image-url)

**Procedure:** How to Change the Chart Type in Insight

1. On the Options toolbar, click Chart Picker.
The table of chart selections opens, as shown in the following image.

2. Select a chart type.

Your chart refreshes with the new chart type, and the Insight interface refreshes to display all of the field containers that are relevant to the current chart type.

**Procedure:** How to Delete a Field From a Field Container

1. Add one or more fields to your chart.
2. Hover over the field that you want to delete and click X, as shown in the following image.

The chart refreshes to reflect your selections.

**Procedure:** How to Reorder the Display of Field Containers

1. Add multiple fields to your chart, as shown in the following image.
2. In the Vertical Axis grouping, drag the second field container into the first position. The placement of the field is shown by a dark blue vertical bar, as shown in the following image.

The following image shows the newly ordered fields.
Searching for Fields

You can locate fields for your field containers using the search option. On the toolbar, click the plus sign. In the search field, start typing the field that you want to locate. You can type in whole words or partial words. The search identifies all fields that contain any instance of the characters that you specify, as shown in the following image.

![Search for Fields](image)

Changing Summary Operators for the Field

When working with measure fields, you can change the summary operators for the field from Summary (default) to Average, Maximum, or Minimum. You can also change a Count field to Count Distinct, using a similar menu selection.
When you make a selection, the axis of the relevant measure updates in the chart, as shown in the following image.

Options for changing the Summary field are shown in the following image.
Filtering in Insight

To enable filtering, click the Show Filter icon, which is located in the Options section of the toolbar. This opens the filter shelf that renders above the field container shelf, as shown in the following image.

Use the filter shelf to build your filter. The filter shelf must be visible in order to add or modify a filter. In addition, filters that were created in a procedure (.fex) or InfoAssist session prior to launching Insight are applied, but do not show in Insight.
**Note:** As of Release 8.2 Version 03, query variables in Insight are available and functional on the Filter shelf. Typically, query variables display in the Data pane, above the measure fields. The filter values display as True or False, rather than one and zero. In addition, you can only select one value, as shown in the following image.

### Accessories

<table>
<thead>
<tr>
<th>All</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
</tr>
</tbody>
</table>

- **Select all**
- **Clear**

<table>
<thead>
<tr>
<th>True</th>
</tr>
</thead>
<tbody>
<tr>
<td>False</td>
</tr>
</tbody>
</table>

**Types of Filters**

There are different types of filters in Insight. For example, if you are filtering with a date field, you can use a built in calendar to select a date range, as shown in the following image.

### Sale Date

<table>
<thead>
<tr>
<th>All</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>2009/04/01</th>
<th>2012/12/31</th>
</tr>
</thead>
</table>

#### April 2009

<table>
<thead>
<tr>
<th>Su</th>
<th>Mo</th>
<th>Tu</th>
<th>We</th>
<th>Th</th>
<th>Fr</th>
<th>Sa</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>6</td>
<td>7</td>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
</tr>
<tr>
<td>12</td>
<td>13</td>
<td>14</td>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
</tr>
<tr>
<td>19</td>
<td>20</td>
<td>21</td>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
</tr>
<tr>
<td>26</td>
<td>27</td>
<td>28</td>
<td>29</td>
<td>30</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### December 2012

<table>
<thead>
<tr>
<th>Su</th>
<th>Mo</th>
<th>Tu</th>
<th>We</th>
<th>Th</th>
<th>Fr</th>
<th>Sa</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
<td>3</td>
<td>4</td>
<td>5</td>
<td>6</td>
<td>7</td>
</tr>
<tr>
<td>8</td>
<td>9</td>
<td>10</td>
<td>11</td>
<td>12</td>
<td>13</td>
<td>14</td>
</tr>
<tr>
<td>15</td>
<td>16</td>
<td>17</td>
<td>18</td>
<td>19</td>
<td>20</td>
<td>21</td>
</tr>
<tr>
<td>22</td>
<td>23</td>
<td>24</td>
<td>25</td>
<td>26</td>
<td>27</td>
<td>28</td>
</tr>
<tr>
<td>29</td>
<td>30</td>
<td>31</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
If you are filtering on a numeric value, such as a measure value, you can filter on values that are specific to a field. In this scenario, when you define the filter, a slider control opens. You can adjust the range of values that you want to include, using the slider control options, as shown in the following image.

You can also filter on dimension values. You can select one or more values by simply clicking on multiple values. A check mark appears, indicating the values selected, as shown in the following image.
You can select all values for the dimension, select one or more, or clear all selected values, as shown in the following image.
Adding a Filter

You add a filter when you want to limit the display of your data, or drill down to focus on specific data values. For example, you may want to just display data for Camcorder and Televisions, rather than all Product Categories. You can do this by adding a filter for the Camcorder and Televisions, as shown in the following image.

**Procedure:** How to Add a Filter in Insight

1. In the Options toolbar, click *Show Filter*.
   
   The filter shelf opens.

2. Click the Show Filter icon.

3. From the drop-down list that opens, select the field on which to filter.

4. Click the identified field in the filter shelf to specify a value for the filter.
   
   A list displays, showing the values that you can select.

5. Click on the filter shelf to save your filtered items.
   
   Your chart refreshes.
Removing a Filter

To remove a filter, hover over it and click on the X, as shown in the following image.

![Filter Removal Image]

The chart refreshes and displays your data without any filter.

Using the Options Toolbar

The Options toolbar is located in the upper-right corner of the Insight interface. These options control your interactions with your data, including options such as pivoting and filtering. You can also change your chart type using the Chart Picker option.

Reference: Options Toolbar Icons

The following section describes the icons that display on the Options toolbar.

- **Reset**
  
  Returns the chart to its original state. Any filters, measures, dimensions that are added in the current Insight session are reverted. The chart type is reverted, as well.

- **Swap Axis**
  
  Swaps the x and y axis, placing the contents of the x axis on the y axis. You can click Swap Axis again to change the chart back to its original orientation.
Save
Saves the current Insight chart as a unique entry in the repository. When you click Save, you are presented with a list of folders. Navigation is limited to where you can save content. The default folder is your My Content folder. You can save the same Insight chart multiple times. Insight uses the same title and file name. You will then be prompted to overwrite the file.

Chart Picker
Provides options for selecting different chart types, including:

- **Horizontal Bar.** Offers the capability of ranking data in descending order. This chart type can also be used when x-axis labels are too long to fit legibly side-by-side. The following field containers are available for this chart type: Horizontal Axis, Group, and Color.

- **Vertical Bar.** Shows different measures per dimension component using different identifying colors. The following field containers are available for this chart type: Vertical Axis, Group, and Color.

- **Vertical Stacked Bar.** Stacks values per dimension component using differentiating colors. The following field containers are available for this chart type: Vertical Axis, Group, and Color.

- **Pie.** Presents values as part of a whole using colors to separate the segments. Pie charts emphasize where your data fits in relation to the larger whole. The following field containers are available for this chart type: Rows, Columns, Measure, Color, and Size.

- **Vertical Line.** Creates a line chart which is representative of the data. Line charts are useful for showing trends in numerical data. The following field containers are available for this chart type: Vertical Axis, Group, and Color.
Area. Creates an area chart which is similar to a line chart except the area between the data line and the zero line (or axis) is usually filled with color. The following field containers are available for this chart type: Vertical Axis, Group, and Color.

Scatter. Plots data using variable scales on both axes. The following field containers are available for this chart type: Rows, Columns, Vertical Axis, Horizontal Axis, Size, Detail, and Color.

Note: When working with Insight Scatter or Bubble Charts, the "Show Datalabels" ability is tied to the Size bucket. Therefore, you will only see datalabels if there is a measure in the Size field container.

Circle. Plots differing values in rows, enabling you to draw inferences as to how the values overlap. The following field containers are available for this chart type: Rows, Columns, Vertical Axis, Horizontal Axis, Size, Detail, and Color.

Treemap. Displays large amounts of hierarchically structured data. This chart type uses sections to represent an aspect of the selected measure. The following field containers are available for this chart type: Grouping, Size, and Color.

Histogram. Analyzes the distribution of a measure while assigning it to field containers based on the values you specify for the bins that are created. The default bin count is 10. The following field containers are available for this chart type: Rows, Columns, and Measure.

Table. Presents data in tabular form, allowing you to compare various intersections in your data. The following field containers are available for this chart type: Rows, Columns, and Measure.

Matrix. Analyzes one or two measures against a crosstab of two categorical dimensions. The following field containers are available for this chart type: Rows, Columns, Size, and Color.
Point Map. Uses symbols of different sizes to represent data associated with different areas or locations within the map. The following field containers are available for this chart type: Layer, Size, and Color.

Choropleth Map. Visualizes location-based data, trends, and distributions across a geographic area. These maps are geographically-based heat maps. The following field containers are available for this chart type: Layer and Color.

Note: The orientation of this chart icon changes if you swap an axis. In addition, the image that displays for the chart type changes, based on your selection.

Show Filter
Defines filters for your data. Select this icon, and using the filter shelf that opens above the field container shelf, click the Show Filter icon to define a filter. For more information, see Filtering on page 64.

Note: To select one or more non-consecutive values, select each field. The selected values will display with a check mark to indicate that they have been selected.

More Options
Opens the following additional options:

- Export Data. Exports the underlying data of the current chart to an Excel file in LOCAL file storage. You will be alerted when the file appears in the bottom left corner, similar to any other file that you download.

- Export Image. Generates an image of the current chart, which is saved in PNG format to LOCAL file storage using the current width and height of the browser window.

- Series Layout. The bar, line, and area charts in Insight support several different sub-graph types (aka Layout). The supported graph types include: horizontal bar, vertical bar, vertical stacked bar, line, and area charts. For bar, line, and area charts, the Series Layout Options are as follows:
  - Horizontal Bar: Stacked, Absolute, Percent, Side-by-Side
  - Vertical Bar: Stacked, Absolute, Percent, Side-by-Side
  - Vertical Stacked Bar: Stacked, Absolute, Percent, Side-by-Side
  - Line: Stacked, Absolute, Percent
- **Vertical Stacked Area**: Stacked, Absolute, Percent

- **Y-Axis Log Scale**. Adjusts the log scale on the y axis. This option is always unchecked, by default. The following chart types are supported:
  - Horizontal Bar
  - Vertical Bar
  - Vertical Stacked Bar
  - Line
  - Area charts
  - Scatter charts
  - Bubble
  - Circle
  - Histogram

- **X-Axis Log Scale**. Adjusts the log scale on the x axis. This option is always not selected, by default. The following chart types are supported:
  - Scatter
  - Bubble

- **Change Bin Size**. Changes the size of the bin (numeric value only). This option is only available for histograms. Clearing the text box switches it back to automatic bin size generation.

- **Show Data Label**. Turns numeric Data labels on/off on all charts, except Grids. The default for this setting is always Off except for Treemaps.

- **Show Totals**. Turns the Summary Row Total on Data Grid on or off. The default for this setting is always False.

- **Marker Shape**. Changes the marker shape used in the matrix marker chart. Options include: Circle, Square, or Fill.
Using Insight in Phone Mode

Phone mode, which is available in Insight, allows you to take advantage of the features of Insight on your phone. The interactive heading that is available in Insight on a tablet or desktop is replaced by a static heading that displays the field names in the chart, in blue text. These become summary fields that allow you to see what fields are included in the chart.

Insight is mobile aware and mobile friendly. Full functionality is available on tablet devices and other high-resolution touch displays. On smaller devices, such as an iPhone, Insight enters a special phone mode which has a useful, but more limited, set of options and features that are tuned for the small screen real-estate of the device. In this mode, you can add or modify filters to narrow your data as needed. You can also hover over data points to see the underlying data.

Measures are shown first. The first measure displays with a summation attribute (for example, Sum or Avg) and then displays of and then the name of the measure, as shown in the following image.

In the above image, area one is the static heading. Area two marks the filtering side option button. Lastly, area three shows the conbody of the chart.
Numeric measures are displayed after the measures in the order of Y-Axis and then X-axis. If you define fields in your Grouping field container, they display after the collective measures and are preceded by the word *by*. If you have created a matrix marker chart, the relevant field containers for these display next. They also use the word *by*, as do any Detail field containers that are populated in the chart. If your chart specifies a field for color, Phone mode precedes the display of this item with *color by*. Lastly, if you have populated the Size field container, this displays last and is introduced by *size by*.

**User Options in Phone Mode**

You have a number of options in Phone mode, including robust filtering and hover capabilities.

**Filtering**

In Phone mode, you can filter just like in regular desktop mode. The primary difference is that the filter shelf stacks the available filters in a vertical row, as shown in the following image.

You click the filter icon to bring up the filter shelf and then you click the X to close it. If you have defined filters, closing the filter shelf merely collapses it. The filters that you defined remain intact. To remove a filter, hover over it and click the X in the upper-right corner.
General Usability

Phone mode allows you to view your chart and filter it to refine it based on your own unique scenario.

You can hover over a data bar a segment of a chart to obtain additional, detailed information from the underlying data. The tooltips that display are based on your data selections.

You can also show and hide the legend using the right arrow above the legend. When you collapse the legend, you can see more of your chart.

The opportunities for dynamic charting are vast with Insight. Using dynamic menus, filtering options, and search features, you can quickly and effectively create charts that communicate your data.

Selecting a Chart Type

InfoAssist provides a complete chart library of both basic and advanced charts. You can choose from a wide variety of charts to best represent the data that you want to display.

It is important that you choose a chart that is appropriate for your data. When working with chart types in the Other category, which is available in the Chart Types group on the Format tab in Chart mode, you can quickly access a description for each chart, simply by hovering over the chart type with your mouse in the Select a chart dialog box. This facilitates quick identification of the relevant chart type, making it easy to create the right type of chart based on your data.

Note:

- To change the chart type of a migrated chart procedure that contains bar, line, or area charts, click the Type button on the Series tab, instead of the Format tab.

- As of Release 8.2 Version 02, the new chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. In InfoAssist, specific field containers display for each chart type. For information on the field containers for charts, see Field Containers for Charts and Visualizations.

Bar Charts

Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis). The length of a bar corresponds to a value or amount. You can clearly compare data series (fields) by the relative heights of the bars. Use a bar chart to display the distribution of numerical data. You can create horizontal and vertical bar charts.
Note:

- If you are working with a large dataset, you can enable the display of a scroll bar under your chart, allowing you to easily scroll through your data from left to right. If you want to enable, disable or re-enable scroll bars, click the Format tab and then click Interactive Options. In the Interactive Options dialog box, select the Auto Enable X-Axis Scrolling check box.

- When working with stacked bar charts in either Chart or Visualization mode, borders can be enabled to show each series or measure in the chart. When enabled, the borders outline each measure in a stacked bar chart. This allows you to differentiate between the measures when they are displayed using the same color on a riser.

You can specify a border for all series in the Style dialog box, which is accessible from the Series tab.

When to use: Use a bar chart when individual values are important. For example, a basic vertical bar chart can compare the individual products sold to the total amount in sales for each product. A retailer would find it important to know which pieces of inventory are selling and how much revenue each item is generating for the company.

The following image is an example of a bar chart showing gross profit and quantity sold by product category.
A *horizontal bar chart* becomes useful when you want to emphasize a ranking relationship in descending order, or the X-axis labels are too long to fit legibly side-by-side. For example, a basic horizontal bar chart can rank in descending order which products are generating the most revenue for the retailer.

**Bar Chart Types**

The following table lists the available bar chart types.

<table>
<thead>
<tr>
<th>Available Bar Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Clustered Bar</td>
</tr>
<tr>
<td>Vertical Stacked Bar</td>
</tr>
<tr>
<td>Vertical Dual-Axis Clustered Bar</td>
</tr>
<tr>
<td>Vertical Dual-Axis Stacked Bar</td>
</tr>
<tr>
<td>Vertical Bi-Polar Clustered Bar</td>
</tr>
<tr>
<td>Vertical Bi-Polar Stacked Bar</td>
</tr>
<tr>
<td>Vertical Percent Bar</td>
</tr>
<tr>
<td>Vertical Histogram</td>
</tr>
<tr>
<td>Vertical Waterfall</td>
</tr>
<tr>
<td>Vertical Multi-3Y Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Multi-4Y Bar (Not in HTML5)</td>
</tr>
</tbody>
</table>

**Pie Charts**

A pie chart is a circular chart that represents parts of a whole. A pie chart emphasizes where your data fits, in relation to a larger whole. Pie charts work best when the data consists of several large segments. As a best practice, limit your pie chart to five measure fields. Too many measure fields can divide a pie into many thin components that could become difficult to see. Use color on individual segments to create visual contrast.
In addition, you can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:**

- When working with pie charts, you can add one measure field to the Color field container. This adds the measure as a By field, and determines how the pie chart is colored. Depending on your measure data, this may result in a large number of pie segments.

- You cannot plot negative data on a pie chart.

**When to use:** Use a pie chart when you have several large segments of data that you want to display as a whole.

For example, the following image is a pie chart showing the product revenue by sale quarter.

### Pie Chart Types

The following table lists the available pie chart types.
<table>
<thead>
<tr>
<th>Available Pie Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi Pie</td>
</tr>
<tr>
<td>Multi Ring Pie</td>
</tr>
<tr>
<td>Multi Proportional Pie (Not in HTML5)</td>
</tr>
<tr>
<td>Multi Proportional Ring Pie (Not in HTML5)</td>
</tr>
<tr>
<td>Single Pie</td>
</tr>
<tr>
<td>Single Ring Pie</td>
</tr>
<tr>
<td>Pie-Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Ring Pie-Bar (Not in HTML5)</td>
</tr>
</tbody>
</table>

**Line Charts**

Line charts are useful for emphasizing the movement or trend of numerical data over time. They allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited to a line chart.

You can also plot line charts with two or more scales to present a comparison of the same value, or set of values, in different time periods.

**Note:** If you are working with a large dataset, you can enable the display of a scroll bar under your chart, allowing you to easily scroll through your data from left to right. If you want to enable, disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box.

**When to use:** Use a line chart when you want to trend data over time. For example, monthly changes in employment figures, or yearly sales of an item in your inventory.
For example, the following image is a line chart that traces product revenue over a four-year period.

Radar charts are essentially analogous to line charts, except that the scale wraps around. Radar charts compare two or more data sets. They work well with data that is cyclical, such as the months of a year. A radar line chart is available in the line chart category, and a radar area chart is available in the area chart category. You can use axes or polygons to represent values in a star or spider configuration.

**Line Chart Types**

The following table lists the available line chart types.

<table>
<thead>
<tr>
<th>Available Line Chart Types</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Absolute Line</td>
<td>Horizontal Absolute Line</td>
</tr>
<tr>
<td>Vertical Stacked Line</td>
<td>Horizontal Stacked Line</td>
</tr>
<tr>
<td>Vertical Dual-Axis Absolute Line</td>
<td>Horizontal Dual-Axis Absolute Line</td>
</tr>
<tr>
<td>Available Line Chart Types</td>
<td></td>
</tr>
<tr>
<td>------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Vertical Dual-Axis Stacked Line</td>
<td></td>
</tr>
<tr>
<td>Vertical Bi-Polar Absolute Line</td>
<td></td>
</tr>
<tr>
<td>Vertical Bi-Polar Stacked Line</td>
<td></td>
</tr>
<tr>
<td>Vertical Percent Line</td>
<td></td>
</tr>
<tr>
<td>Radar Line</td>
<td></td>
</tr>
<tr>
<td>Horizontal Dual-Axis Stacked Line</td>
<td></td>
</tr>
<tr>
<td>Horizontal Bi-Polar Absolute Line</td>
<td></td>
</tr>
<tr>
<td>Horizontal Bi-Polar Stacked Line</td>
<td></td>
</tr>
<tr>
<td>Horizontal Percent Line</td>
<td></td>
</tr>
</tbody>
</table>

**Area Charts**

Area charts are similar to line charts except that the area between the data line and zero line (or axis) is usually filled with color. Area charts allow you to stack data on top of each other. Stacking allows you to highlight the relationship between data series, showing how some data series approach a second series.

**Note:** If you are working with a large dataset, you can enable the display of a scroll bar under your chart, allowing you to easily scroll through your data from left to right. If you want to enable, disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box.
When to Use: Use an area chart when you want to distinguish the data more dramatically by highlighting volume with color. For example, the following image is a stacked area chart depicting the gross profit, revenue, and quantities sold for products over a three-year time period.

Area Chart Types

The following table lists the available area chart types.

<table>
<thead>
<tr>
<th>Available Area Chart Types</th>
<th>Horizontal Absolute Area</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Absolute Area</td>
<td>Horizontal Absolute Area</td>
</tr>
<tr>
<td>Vertical Stacked Area</td>
<td>Horizontal Stacked Area</td>
</tr>
<tr>
<td>Vertical Bi-Polar Absolute Area (Not in HTML5)</td>
<td>Horizontal Bi-Polar Absolute Area (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Bi-Polar Stacked Area (Not in HTML5)</td>
<td>Horizontal Bi-Polar Stacked Area (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Percent Area</td>
<td>Horizontal Percent Area</td>
</tr>
</tbody>
</table>
Scatter Charts

Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart, by default, however you can optionally specify a non-measure (dimension) field on either the vertical or horizontal axis. You can also specify a non-measure field on both axes, which results in a vertical display of your dimension data.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak relationship, or no relationship.

**When to use:** Use a scatter chart when you want to determine patterns in your data.

The following image is a scatter chart that shows gross profit and MSRP data for product categories.
Multi-Axis Charts

Bar, line, and area chart types have multi-axis options, such as dual-axis charts and multi-Y charts, where you can compare one X-axis value to several Y-axis measure fields.

InfoAssist allows you to assign each individual series to the Y1 through Y5 axis.

**When to use:** Use a multi-axis chart when you want to plot values on an additional axis, or multiple axes, to compare multiple sets of data that are on different scales.

For example, the following image is a dual-axis bar chart that shows the revenue and MSRP by store type over a four-year time period.

![Dual-axis bar chart](image)

XY Plot Charts

An XY plot chart depicts the relationships among the numeric values in several data series. It plots two groups of numbers, where for every X value, there is a corresponding Y value. This results in a single point of XY coordinate.

**When to use:** Use XY plot charts when you have two sets of numbers to compare and want to perform trend analysis.

**Scatter.** Scatter charts show a relationship between X and Y values. They compare two sets of numbers at once, possibly revealing patterns and trends.
You can plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a basic line pattern so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart by default.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak or no relationship.

Scatter charts share many of the characteristics of basic line charts. Scatter charts and line charts are distinguishable from one another only by virtue of their X-axis format. Line charts can appear without connecting lines, making them look like scatter charts, and scatter charts can appear with connecting lines, making them look like line charts.

- **Polar.** A polar chart is a circular chart. Data is displayed on a polar chart in terms of values and angles. Polar charts share characteristics with scatter charts. Only one column field is allowed, in the following order: X (degree) for the column field, and Y (distance from the center) for the Across or By field.

- **Bubble.** A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values, in that order. The third variable (Z) represents size. The size of each bubble is used to show the relative importance of the data.

  **Note:** You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.

### XY Plot Chart Types

The following table lists the available XY plot chart types.

<table>
<thead>
<tr>
<th>Available XY Plot Chart Types</th>
<th>XY Scatter</th>
<th>XY Polar</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bubble</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 3D Charts

A 3D chart uses three axes, X, Y, and Z to display data from two or more data sets so that trends are most apparent.
**When to use:** Use a 3D bar chart when you want to look at the general shape of the data, but add visual depth to a chart presentation. A 3D chart would not be a good choice for presenting exact values, since it is difficult to determine values in a 3D chart.

**Note:** When working with charts in HTML5 format, the 3D Effect option is not supported.

The following image is a 3D chart that shows the revenue for products categories over a four-year time period.

![3D Chart](image)

### 3D Chart Types

The following table lists the available 3D chart types.

<table>
<thead>
<tr>
<th>Available 3D Chart Types</th>
<th>3D Pyramid (Not in HTML5)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Bar</td>
<td>3D Bar</td>
</tr>
<tr>
<td>3D Octagon (Not in HTML5)</td>
<td>3D Octagon (Not in HTML5)</td>
</tr>
<tr>
<td>3D Floating Cubes (Not in HTML5)</td>
<td>3D Floating Cubes (Not in HTML5)</td>
</tr>
<tr>
<td>3D Connected Series Area</td>
<td>3D Connected Series Area</td>
</tr>
<tr>
<td></td>
<td>3D Connected Series Ribbon (Not in HTML5)</td>
</tr>
</tbody>
</table>
### Available 3D Chart Types

<table>
<thead>
<tr>
<th>3D Connected Group Area (Not in HTML5)</th>
<th>3D Connected Group Ribbon (Not in HTML5)</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Cone (Not in HTML5)</td>
<td>3D Sphere (Not in HTML5)</td>
</tr>
<tr>
<td>3D Surface</td>
<td>3D Surface with Sides (Not in HTML5)</td>
</tr>
<tr>
<td>3D Smooth Surface (Not in HTML5)</td>
<td>3D Smooth Surface with Sides (Not in HTML5)</td>
</tr>
<tr>
<td>3D Honeycomb Surface (Not in HTML5)</td>
<td></td>
</tr>
</tbody>
</table>

### Stock Charts

Stock charts track the trend of a particular stock. They show the trading volume of the stock, its opening and closing values, and its high and low values over a specific time period. The data is represented by sets of bars or lines.
Stock Chart Types

The following table lists the available stock chart types.

<table>
<thead>
<tr>
<th>Available Stock Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock Hi-Lo (Not in HTML5)</td>
</tr>
<tr>
<td>Stock Hi-Lo with Volume (Not in HTML5)</td>
</tr>
<tr>
<td>Stock Hi-Lo Open-Close (Not in HTML5)</td>
</tr>
<tr>
<td>Stock Hi-Lo Open-Close with Volume (Not in HTML5)</td>
</tr>
<tr>
<td>Open-Hi-Lo-Close Candle Stock</td>
</tr>
<tr>
<td>Open-Hi-Lo-Close Candle Stock with Volume (Not in HTML5)</td>
</tr>
</tbody>
</table>

Special Charts

Special charts include a variety of additional chart types.

- **Gauge.** A gauge chart indicates the current position of a single data value within a given spectrum. This chart has a circular shape.
- **Gauge Thermometer.** A gauge thermometer chart indicates the current position of a single data value within a given scale. This chart has the shape of a thermometer. It is not available in HTML5.
- **Pareto.** A Pareto chart uses the X axis to show group members, and the Y axis to show the percent of the total of all groups that each group represents. This chart highlights the differences between groups of data.
- **Vertical Box Plot.** A vertical box plot is oriented vertically, and shows the distribution of data through five-number summaries: Upper limit, Upper Quartile, Median, Lower Quartile, and Lower Limit. This chart can be represented with or without outliers, also known as whiskers.
- **Horizontal Box Plot.** A horizontal box plot is oriented horizontally, and shows the distribution of data through five-number summaries: Upper limit, Upper Quartile, Median, Lower Quartile, and Lower Limit. This chart can be represented with or without outliers, also known as whiskers.
- **Funnel.** A funnel chart is essentially a pie chart, displaying only one group of data at a time, from the first series to the last series at the bottom of the funnel.
- **Pyramid.** A pyramid chart is essentially a pie chart, displaying only one group of data at a time, from the first series to the last series at the top of the pyramid.
Spectral Map. A spectral map contains a row or column matrix of markers that are displayed in different colors, according to the data values.

HTML5 Charts

The following HTML5 charts are available:

- **Parabox.** Parabox charts are used to visualize and analyze multivariate data. In a typical scenario, hundreds of possible outcomes can be compared by filtering along any dimension.

- **Mekko Chart.** Mekko charts compare two related variables by percent of total and magnitude. They are popular in business and marketing.

- **Streamgraph.** Streamgraph charts are typically used to illustrate how data has changed over time. They resemble a stacked area chart. However, the x-axis is not fixed. Streamgraphs are commonly used to illustrate trends in the Social Media arena.

- **Tag Cloud.** Tag Cloud charts display the most prominent terms in a visual representation for text data. They are noted for their quick display of relevant information, allowing you to make quick decisions and narrow your search for terminology. Tag Cloud charts are typically used to depict keywords on websites or to visualize free form text.

- **Treemap.** Treemap charts are used to display large amounts of hierarchically structured data. In a sectioned format, each rectangle represents an aspect of the selected measure. When a second measure is indicated, color coding is applied, emphasizing the unique sections of the treemap.

- **Grid.** Grids present data in tabular form. For example, in Chart mode, you can use the Grid chart type to create a table that summarizes your data. This option is also available in Visualization mode.

Creating Your Own Chart Types

Business User Edition supports the ability to add new, custom chart types to its list of built-in charts. These custom chart types are called extensions or plug-ins. An extension is a block of code that accesses resources external to Business User Edition. This topic describes the structure of an extension and the steps necessary to create your own and add it to the chart library.
Introducing Chart Extensions

Chart extensions are written in JavaScript. The visual part of a visualization can be drawn with HTML, Canvas, or SVG. Extensions can include external CSS and JS libraries (such as d3), which can be used to build almost any visualization. The WebFOCUS Extension API is limited to new, complete chart types only. It is not possible to add features to existing chart types, and it is not possible to modify or extend parts of Business User Edition outside of the chart area allocated to your extension.

This topic summarizes the process of writing, configuring, and installing a chart extension. Detailed instructions can be found on the Information Builders GitHub site:

https://github.com/ibi/wf-extensions-chart

Business User Edition extensions must be placed in the extensions folder under the web_resource folder of your Business User Edition installation. By default, this is the following location:

c:\ibi\install_dir\config\web_resource\extensions

where:

install_dir


Several sample chart extensions have already been installed in the extensions folder so that you can see their code, their structure, and how they are accessed in Business User Edition.

**Note:** The user installing the extension must know how to write JavaScript code for what the chart extension needs to generate. The GitHub site documents how to make the extension conform to the WebFOCUS API and how to install the extension in the Business User Edition chart library. It does not describe how to write JavaScript code.

Creating a Chart Extension

This section summarizes the build cycle for creating an extension and the structure and components of an extension.

**Reference:** Build Cycle for Writing an Extension

Creating an extension often involves cycles of writing, running, and then debugging code.

When you make changes to the properties.js file for your extension, you need to clear the Business User Edition cache in order for those changes to be recognized. Clear the cache using the *Clear cache* link in the Administration Console.
If you change the .js code for your extension (for example, com.ibi.simple_bar.js), you do not need to make any changes to Business User Edition. You only need to clear your own browser cache, to ensure that the new JavaScript file is downloaded. The same is true if you change any additional .js files included by your extension.

Reference: Extension Structure

The Simple Bar extension example demonstrates the required and optional files in an extension, and how those files are typically laid out.

You can open com.ibi.simple_bar and com.ibi.simple_bar.js in a text editor to see exactly how an extension is written.

The extension ID (ext_id) is a string in the form com.your_company.extension_name. The ext_id must be all lowercase, and can include only letters, numbers, underscores and dots. The entire extension lives in a folder named ext_id. The core of the extension lives in a file named ext_id.js. This file includes code to render the extension as a new chart type within Business User Edition.

The properties.json file configures your extension to run in Business User Edition. This file includes all the metadata needed to include your extension in Business User Edition, as well as a list of all properties you wish to expose to end users, so they can customize the behavior of your extension.

The extension folder can also include optional additional folders for external css and lib resources. If your extension uses any additional CSS or JavaScript library files, you can keep those resources organized in dedicated folders, such as css and lib, as you choose. External resources are configured and loaded inside the base ext_id.js file of your extension.

Using the Chart Extension API

To see examples of everything that the chart extension API provides, look at com.ibi.simple_bar.js. It is divided into two main parts, chart rendering and extension configuration.

Rendering Charts

The extension API provides three entry points that you can use as needed by defining your own JavaScript callback functions. They are passed a set of properties in a config object. Some properties are available during the entire rendering process, and some are only available during render callback.
Reference: Chart Rendering Callback Functions

You can define the following three JavaScript callback functions. Only the renderCallback function is always required.

- initCallback(successCallback, config) This optional function is invoked by the engine exactly once during library load time, providing a way to implement document.onload initialization code. This function is passed a successCallback, which you must invoke with true if your initialization code succeeded or false if was not successful. If you call successCallback(false), no further interaction with your extension will occur, and your extension will render as an empty page.

- preRenderCallback(config) This optional function is invoked each time your extension is to be rendered, as the very first step in the overall rendering process. This is a good place to examine and tweak or override any internal chart properties that will affect the subsequent rendering.

- renderCallback(config) This required function must contain all of the code that will actually draw your chart. The config object will contain the properties described in the following sections.

Each of the three entry point callbacks is passed a config object, which contains a set of useful properties.
Example: Sample renderCallback Function

The following sample renderCallback code renders the Simple Bar extension.

```javascript
function renderCallback(renderConfig) {
    var chart = renderConfig.moonbeamInstance;
    var props = renderConfig.properties;
    var container = d3.select(renderConfig.container)
        .attr("class", "com_ibi_chart");
    var data = renderConfig.data;
    if (renderConfig.dataBuckets.depth === 1) {
        data = [data];
    }

    var seriesCount = data[0].length;
    var seriesLabels = data[0].map(function (el) { return el.labels; });
    data = d3.transpose(data).map(function (el, idx) {
        el = el[0];
        var v = Array.isArray(el.value) ? el.value : [el.value];
        var y0 = 0;
        return v.map(function (d, s) {
            return chart.mergeObjects(d, { y0: y0, y1: y0 += d, seriesID: s, value: d, labels: seriesLabels[idx] });
        });
    });

    var w = renderConfig.width;
    var h = renderConfig.height;
    var x =
        d3.scale.ordinal().domain(pv.range(seriesCount)).rangeRoundBands([0, w], 0.2);
    var ymax = d3.max([].concat.apply([], data), function (d) { return d.y1; });
    var y = d3.scale.linear().domain([0, ymax]).range([25, h]);
    var svg = container.selectAll("g")
        .data(data)
        .enter().append("g")
        .attr("transform", function (d, i) {
            return 'translate(' + x(i) + ', 0)';
        });

    svg.selectAll("rect")
        .data(function (d) { return d; })
        .enter().append("rect")
        .attr("width", x.rangeBand())
        .attr("y", function (d) { return h - y(d.y1); })
        .attr("height", function (d) { return y(d.y1) - y(d.y0); })
        .attr("tdgtitle", function (d, s, g) {
```
```
//To support tooltips, each chart object that should draw a tooltip
//must set its 'tdgtitle' attribute to the tooltip's content string.

// Retrieve the chart engine's user-defined tooltip content with
getToolTipContent():
// 's' and 'g' are the series and group IDs for the riser in question.
// 'd' is this riser's individual datum, and seriesData is the array of
data for this riser's series.
var seriesData = chart.data[s];
var tooltip = renderConfig.modules.tooltip.getToolTipContent(s, g, d, seriesData);

// getToolTipContent() return values:
// - undefined: do not add any content to this riser's tooltip
// - the string 'auto': you must define some 'nice' automatic tooltip
// content for this riser
// - anything else: use this directly as the tooltip content
if (tooltip === 'auto') {
  if (d.hasOwnProperty('color')) {
    return 'Bar Size: ' + d.value + '<br/>Bar Color: ' + d.color;
  }
  return 'Bar Size: ' + d.value;
}
return tooltip;

$.attr('class', function(d, s, g) {
  // To support data selection and tooltips, each riser must include a
class name with the appropriate seriesID and groupID
  // Use chart.buildClassName to create an appropriate class name.
  // 1st argument must be 'riser', 2nd is seriesID, 3rd is groupID, 4th
  // is an optional extra string which can be used to identify the risers in
  // your extension.
  return chart.buildClassName('riser', s, g, 'bar');
});

$.attr('fill', function(d) {
  // getSeriesAndGroupProperty(seriesID, groupID, property) is a handy
  // function
  // to easily look up any series dependent property. 'property' can be in
  // dot notation (eg: 'marker.border.width').
  return chart.getSeriesAndGroupProperty(d.seriesID, null, 'color');
});

svg.append('text')
   .attr('transform', function(d) {return 'translate(' + (x.rangeBand() / 2) + ',' + (h - 5) + ')';})
   .text(function(d, i){return seriesLabels[i]});

renderConfig.modules.tooltip.updateToolTips();  // Tell the chart engine
your chart is ready for tooltips to be added
renderConfig.modules.dataSelection.activateSelection();  // Tell the
chart engine your chart is ready for data selection to be enabled
}
### Reference: Properties That Are Always Available

The following properties are always available.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>moonbeamInstance</td>
<td>The chart instance currently being rendered.</td>
</tr>
<tr>
<td>data</td>
<td>The data set being rendered.</td>
</tr>
<tr>
<td>properties</td>
<td>The block of properties for your extension, as set by the user.</td>
</tr>
<tr>
<td>dataBuckets</td>
<td>Optional custom data buckets. For information, see Defining and Using Buckets in an Extension on page 90.</td>
</tr>
</tbody>
</table>

### Reference: Properties Available Only During Render Callback

The following properties are available only during render callback, and are used by your chart rendering code (renderCallback).

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>Width of the container your extension renders into, in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>Height of the container your extension renders into, in pixels.</td>
</tr>
<tr>
<td>containerIDPrefix</td>
<td>The ID of the DOM container your extension renders into. Prepend this to all IDs your extension generates, to ensure multiple copies of your extension work on one page.</td>
</tr>
<tr>
<td>container</td>
<td>DOM node for your extension to render into, either an HTML DIV element or an SVG G element, depending on your chosen containerType extension configuration</td>
</tr>
<tr>
<td>rootContainer</td>
<td>DOM node containing the specific chart engine instance being rendered.</td>
</tr>
</tbody>
</table>
Configuring Your Chart Extension

Extension configuration consists of two parts.

- Chart Engine Configuration configures the extension to interact with the chart engine and in Business User Edition Chart mode. This part of the extension configuration is defined in the config object that is passed to the chart renderer functions.

- Chart Interface Configuration interacts with the chart type picker in the user interface and the chart attribute categories. This part of the extension configuration is defined in the properties.json file.

Creating a config Object for Chart Engine Configuration

To configure your extension, create a config object with all the information unique to your extension, then register your extension with the extension API.

Reference: Creating a config Object for Your Extension

Required and optional properties in your config object are described in the following table.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Is the extension ID described in Extension Structure on page 81.</td>
</tr>
<tr>
<td>name</td>
<td>Is the name for the chart type to be displayed in the user interface.</td>
</tr>
<tr>
<td>description</td>
<td>Is a description for the chart type to be displayed in the user interface.</td>
</tr>
<tr>
<td>containerView</td>
<td>Is either 'html' or 'svg' (the default).</td>
</tr>
<tr>
<td>initCallback</td>
<td>Optional. References your initCallback function, described in Rendering Charts on page 81.</td>
</tr>
<tr>
<td>preRenderCallback</td>
<td>Optional. References your preRenderCallback function, described in Rendering Charts on page 81.</td>
</tr>
<tr>
<td>renderCallback</td>
<td>Required. References your renderCallback function, described in Rendering Charts on page 81.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>resources</td>
<td>Optional. Are additional external resources (CSS and JS) required by this extension.</td>
</tr>
</tbody>
</table>

**Example:** **Sample config Object**

The following code is a sample of the config object used with the Simple Bar extension.

```javascript
var config = {
  id: 'com.ibi.simple_bar', // string that uniquely identifies this extension
  containerType: 'svg',  // either 'html' or 'svg' (default)
  initCallback: initCallback, // Refers to your init callback fn (optional)
  preRenderCallback: preRenderCallback, // Refers to your preRender callback fn (optional)
  renderCallback: renderCallback, // Refers to your render fn (required)
  resources: { // Additional external resources (CSS & JS) required by this extension (optional)
    script: ['lib/d3.min.js'],
    css: ['css/extension.css']
  }
};
```

**Reference:** **Registering Your Extension**

To register your extension with the WebFOCUS extension API, call:

```javascript
tdgchart.extensionManager.register(config);
```

**Reference:** **Tips for Building Your Extension**

The easiest way to build your own extension is to clone the Simple Bar example, then tweak it. Assume the ID of the new extension is com.foo.bar:

2. In com.foo.bar.js, delete the inner content of the three callback functions.
3. In com.foo.bar.js, change the entries for each property in config to match the requirements of your extension.
4. Add any external resources you need to `lib` and `css`, and load them by setting `config.resources` in `com.foo.bar.js`.
5. Implement `renderCallback` in `com.foo.bar.js` to draw your extension.
Configuring the Chart Interface

Each extension must include a properties.json file, which defines the information needed by Business User Edition when drawing its user interface.

The properties.json file consists of the following blocks.

- **info.** This block defines several general purpose configuration options.

- **properties.** This block defines any properties of your extension that the end user may want to change. The user can change these properties in the GRAPH_JS blocks in a Business User Edition chart procedure.

- **propertyAnnotations.** This block validates the content of the properties block. Everything in properties must appear in propertyAnnotations. The possible types of any non-object (leaf) property in properties must be notated as one of "str", "bool", or "number".

- **dataBuckets.** This block defines the set of chart attribute categories that appear in the Query pane in Business User Edition when creating a chart. Each member in the dataBuckets collection is a bucket.

  There are two types of buckets, built-in and custom. Built-in buckets provide an easy way to reuse the existing Business User Edition data bucket logic. There are currently two built-in buckets, tooltip, and series_break. Use any of these buckets by setting the associated dataBuckets property to true.

- **bucket.** Each bucket block defines one custom chart attribute category. Each custom bucket requires the following properties:

  - **id.** This property corresponds exactly to the dataArrayMap and data properties that will be received by the render function for your chart.

  - **type.** This property defines the type of data field this bucket accepts, "measure", "dimension", or "both".

  - **count.** Consists of count.min and count.max, which define the minimum and maximum number of fields this bucket can accept. A minimum of 0 means this bucket is optional.

  - **translations.** Defines translations in different languages for every label to be drawn in Business User Edition. The translation object has one property for each language the extension supports, keyed by ISO-639 two letter locale strings.
**Example:** Sample properties.json File

The following properties.json file is from the Simple Bar extension.

```json
{
// Define some general extension configuration options
  "info": {
    "version": "1.0",  // version number of your extension.
    "implements_api_version": "1.0",  // version number of the WebFocus
    "author": "Information Builders",
    "copyright": "Information Builders Inc.",
    "url": "https://github.com/ibi/wf-extensions-chart/tree/master/
    simple_bar%20example",
    "icons": {
      "medium": "icons/medium.png"  // Reference to an image in the
      extension, used in the WF chart picker
    }
  },
// Define any properties of your extension that end user may want to
change.
  "properties": {
    "exampleProperty": 50
  },
// Define the possible values for each property in 'properties'.
  "propertyAnnotations": {
    "exampleProperty": "number"
  },
// Define the available data buckets drawn in WF's 'Query' data bucket
  "dataBuckets": {
    // Choose whether or not to reuse existing WF data buckets. All
    optional.
    "tooltip": false,
    "series_break": true,
```
// Define your own custom data buckets. Optional
"buckets": [
  {
    "id": "value",
    "type": "measure",
    "count": {"min": 1, "max": 5}
  },
  {
    "id": "labels",
    "type": "dimension",
    "count": {"min": 1, "max": 5}
  }
],
// Define the set of labels used in the WF interface for buckets and
chart type picker.
"translations": {
  "en": {
    "name": "My Simple Bar Chart",
    "description": "This chart is just a simple bar chart, nothing
to see here.",
    "icon_tooltip": "This extension does ...",
    "value_name": "Value Bucket",
    "value_tooltip": "Drop a measure here",
    "labels_name": "Label Bucket",
    "labels_tooltip": "Drop a dimension here"
  },
  "fr": {
    "name": "Un Bar Chart tres simple",
    "description": "C'est un Bar Chart vraiment simple",
    "icon_tooltip": "This extension does ...",
    "value_name": "Value Bucket",
    "value_tooltip": "Drop a measure here",
    "labels_name": "Label Bucket",
    "labels_tooltip": "Drop a dimension here"
  }
}
}

**Accessing Data for Your Extension**

Each time an extension is rendered, the render callback for the extension is passed the
current data set using the renderConfig.data argument. The overall structure of the data set is
declared by the set of buckets listed in the properties.json file, while the specific content of the
data is defined by the data fields the user has added to each bucket.

**Defining and Using Buckets in an Extension**

The data set is passed into an extension using the data property of the first argument of the
render callback, typically named renderConfig. Additional information about the current set of
fields in each bucket is in renderConfig.dataBuckets.
A data set is represented in JavaScript as arrays of objects. If an extension defines only custom buckets, the data set will be a flat array of objects. If an extension uses some built-in buckets, the data set may contain deeply nested arrays of arrays. The renderConfig.dataBuckets.depth property will be set to the number of array dimensions in the current data set.

**Custom Buckets**

Each innermost object within the arrays of data (called a *datum*) will have one property for each data bucket that contains a field. Each property will be the id of a custom bucket, as defined in the dataBuckets.buckets section of properties.json. The type of values of these properties depend on the bucket type. Dimension buckets have string values, while measure buckets have numeric values. If a bucket contains more than one field, the associated property for each innermost object will be an array of string or number values.

If you implement the extension API version 2, you can retrieve the field name and number format associated with a data bucket entry. To use API 2 and get a bucket entry field name or number format, an extension must declare that it implements extension API version 2 using the 'implements_api_version' entry in the info block of properties.json:

```json
{
   "info": {
      "implements_api_version": "2.0"
   }
}
```

**Built-in Buckets**

An extension can use buckets that are built-in and predefined by Business User Edition. These buckets will affect more than just the data set. Each bucket will also set specific chart engine properties, to pass in additional information related to that bucket.

Each built-in bucket is either a **standard** bucket or a **break** bucket.

- Standard buckets behave exactly like custom buckets. The data set remains a single array, and each datum object will include an additional property named after the bucket.

- Break buckets divide the data set into additional arrays of data. For each break bucket used, each datum object will be transformed into a full array of datum objects. The number of datum objects in each array will remain unchanged, but the number of arrays or datum arrays will correspond to the number of entries in the break field.
Types of Break Buckets

Break buckets can be of two types:

- A series-break bucket breaks the data set into one array for each entry in the series break field chosen by the user. A series-break bucket uses series-dependent properties defined in the chart engine, and the data names are now listed in those series-dependent properties. Each entry in the series-break field will generate a corresponding series property object in the chart engine, retrievable with renderConfig.moonbeamInstance.getSeries(x), where x is an integer for the series to be retrieved. getSeries returns an object with properties such as color and label, which are unique to the chosen series.

- A matrix-break bucket is used for the sort fields that define the columns and rows in a matrix chart. A matrix-break bucket also adds more array dimensions to the data set. A matrix-break bucket is broken into column and row sub-buckets. If either the row or column bucket contains any fields, the data set will contain two additional dimensions of data, even if one of the matrix buckets is empty. That is, the data set will either contain neither row nor column data, or both row and column data, never just one or the other. bucket.depth will always be at least three.

The Tooltip Bucket

The tooltip bucket is not a break bucket, and does not add any additional array dimensions to the data set. Instead, tooltip behaves like a custom bucket. Each inner datum object will contain a property named tooltip, with a value of type string for dimensions, number for measures, and an array of values for multiple fields in the bucket.

The usefulness of this bucket is that in addition to including tooltip-specific data in the data set, Business User Edition also generates meaningful tooltip content for each series. This tooltip content is the same content used for all of the built-in Business User Edition chart types. Using the tooltip bucket means the extension does not have to figure out what ought to go into each tooltip.

**Example:** Sample Series-Break Bucket Definition

This example uses the following sample data.

<table>
<thead>
<tr>
<th>Car</th>
<th>Country</th>
<th>Seats</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW</td>
<td>Germany</td>
<td>5</td>
</tr>
<tr>
<td>Audi</td>
<td>Germany</td>
<td>4</td>
</tr>
<tr>
<td>Car</td>
<td>Country</td>
<td>Seats</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>Peugeot</td>
<td>France</td>
<td>5</td>
</tr>
<tr>
<td>Alfa Romeo</td>
<td>Italy</td>
<td>4</td>
</tr>
<tr>
<td>Maserati</td>
<td>Italy</td>
<td>2</td>
</tr>
<tr>
<td>Toyota</td>
<td>Japan</td>
<td>4</td>
</tr>
</tbody>
</table>

The following code defines a series-break bucket for API version 1.0.

```javascript
dataBuckets:
  series_break: true,
  buckets:
    [
      {id: "label", type: "dimension"},
      {id: "value", type: "measure"}
    ]
```

Consider the following fields assigned to each of the buckets:

- "Country" assigned to the "series_break" bucket.
- "Car" assigned to the "label" bucket.
- "Seats" assigned to the "value" bucket.

In the renderConfig function, the renderConfig.data object will be similar to the following, in which the Country values are no longer part of the data array. However, a new array starts for each change in the Country value:

```javascript
[{labels: "PEUGEOT", value: 5}],
[{labels: "ALFA ROMEO", value: 4}, {labels: "MASERATI", value: 2}],
[{labels: "TOYOTA", value: 4}],
[{labels: "AUDI", value: 4}, {labels: "BMW", value: 5}]
```

The renderConfig.dataBuckets object will be defined as follows:

```javascript
renderConfig.dataBuckets = {
  depth: 2,
  series_break: {title: "Country"},
  buckets: {
    label: {title: "Car"},
    value: {title: "Seats"}
  }
```

If you are using API version 2.0, dataBuckets.buckets is an array instead of an object. Each entry in this array represents the content of one data bucket. The id property identifies which bucket this is, and the fields array specifies how many entries are in this bucket and the unique information for each (titles, field names, number formats).
The dataBuckets object includes a method named getBucket(). Pass it the name of a bucket and it returns the content of that bucket.

There are two types of buckets, built-in and custom. Built-in buckets provide an easy way to reuse the existing WebFOCUS data bucket logic. There are currently two built-in buckets, tooltip, and series_break. Use any of these buckets by setting the associated dataBuckets property to true.

**The dataBuckets block includes the following objects for API Version 2.0.**

- **depth.** Specifies the number of buckets in the buckets array.

- **buckets.** Specifies the properties of all fields for all buckets.
  
  - **id.** This property corresponds exactly to the dataArrayMap and data properties that will be received by the render function for your chart.

  - **fields.** Is an array of fields for each bucket. For each field, defines the field title, name, and number format:

```javascript
{"title": "fieldtitle", "fieldName": "fieldname", "numberFormat": "format"}
```
With API Version 2.0, the content of renderConfig.dataBuckets that is passed to each render callback in an extension provides field title and format information. In the following example, the there are two buckets. The labels bucket has one field, CAR.ORIGIN.COUNTRY, whose title is COUNTRY. The value bucket has two fields, CAR.SALES, title SALES, and CAR.BODY.DEALER_COST, title DEALER_COST.

```json
"dataBuckets": {
  "getBucket (bucketName)",
  "depth": 2,
  "buckets": [
    {
      "id": "labels",
      "fields": [
        {"title": "COUNTRY", "fieldName": "CAR.ORIGIN.COUNTRY"}
      ]
    },
    {
      "id": "value",
      "fields": [
        {"title": "SALES", "fieldName": "CAR.SALES", "numberFormat": ",##0.00"},
        {"title": "DEALER_COST",
         "fieldName": "CAR.BODY.DEALER_COST",
         "numberFormat": ",###"}
      ]
    }
  ]
}
```

Handling Partial and Null Data in an Extension

In many cases, the end user working with an extension cannot populate all of the extension buckets immediately. An extension must correctly handle these partial data cases, and cannot crash if one or more buckets are empty. It is important to check renderConfig.dataBuckets to see which buckets have been populated, and act accordingly.

In addition, data sets are often incomplete, missing some values for a given combination of dimensions and measures. These missing values may show up in the data set as null entries within an array (instead of datum objects), or they may show up as entirely empty arrays. It is important to detect and handle these missing data cases, and render a visualization appropriate for such missing data.
Most extensions require some minimum number of populated buckets before anything can be rendered. Use the count.min properties of each dataBuckets.bucket entry in properties.json to define these minimum requirements. If the fields in all buckets do not meet the minimum counts, then the renderCallback for the extension will not be called. Instead, the noDataPreRenderCallback for the extension is called. This allows the extension to render in a special no data mode. In this mode, the extension should render in grey scale, using renderCallback.baseColor as the main color. This should be a very simplified, sample rendering of the extension.

**Example:** 
**Sample noDataPreRenderCallback Function**

The following noDataPreRenderCallback function is from the Simple Bar sample extension.

```javascript
function noDataRenderCallback(renderConfig) {
  var grey = renderConfig.baseColor;
  renderConfig.data = [{value: [3, 3]}, {value: [4, 4]}, {value: [5, 5]}, {value: [6, 6]}, {value: [7, 7]}];
  renderConfig.moonbeamInstance.getSeries(0).color = grey;
  renderConfig.moonbeamInstance.getSeries(1).color = pv.color(grey).lighter(0.18).color;
  renderCallback(renderConfig);
}
```

**Installing a Chart Extension**

1. Find the extensions folder for your local Business User Edition installation. This is typically the following folder.

   C:\ibi\install_dir\config\web_resource\extensions

   where:

   *install_dir*


   **Note:** The WebFOCUS Extension section of the Information Builders GitHub page maintains a list of publicly available and supported extensions. To install one of those, click the extension you want to install, then right click the zip file for that extension, for example com.ibi.xyz.zip, and choose Save link as...

2. Unzip the downloaded zip file into the Business User Edition extensions folder. For example, for the com.ibi.xyz.zip zip file, this should create the following folder.

   C:\ibi\install_dir\config\web_resource\extensions\com.ibi.xyz

   If you are installing your own extension from your own environment, copy or download it to the Business User Edition extensions folder, using the same naming conventions for the folder and the extension ID as described for the sample extensions.
3. Edit `C:\ibi\install_dir\config\web_resource\extensions\html5chart_extensions.json`. Create a new line for the new extension in the form:

   "com.ibi.abc": {"enabled": true},

where:

   abc

   Is the name of the extension.

4. In the Administration Console, click *Clear cache*. This will force WebFOCUS to reload all extensions.

Following is a sample `html5chart_extensions.json`.

```
{
   "com.ibi.simple_bar": {enabled: true},
   "com.ibi.liquid_gauge": {enabled: false},
   "com.ibi.sankey": {enabled: true}
}
```

**Note:** The Administration Console provides a user interface for installing chart extensions. For information, see *Install HTML5 Chart Extensions From the IBI GitHub Page*.

**Reference:**  
Preserving Custom Chart Types When Reinstalling Business User Edition

If you reinstall the Business User Edition, your extensions folder will be overwritten. Therefore, if you have installed any custom chart extensions, you should preserve them by copying them to another location prior to reinstalling the Business User Edition and copying them back to the extensions folder after reinstalling the Business User Edition.

You will also have to copy the entries for your custom extensions into the new `html5chart_extensions.json` file installed with the new version of Business User Edition.

**Note:** The extensions that are delivered as part of Business User Edition will be reinstalled automatically, so you should not preserve those extensions. In that way, if any enhancements have been made to those extensions, you will automatically have access to the enhanced versions when you reinstall Business User Edition.
Using Your Extension in a WebFOCUS Request

If you have installed and configured your extension as described, your extension will be available for use in Business User Edition as a chart type in the *Other* format category under *HTML5 Extension*, as shown in the following image.

The attribute categories you defined in the dataBuckets object of your extension are available in the query pane.

In the FOCEXEC:

- The LOOKGRAPH value is EXTENSION.
- The actual extension to use is identified in the chartType property of the *GRAPH_JS* block in the StyleSheet. For example:

  ```
  *GRAPH_JS
  chartType: "com.ibi.simple_bar",
  }
  ```

- Each custom attribute category name is prepended with a greater-than character (>). For example:
The following is a sample request using the Simple Bar extension.

```plaintext
GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
GROSS_PROFIT_US
REVENUE_US
DISCOUNT_US
BY PRODUCT_CATEGORY
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH EXTENSION
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$
TYPE=DATA, COLUMN=PRODUCT_CATEGORY, BUCKET= >labels, $  
TYPE=DATA, COLUMN=COGS_US, BUCKET= >value, $  
TYPE=DATA, COLUMN=GROSS_PROFIT_US, BUCKET= >value, $  
TYPE=DATA, COLUMN=REVENUE_US, BUCKET= >value, $  
TYPE=DATA, COLUMN=DISCOUNT_US, BUCKET= >value, $  
*GRAPH_JS
chartType: "com.ibi.simple_bar",
*END
ENDSTYLE
END
```
Run the chart. The output is shown in the following image.

Building a Document

Document view allows you to build multiple reports and charts on the same canvas. The styling, design, and report building functionality of Live Preview and Query Design view is available in Document view.

In addition, there are many other features that simplify building documents. You can build and insert multiple reports in the form of reports and charts into documents. You can also insert images and text for presentation and organizational purposes.

Inserting Reports From Multiple Data Sources

With InfoAssist opened in Document view, you can insert multiple charts and reports onto the canvas. These reports can be from different data sources. With documents, you have the option to add additional data sources to the document.

In order to insert reports from different data sources, the document must have multiple data sources loaded. For more information on adding and switching between data sources, see Data Tab.

Procedure: How to Insert Two Reports From Two Different Data Sources

A document can display multiple reports from multiple data sources in the same document.

1. With InfoAssist open in Document view, click the Insert tab and select chart or report.
2. If your document has only one data source, insert additional data sources.
   For more detailed instructions on inserting multiple data sources, see Data Tab.

3. Switch to a data source different than the one used in step 1.
   For more detailed instructions on switching to a different data source, see Data Tab.

4. Insert a chart or report using this new data source, following the instructions given in Inserting a New Report on page 101.
   Your document is now populated with reports that have data from different data sources.
   You can add as many data sources as you need.

**Inserting a New Report**

With InfoAssist opened in Document view, you can insert multiple charts and reports onto the canvas. The procedures in the following sections detail how to insert reports into documents.

In Document view, you can insert a report in the following ways:

- Use the Insert tab.
- Double-click a data source field.
- Right-click a data source field.
- Drag a data source field onto the canvas.

**Note:**

- When you use the Insert tab, double-click a data source field, or right-click a data source field, a report placeholder is added to the canvas.
- When you insert an existing report, which has already been created and is referenced via INCLUDE syntax, and then select it on the Document canvas, the data fields do not display in the Query pane.

Dragging a data source field onto the canvas inserts the placeholder at the location you dropped it.

The following procedures describe how to insert new reports. For more information on how to edit existing reports, see How to Style and Customize a Report on page 109.

**Procedure:** How to Insert a Report

Do one of the following, while in Document mode:

- On the Insert tab, in the Reports group, click Report. Add fields to the placeholder report.
On the Home tab, in the Format group, click Report. Double-click a data source to automatically create a report with that data.

On the Home tab, in the Format group, click Report. Drag a field to the canvas to create a report.

Inserting a New Chart

With InfoAssist opened in Document view, you can bring multiple charts and reports onto the canvas. The procedures in the following sections describe how to insert charts into documents.

In Document view, you can insert a chart in the following ways:

- Use the Insert tab.
- Double-click a data source field.
- Right-click a data source field.
- Drag a data source field from the Resources panel onto the canvas.

Note: When you use the Insert tab, double-click a data source field, or right-click a data source field, a chart placeholder is added to the canvas.

Dragging a data source field onto the canvas inserts the placeholder at the location you dropped it.

The following procedures describe how to insert new charts. For more information on how to edit existing charts, see How to Style and Customize a Chart on page 109.

Procedure: How to Insert a Chart

1. Do one of the following, while in Document mode:
   - On the Insert tab, in the Reports group, click Chart. Add fields to the placeholder chart.
   - On the Home tab, in the Format group, click Chart. Double-click a data source to automatically create a chart with that data.
   - On the Home tab, in the Format group, click Chart. Drag a field to the canvas to create a chart.

2. Optionally, change the chart format using the options on the Format tab, in the Chart Types group.
Inserting an Existing Report

With InfoAssist opened in Document view, you can insert existing charts and reports onto the canvas from the Insert tab. The following procedure describes how you can insert reports into new documents and documents that are already populated with reports, text, and images.

**Note:** When working in Document view, you cannot insert an existing report that has a HOLD.

**Procedure:** How to Insert an Existing Report With the Insert Tab

You can create a document in the Custom Reports section of the domain and use Standard Reports items as Existing Report components. You cannot use other Custom Report items as components.

1. With InfoAssist open in Document view, click the *Insert* tab.
2. In the *Reports* group, click *Existing Report*.
   
   An Open dialog box appears.
3. Browse to the report that you want to insert and click *Open*.
   
   The report placeholder is added to the canvas.

**Note:** You cannot edit an existing report that is inserted into a document.

Creating a Document From a Single Report

You can take a single report created in Live Preview or Query Design view and convert it into a document, displaying it in Document view.

When you convert a single report into a document, the original report is preserved and a copy of that report is opened as a document in Document view. You can then add additional reports, charts, images, and text.

Inserting Text and Images

With InfoAssist opened in Document view, you can bring text and images onto the canvas. The following procedures describe how you can insert text and images into new documents and documents that are already populated with reports, text, and images.

**Note:** You can only do this in Document view.

The following procedures detail how to insert text and images. For more information on how to edit existing text and images, see *Editing Components in a Document* on page 104.

**Procedure:** How to Insert Text

1. With InfoAssist open in Document view, click the *Insert* tab.
2. In the Objects group, click Text Box.
   A text component is added to the canvas, containing default text.

3. Double-click, or right-click, the text component to edit the text.
   For more information on editing and styling the text, see How to Edit Text on page 110.

**Procedure:** How to Insert an Image

1. With InfoAssist open in Document view, click the Insert tab.
2. In the Objects group, click Image.
   An Open dialog box appears.
   
   **Note:** By default, the Open dialog box displays image files in the current WebFOCUS Content folder.

3. Browse to the desired image and click OK.
   The selected image is added to the canvas.

**Procedure:** How to Create an Adaptive Dashboard

In Document mode, you can create an Adaptive Dashboard. This is a feature that provides a mobile view with a fixed layout that will make dashboards easier to use while navigating on mobile devices.

1. With InfoAssist open in Document mode, click the Layout tab.
2. In the Page Layout group, click Adaptive Dashboard.
3. Add components as needed.
4. Access the dashboard from a mobile device, making adjustments, as needed.
   
   **Note:** You must run an Adaptive Dashboard using the Run in new window option to take advantage of this feature on a mobile device or tablet. When using an Adaptive Dashboard inside an iframe on a mobile device (for example, when running it from the Home Page without using the New Window option), the output is displayed with the components layout and menu options displayed when run from a desktop.

**Editing Components in a Document**

The reports, controls, and text in a document can be edited, moved, resized, and deleted. Each of these components has a context menu, which can be accessed by right-clicking the component.
Images can be moved, resized, and deleted, but they have no context menu and cannot be edited. Right-clicking an image brings up the option to delete it.

**Procedure: How to Resize a Component**

You can resize a component in the following ways:

- Using the component sizing handles.
- Changing the height and width on the Layout tab, in the Size & Arrange group.
- Accessing the options on the Size tab in the Size and Position dialog box.

The resize feature is available for all components that can be added to a document.

1. Open or create a document with at least one report, text component, control, or image.
2. Resize the component in one of the following ways:

   - **Sizing Handles:** Select the component and drag the sizing handles that appear around it. As you manually increase the height and width of the component, the new values appear in the corresponding text boxes in the Size & Arrange group of the Layout tab.

   - **Ribbon:** You can use the ribbon in one of the following ways:
     - Select the component in the document. On the Layout tab, in the Size & Arrange group, enter values in the Height and Width fields.
     - On the Layout tab, in the Size & Arrange group, click the dialog box launcher to open the Size and Position dialog box, as shown in the following image.

   - **Shortcut Menu:** Right-click the component and select Size and Position. The Size and Position dialog box opens.

**Note:** You must right-click the corner of the component. For charts, if you click on any other point in the chart, the Size and Position option will not display.

From the Size and Position dialog box, open the Size tab.

Use the Height and Width options to change the position of the selected component. You can adjust the pixel size of the object with the Size options or the scale percentage of the object with the Scale options.
You can lock the aspect ratio using the Aspect Ratio button, which is available when working with charts, images, and text boxes while working in Document view. With the aspect ratio locked, changing the width automatically changes the height to keep the component to scale, and changing the height automatically changes the width.

**Note:** The Auto Overflow option is only available while working with reports in Document view through the Size & Arrange group. With Auto Overflow set, you cannot manually set the height and width of a report. The area of the report expands automatically to show all data.

When two objects are selected, the *Relative Position* button sets the bottom-left corner of the component that is higher on the page to the upper-left corner of the one that is lower. Once a relationship is created, arrows appear to show that relationship while both items are still selected.

**Procedure: How to Move a Component**

You can move a component by clicking it, or by accessing the Position section of the Size and Position dialog box. This feature is available for all components that can be added to a document.

You can also align components with each other so that their horizontal or vertical position matches. For more information, see *How to Align Components* on page 106.

1. Open or create a document with at least one report, text component, control, or image.
2. Select the component and move it by using one of the following methods:

   - Drag the component anywhere on the canvas.
   - or
   - Right-click the component and click *Size and Position*.
     - On the Size and Position dialog box, click the *Position* tab.
     - Use the Horizontal and Vertical options to change the position of the selected component.

**Procedure: How to Align Components**

You can align components with each other so that their horizontal or vertical positions match. You must have multiple components selected to use the align options.
The alignment is anchored by the component that is in the farthest position of the selected alignment. For example, if you select two components and click Align Left, the components align horizontally with the component farthest to the left.

1. Open or create a document with at least two components.
2. Select a component.
3. Select a second component by holding the Ctrl key and clicking a component.

**Note:** You can select multiple components simultaneously by holding the Ctrl key and with the left mouse dragging a selection box around the components. When you release the mouse, sizing handles appear around each component that you selected. If the components display with light-grey coloring, this indicates that the components are selected.

Sizing handles appear around the components, as shown in the following image.
4. Align the components using one of the following methods:

- Right-click one of the selected components and select an alignment option from the Align drop-down menu, as shown in the following image.

![Align Options](image)

or

- Access the alignment options from the Align drop-down menu. The menu is available on the Layout tab, in the Size & Arrange group.

The selected components align, as shown in the following image.

![Alignment Result](image)

5. Click anywhere in the canvas to deselect the components.
Procedure: How to Style and Customize a Report

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in How to Move a Component on page 106 and How to Resize a Component on page 105. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can right-click a component to select individual fields to edit through the context menu.

In addition to reports, you can style and customize charts and text. For more information on charts, see How to Style and Customize a Chart on page 109. For more information on text, see How to Edit Text on page 110.

Note: Images cannot be edited.

1. Open or create a document with at least one report.
2. Click the report.
   
   The Query pane becomes active and you can now select fields within the report. Select a field by clicking it in the canvas or in the Query pane.

Procedure: How to Style and Customize a Chart

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in How to Move a Component on page 106 and How to Resize a Component on page 105. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can double-click or right-click a component to select individual fields to edit through the context menu or Field tab.

In addition to charts, you can style and customize reports and text. For more information on reports, see How to Style and Customize a Report on page 109. For more information on text, see How to Edit Text on page 110.

Note: Images cannot be edited.

1. Open or create a document with at least one chart.
2. Click the chart.
   
   The Query pane becomes active and you can now select fields within the chart. Select a field by clicking it in the canvas or in the Query pane.

   You can now edit the selected chart using commands available through the context menu or the ribbon.
Procedure: How to Edit Text

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in How to Move a Component on page 106 and How to Resize a Component on page 105. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can right-click a component to select individual fields to edit through the context menu.

In addition to editing text, you can style and customize reports and charts. For more information on reports, see How to Style and Customize a Report on page 109. For more information on charts, see How to Style and Customize a Chart on page 109.

Note: Images cannot be edited.

1. Open or create a document with at least one text component.
2. Click the text box.
   Sizing handles appear around the border and the text box toolbar becomes active.
3. Click anywhere in the text box and begin entering text.
4. Highlight the text you would like to edit, and right-click it. A menu of options appears, as shown in the following image.

5. Using the menu options, you can style the text and insert quick text.

The text component menu options are as follows:

- Font. Opens a list of available fonts for the selected text.
Procedure: How to Delete a Component

The following procedure applies to all components in Document view.

1. Open or create a document with at least one component.
2. Right-click the component and click Delete.

The component is deleted from the canvas.

Note: You can also delete a component by clicking it and pressing the Delete key.

Creating Multi-Page Documents

In Document mode, content can be created on multiple pages. The available output formats are: HTML, active report, PDF, Excel (xlsx), and PowerPoint (pptx). Additional Excel formats are available, as well.

Note: When working in Document mode using the active report format, you can create a rich, multi-object document that integrates various reports and charts, closely resembling a dashboard.
Microsoft Excel 2007 and Microsoft PowerPoint 2007 are enabled by default in the Administration Console. To enable or disable formats, you must do so in the Administration Console.

- The active report output format combines multiple reports and charts into one document, resulting in a tabbed active dashboard.
- Excel combines multiple reports as different sheets in a workbook.
- PowerPoint combines multiple reports and charts in a single slide.

Creating Multi-page Documents

You can create multi-page documents, allowing you to display an array of information across different pages.

Procedure: How to Create a Multi-page Document

1. Create a new document.
   
   Page 1 appears on the canvas title bar.

2. Add content, such as a new or existing report, chart, text, and images to Page 1.

3. To add another page, do one of the following:
   
   - On the Insert tab, in the Pages group, click Page.
   - On the canvas title bar, click the page icon. From the Page menu that opens, select New Page.

   A new page, for example, Page 2, is inserted after the current page, and appears on the canvas.

   Each new page that you add is named Page n, where n is a unique number increasing by an increment of 1.

4. Add content to Page 2.

5. Repeat steps 3 - 4 until your document is complete.

   To navigate between pages, open the Page menu by clicking the Page icon at the top of the canvas.

Creating a Multi-page Active Technologies Dashboard

You can create a multi-page active technologies dashboard using InfoAssist.
**Procedure:** How to Create a Multi-page Active Technologies Dashboard

1. Create a new active dashboard by setting the output format to active report.
   Page 1 appears on the canvas title bar.
2. Add content, such as a new or existing report, chart, text, images, and active dashboard prompts to Page 1.
3. To add another page, do one of the following:
   - On the Insert tab, in the Pages group, click Page.
   - On the canvas title bar, click the page icon. From the Page menu that opens, select New Page.
   A new page, for example, Page 2, is inserted after the current page, and appears on the canvas.
   Each new page that you add is named Page n, where n is a unique number increasing by an increment of 1.
4. Add content to Page 2.
5. Repeat steps 3 - 4 until your dashboard is complete.
   To navigate between pages, open the Page menu by clicking the Page icon at the top of the canvas.
6. Run the active dashboard.
   The tabs appear at the top of the canvas.

**Navigating the Page Menu**

You can access the Page menu by clicking the Page icon in Design mode.

The Page menu lists the pages in the order in which you created them. You can rearrange the pages using drag-and-drop functionality. You can also select multiple pages and delete them.

In addition, the Page menu contains the New Page option to add a new page to the document. The Duplicate option creates a duplicate page.

The Page menu also contains Page Options which you can click to launch a dialog box of the following options:

- Rename Page
- Move Page Up
Move Page Down

Delete

When you select a page, the Rename, Move Up, Move Down, and Delete options become active in the menu bar at the top of the dialog box. Also, when you right-click a page, a context menu of these same options opens.

The position of the page that you have selected determines which directional options are available. For example, Move Up would not be an option for Page 1. Move Down would not be an option for the last page.

To close the dialog box, click OK.

Using the Active Cache Option

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the Reporting Server.

Tip: It is recommended that you set the number of rows retrieved five times greater than the number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows retrieved is 100.

Enabling Active Cache Through InfoAssist

Active cache is enabled when you select active report as the output type and the Pages on Demand button (Format tab, Navigation group) is enabled.

The Advanced tab on the active report options dialog box contains the Rows Retrieved drop-down list. Use this setting to establish the increments in which the cached data stored in a binary file is returned to the output window. The default is 100.

Note: In a multi-page document, active cache must be enabled per component. It is not globally set. Therefore, when creating a document in AHTML format, you must select each component separately to enable active cache. When you do so, the Pages on Demand button is activated.

Building Visualizations

Visualizations centralize information by providing different views of data that are pertinent to a particular objective. For example, reviewing trends or fluctuations in data over a period of time or within a region. A visualization provides you with a quick glance of information on a single screen.
Visualizations support the use of different types of charts, maps, and grids. For example, you may want to use a bar, pie, and line chart to show different views of the same data. Alternatively, you may want to offset a particular visual by showing other types of related data that employ a different type of visual. You can also add a text cell to your visualization to provide explanatory text or information that other users can reference.

Visualizations allow you to monitor changes in data. They also serve to provide information in real-time, based on changes in underlying data or other components. A visualization can be updated, changed, or revised at any time to account for shifts in data needs.

Creating a Visual

You can create charts, maps, and grids to visually represent your data. You can add multiple visuals to the canvas to create a complete visualization.

The default visual is a bar stacked chart. You can use the Change option in the Visual group on the Home tab to change the visual type.

The following visual is a matrix marker chart that shows sales data for a range of electronic products.
Procedure: How to Create a Visualization From InfoAssist

You can have multiple file types opened at once. To create a visualization:

1. On the Quick Access toolbar, click New.
   
   or

   Click the Application Main Menu button, and click New.

   The InfoAssist splash screen displays.

2. Click Build a Visualization.

3. In the Open dialog box, select a data source and click Open.

   InfoAssist switches to visualization mode.

Changing the Visual Type

You can create a visual using the default chart type, which is a stacked bar chart. You can add your data to this chart and then change the chart type, or you can change the chart type prior to making your data selections.

Once you have started exploring your data, you can switch between the different types to obtain the graphical image that you wish to display.

You change the visual type from the Home tab.

Procedure: How to Change the Visual Type

1. On the Home tab, in the Visual group, click Change, as shown in the following image.

   ![Visual group](image)

   Note: The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.

   The Select a Visual menu displays.

2. On the Select a Visual menu, click the type of visual that you want to use.

   Your canvas refreshes and displays the visual that you selected.
Note: Depending on the type of visual that you select, you may need to select additional or different data fields.

Selecting a Visual

It is important that you select a chart, grid, or map that appropriately displays a meaningful view of your data. InfoAssist provides a library of visuals.

You can select a visual type from the Select a Visual menu, on the Home tab, in the Visual group. The following table describes the types of charts available.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Visual Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📖</td>
<td>Grid</td>
<td>Grids provide a tabular view of data. They allow you to review data in a row and column format, similar to a printed report.</td>
</tr>
<tr>
<td>📊</td>
<td>Bar chart</td>
<td>Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis).</td>
</tr>
<tr>
<td>📊</td>
<td>Stacked bar chart</td>
<td>A stacked bar chart is the default visual.</td>
</tr>
<tr>
<td>📊</td>
<td>Histogram</td>
<td>Histograms graphically represent the distribution of numeric data. They facilitate the identification and discovery of the underlying frequency distribution within a set of continuous data. You can use histograms to identify trends and illustrate categorizations, or groupings, also known as bins. For more information, see Binning on page 35.</td>
</tr>
<tr>
<td>📊</td>
<td>Absolute line chart</td>
<td>Line charts allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited for a line chart.</td>
</tr>
<tr>
<td>Icon</td>
<td>Visual Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Area chart" /></td>
<td>Area chart</td>
<td>Area charts analyze trends over time and look for differences in values.</td>
</tr>
<tr>
<td><img src="image" alt="Stacked area chart" /></td>
<td>Stacked area chart</td>
<td>Stacked area charts allow you to stack data on top of each other.</td>
</tr>
<tr>
<td><img src="image" alt="Pie chart" /></td>
<td>Pie chart</td>
<td>Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where your data fits, in relation to the other components in the pie.</td>
</tr>
<tr>
<td><img src="image" alt="Ring pie chart" /></td>
<td>Ring pie chart</td>
<td>Ring pie charts are useful when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure.</td>
</tr>
<tr>
<td><img src="image" alt="Scatter Plot" /></td>
<td>Scatter Plot</td>
<td>Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data.</td>
</tr>
<tr>
<td><img src="image" alt="Bubble chart" /></td>
<td>Bubble chart</td>
<td>Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values. The third variable (Z) represents size. The size of each bubble is used to show the relative importance of the data.</td>
</tr>
<tr>
<td><img src="image" alt="Matrix Marker chart" /></td>
<td>Matrix Marker chart</td>
<td>Matrix marker charts are useful for analyzing one or two measures against a crosstab of two categorical dimensions. The result is a color-scaled matrix chart that shows categorized trends.</td>
</tr>
<tr>
<td>Icon</td>
<td>Visual Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------</td>
<td>-------------</td>
</tr>
<tr>
<td><img src="image" alt="Treemap Icon" /></td>
<td>Treemap</td>
<td>Treemaps are used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree.</td>
</tr>
<tr>
<td><img src="image" alt="Gauge Icon" /></td>
<td>Gauge</td>
<td>Gauges are used to display the value of a measure. In particular, circular gauges are used to represent a single data value within a given spectrum. You can create a single circular gauge for a measure or a matrix circular gauge, which shows the value of the selected measure across different dimensions, such as product category or yearly sales.</td>
</tr>
<tr>
<td><img src="image" alt="Choropleth Map Icon" /></td>
<td>Choropleth map</td>
<td>A geographically-based heat map. It is useful for visualizing location-based data, trends, and distributions across a geographic area.</td>
</tr>
<tr>
<td><img src="image" alt="Proportional Symbol Map Icon" /></td>
<td>Proportional symbol map</td>
<td>A technique that uses symbols of different sizes to represent data associated with different areas or locations within the map.</td>
</tr>
<tr>
<td><img src="image" alt="Heatmap Icon" /></td>
<td>Heatmap</td>
<td>A heatmap is a graphical representation of data where the individual values that comprise a matrix are represented as colors. Using radiant hues, you can track the intensity of a data relationship using the colors defined in the legend.</td>
</tr>
</tbody>
</table>

**Note:** When new data is added to a bar, line, area, pie, scatter, bubble, gauge, or treemap chart, the chart will morph and rebuild, revealing the new values in a smooth transition.

Use the topics in this section to select and create your visuals.

**Grids**

Grids provide a tabular view of data. They allow you to review data in a row and column format, similar to a printed report.
In the following example, we review the Sale Year and Product Category data for the following measure fields:

- Revenue
- Gross Profit

![Table showing Sale Year, Product Category, Revenue, and Gross Profit for years 2014, 2015, and 2016.]

**Procedure: How to Create a Grid**

1. Change the visual to a grid, or insert a new grid.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Rows or Columns - one or more data fields
   - Measure - one or more data fields

As you add, edit, or rearrange the fields in your Query field containers, your canvas refreshes.
Bar Charts

Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis). The length of a bar corresponds to a value or amount. You can clearly compare data series (fields) by the relative heights of the bars. Use a bar chart to display the distribution of numerical data. You can create horizontal and vertical bar charts.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.

Use a bar chart when individual values are important. For example, the following image is a basic vertical bar chart that compares the individual products sold to the total amount in sales for each product. A retailer would find it important to know which pieces of inventory are selling and how much revenue each item is generating for the company.
A horizontal bar chart becomes useful when you want to emphasize a ranking relationship in descending order, or the X-axis labels are too long to fit legibly side-by-side. For example, the following image is a basic horizontal bar chart that ranks which products are generating the most revenue for the retailer.

![Horizontal Bar Chart Example]

**Note:** You can swap the orientation of your data in a bar chart. To do so, on the Home tab, in the Visual group, click Swap.

**Procedure:** How to Insert a New Bar Chart

1. Change the visual to a bar chart or insert a new bar chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field

   **Note:** You can also double-click a data field to add it to your Query field containers.

The bar chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the bar chart.
**Procedure:** How to Create a Stacked Bar Chart

The bar stacked visual is the default visual.

1. Change the visual to a stacked bar chart or insert a new stacked bar chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one or more data fields
   - Color - one data field

   **Note:** You can also double-click a data field to add it to your Query field containers.

   The stacked bar chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the stacked bar chart.

**Line Charts**

Line charts allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited for a line chart.

You can also plot line charts with two or more scales to present a comparison of the same value, or set of values, in different time periods.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.
Use a line chart when you want to trend data over time, for example, monthly changes in employment figures, or yearly sales of an item in your inventory. The following image is a line visual that shows the gross profit in monthly sales for products.

**Procedure:** How to Create a Line Chart

1. Change the visual type to a line chart or insert a new line chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

**Note:** You can also double-click a data field to add it to your Query field containers.

To add insight, you can drag a data field to the color Query field container. This displays the values for this field using color.
The line chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the line chart.

**Area Charts**

Area charts analyze trends over time and look for differences in values by using the see-thru nature of the area fills. Stacked area charts allow you to stack data on top of each other. Stacking allows you to highlight the relationship between data series, showing how some data series approach a second series.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.

Use an area chart when you want to distinguish the data more dramatically by highlighting volume with color. For example, the following image is a basic area chart that depicts the yearly gross profit for various electronic products.
Procedure: How to Create an Area Chart

1. Change the visual type to an area chart or insert a new area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

Note: You can also double-click a data field to add it to your Query field containers.

The area chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the area chart.

Procedure: How to Create a Stacked Area Chart

1. Change the visual type to a stacked area chart or insert a new stacked area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

Note: You can also double-click a data field to add it to your Query field containers.

The stacked area chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the stacked area chart.

Pie Charts

Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where your data fits, in relation to the other components in the pie. Pie charts work best when there are a limited number of slices (for example, less than 10) and the slices are all of a sufficient value as to reveal their fill color inside their wedge.
Use a pie chart when you have segments of data that you want to display as a whole. For example, the following image is a pie chart that shows the proportions of various electronic products based on the quarterly revenue.

![Pie Chart Image]

You can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:** When working with pie charts, you can add one measure field to the Color field container. This adds the measure as a By field, and determines how the pie chart is colored. Depending on your measure data, this may result in a large number of pie segments.

**Procedure:** *How to Create a Pie Chart*

1. Change the visual type to a pie chart or insert a new pie chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
   The following Query field containers must be populated for this visual:
   - **Measure** - one data field. Data in this category is used to indicate the size of the pie slice for the relevant category.
   - **Color** - one data field. Data in this category indicates the colors in your pie chart.
**Note:** You can also double-click a data field to add it to your Query field containers.

The pie chart displays on the canvas. You can add additional data fields for comparative purposes, or to create another pie chart on the same canvas. You can also view underlying data by hovering over any particular point on the pie chart.

**Ring Pie Charts**

Ring pie charts are circular charts that display the total for the selected measure, as well as the individual segments that comprise the ring pie chart. You can hover over each segment to review the underlying data values. This is useful when comparing the measure value for an individual segment against the total for the measure, which displays in the center of the ring pie.

You can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique ring pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:** The font size of the value label in the middle of the ring is automatically set by the chart engine.
Use a ring pie chart when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure. The following image is an example of a ring pie chart.

**Procedure**: How to Create a Ring Pie Chart

1. Change the visual type to a ring pie chart or insert a new ring pie chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - **Measure** - one data field. Data in this category is used to indicate the size of the ring pie segment for the relevant category.
   - **Color** - one data field. Data in this category indicates the colors in your ring pie chart.

**Note**: You can also double-click a data field to add it to your Query field containers.

The ring pie chart displays on the canvas. The total for the selected measure displays in the center of the ring pie chart. You can view underlying data by hovering over any of the ring pie chart segments.
**Scatter Charts**

Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart, by default.

**Note:** You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak relationship, or no relationship.

Adding data fields to the Detail Query field container creates additional BY fields on the scatter chart. For example, the following image shows the results when adding the Product, SubCategory and Model dimension fields to Detail Query field container in a scatter chart which showed gross profit and MSRP data.

![Scatter Chart Example](image.png)

**Procedure:** **How to Create a Scatter Chart**

1. Change the visual type to a scatter chart or insert a new scatter chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

- Vertical Axis - one data field
- Horizontal Axis - one data field
- Detail - one or more data fields
- Color - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The scatter chart displays on the canvas. You can also view underlying data by hovering over any particular point on the scatter chart.

**Bubble Charts**

A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values, in that order. The Z variable represents size. The size of each bubble is used to show the relative importance of the data.

When you add a data field to the Size field container, this value is represented as the Z Axis Title in the legend. It displays as an empty Z Axis Title when a size data field is not specified. If you choose to indicate a Z, or size, data value, the data label displays in the legend. A Size Legend also displays, showing the estimated data value for a range of circle sizes. This allows you to estimate the value of the data based on the size of the circle.

**Note:**

- You can hover over the circles in the visual to obtain exact data values for any given point.
- You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.
- In Visualization mode and for HTML5 charts, if you select the No fill option for your Series style when creating a bubble chart, the series displays in shades of black. For active charts, you must enable the Show Border Color option in order to view the bubbles in your chart at run time, otherwise the bubbles are invisible.
In the following image, a bubble chart is used to show the Manufacturers Suggested Retail Price (MSRP) plotted against Revenue for a variety of electronics products. It also shows the values for Gross Profit, which was specified in the Size field container in the Query pane.

**Procedure:** How to Create a Bubble Chart

1. Change the visual to a bubble chart or insert a new bubble chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one data field
   - Horizontal Axis - one data field
   - Detail - one or more data fields
   - Size - one data field
   - Color - one data field (optional). Labels for the values in this data field will comprise the legend.

**Note:** You can also double-click a data field to add it to your Query field containers.

The bubble chart displays on the canvas. You can also view underlying data by hovering over any particular point on the bar chart.
Matrix Marker

Matrix marker charts are useful for analyzing one or two measures against a crosstab of two categorical dimensions. You can use the Size Query field container for one measure and the Color Query field container for a second measure. The result is a color-scaled matrix chart that shows categorized trends, as shown in the following image.

Procedure: How to Create a Matrix Marker Chart

1. Change the visual to a matrix marker chart or insert a new matrix marker chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Matrix Rows - one data field
   - Matrix Column - one data field
   - Size - one data field. The data for this field determines the size of the marker.
   - Color - one data field. The data in this field determines the color of the marker.

The matrix marker chart displays.
Treemaps

Treemaps are used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree. Each branch is given a rectangle, to which any number of smaller sub-branches can be assigned. The size of each branch is proportional to the summed values of the elements inside the branch.

The following treemap shows the categories of the selected dimension fields, using two data fields to determine the size and color of the treemap segments.

![Treemap Diagram]

**Procedure:** How to Create a Treemap

1. Change the visual to a treemap or insert a new treemap.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Grouping - one or more data fields, which establishes the hierarchy of the Treemap grouping.
   - Size - one data field. This data controls the size of the branches that display.
   - Color - one data field. This data controls the colors that display based on the accompanying gradient.
The treemap displays.

**Gauges**

Gauges are used to display the value of a measure. In particular, circular gauges are used to represent a single data value within a given spectrum. These gauges have a circular shape. You can create a single circular gauge for a measure or a matrix circular gauge, which shows the value of the selected measure across different dimensions, such as product category or yearly sales. The value of the measure that displays in a circular gauge is determined by the underlying data stored for that measure in the database.

The circular gauge functionality uses only one measure in its presentation. The legend reflects the color of the measure within the circular gauge.

In the following example, we review revenue data for each product category by quarterly sales in a matrix circular gauge chart.

<table>
<thead>
<tr>
<th>Sale Quarter</th>
<th>Accessories</th>
<th>Computers</th>
<th>Media Player</th>
<th>Televisions</th>
<th>Video Production</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>25.7M</td>
<td>19.7M</td>
<td>47.8M</td>
<td>14.9M</td>
<td>11.4M</td>
</tr>
<tr>
<td>2</td>
<td>24.1M</td>
<td>22.0M</td>
<td>44.5M</td>
<td>13.6M</td>
<td>10.9M</td>
</tr>
<tr>
<td>3</td>
<td>24.5M</td>
<td>24.6M</td>
<td>45.4M</td>
<td>14.4M</td>
<td>11.0M</td>
</tr>
<tr>
<td>4</td>
<td>30.7M</td>
<td>29.0M</td>
<td>56.8M</td>
<td>17.4M</td>
<td>13.8M</td>
</tr>
</tbody>
</table>

**Procedure:**  How to Create a Circular Gauge

1. Change the visual type to a gauge or insert a new gauge.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following query field containers must be populated for this visual:

- **Measure** - one data field. Data in this category is used to indicate the value of the selected measure, which displays within the gauge.

- **Tooltip** - one or more data fields. The fields that you add provide you with the ability to review additional related, underlying data for different measures. Tooltips are optional.

**Note:** You can also double-click a data field to add it to your Query field containers.

The circular gauge displays on the canvas. You can select additional measure fields for which to include in the tooltip.

### Heatmaps

A heatmap is a graphical representation of data where the individual values that comprise a matrix are represented as colors. Using radiant hues, you can track the intensity of a data relationship using the colors defined in the legend.

Heatmaps are useful when you are looking for hot spots in your data, or areas of focus or interest, as shown in the following image.
**Procedure:** How to Create a Heatmap

1. Change the visual to a heatmap or insert a new heatmap.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

   - **Color** - one data field. This data controls the colors that display based on the accompanying gradient.
   - **Horizontal field container** - one data field.
   - **Vertical field container** - one data field

**Note:** You can optionally populate the Matrix Row and Column fields to increase the segmentation of your heatmap.

The heatmap displays.

**Interacting With Visualizations**

A visualization is comprised of one or more visuals, such as charts, maps, or grids and text. You can create different views of your data in a single visualization, and share that visualization with others in your enterprise.

The following image shows a sample visualization. This visualization includes a map, a matrix grid, and a stacked area chart.
This section summarizes the tasks that are available to you when working with visuals. It provides centralized instructional information on performing each task and offers links to the most common topics when working with visuals.

<table>
<thead>
<tr>
<th>Task</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change visual</td>
<td>On the Home tab, in the Visual group, click Change.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.</td>
</tr>
<tr>
<td></td>
<td>Select a chart, map, or grid from the Select a Visual menu.</td>
</tr>
<tr>
<td>Insert new visual</td>
<td>On the Home tab, in the Visual group, click Insert.</td>
</tr>
<tr>
<td></td>
<td>Use the default stacked bar chart or click Change to select a different chart, map, or grid from the Select a Visual menu.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also add additional charts, maps, or grids to a visualization by dragging a data field onto the canvas and placing it using the handles that are available.</td>
</tr>
<tr>
<td>Rearrange visuals</td>
<td>Drag a visual on top of another visual to activate a shaded area that contains handles, which can be used to indicate placement.</td>
</tr>
<tr>
<td>Copying a visual</td>
<td>On the canvas, select a visual. On the Home tab, in the Clipboard group, click Copy.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also press CTRL+C to copy a selected visual.</td>
</tr>
<tr>
<td>Pasting a visual</td>
<td>Copy a visual. On the Home tab, in the Clipboard group, click Paste.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> You can also press CTRL+V to paste a copied visual on the canvas.</td>
</tr>
</tbody>
</table>
## Task | How To
--- | ---
Duplicating a visual | On the canvas, select a visual. On the Home tab in the Clipboard group, click Duplicate. A duplicate visual is created and a sequential number is assigned based on the type of visual.
Delete visual | Select a visual. On the Home tab, in the Clipboard group, click Cut. You can click the Close button in the upper-right corner of the current visual. From the Query pane, right-click a visual and click Delete. You can also press the Delete key when a visual is selected.
Apply Filter | Drag a dimension field or measure field into the Filter pane to access the filter options that are available. To add filter options for a field that is already in the Query pane, select the field and on the Field tab, in the Filter group, click Filter.
Add visuals to the storyboard | Create a visual. On the Home tab, in the Storyboard group, click Add.

**Procedure:** How to Insert a New Visual

1. On the Home tab, in the Visual group, click the down arrow next to Insert.
2. On the menu, click one of the following options:
   - **Chart.** Inserts a stacked bar chart visual.
   - **Grid.** Inserts a grid visual.
   - **Text.** Inserts a blank text cell.
3. Populate your visual with data or add text to the text cell.

**Note:**
- By default, when you click Insert, a stacked bar chart visual is inserted.
You can also drag a data field from the Data pane to the canvas to insert a new visual. This inserts the default visual, a stacked bar chart. You can use the placement handles to position your new visual on the canvas, for example, above an existing visual or to the side of an existing visual.

Procedure: How to Add Text to Your Visualization

1. On the Home Tab, in the Visual group, click the down arrow on next to Insert.
2. On the menu, click Text.
   A text cell opens on the canvas.
3. Add text to your visualization.

Note: You can resize the text cell and use the text formatting options to customize the display of any text that you add, as shown in the following image.

You can also position the text cell in your visualization by dragging the text cell on top of a visual. Use the placement handles to indicate placement of the text cell.

Procedure: How to Create a Visualization

1. Begin with the default canvas, which consists of a stacked bar chart template.
2. Insert a new visual in one of the following ways:
   
a. Drag a data field from the Data pane onto the canvas. Handles display, which allow you to select the location for the new visual, for example, top (above) or left of the current visual, as shown in the following image.

   ![Insert visual](image)


      **Note:** You can optionally click the down arrow on the Insert button to specify the addition of a chart, grid, or text.

3. Add another visual.

   Now, three visual cells display side-by-side.

4. Click a visual to select it.

   **Note:** You can click a visual to activate it, or double-click on the visual number or name in the Query pane.

5. Reorganize your visuals using the handles.
6. Once you have organized the placement of your visuals, select one and specify the visual type.
   

   **Note:** The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.

   b. In the Select a Visual menu, click the type of visual you want to use. For example, Line, Area, or Map.

   c. Repeat these steps for all three visuals on your canvas.

7. Populate each visual with your data.

   You can change the type of visual that you previously selected at any time. You can also resize or reorganize the position of each visual as you add data.

   For example, move the lower-left visual to the top of the visualization.
The bubble chart now runs across the top of the visualization.

8. Click Save to save your visualization.

**Minimizing or Maximizing a Visual**

When working on a visualization with more than one chart, map, or grid, you can maximize and minimize individual visuals. This allows you to focus on one visual at a time, and then minimize it to view it alongside the other visuals.

The maximize and minimize icons are located in the top-right corner of each visual, next to the Close button. When you click the Maximize icon, the current visual moves to the foreground and is the only visual that displays on the canvas. You can work on this visual, and then minimize it to view the other visuals.

**Note:** You can view other visuals in the maximized mode by selecting a different visual in the Query pane.

**Procedure:** How to Minimize or Maximize a Visual

1. Create a visualization with two or more visuals.
2. Perform the following actions to minimize or maximize your visual:
   - Click the maximize icon or double-click on the Title bar to maximize your visual.
   - Click the minimize icon or double-click on the Title bar to minimize your visual.

   You can maximize one visual at a time, and you can switch between visuals in this mode
   by double-clicking a different visual in the Query pane.

**Procedure:**  How to Delete a Visual

1. In your visualization, select the chart, map, or grid that you want to delete.
2. Perform one of the following tasks to delete the visual:
   - Press the Delete key.
   - On the **Home** tab, in the **Clipboard** group, click **Cut**.
   - Click the **Close** button in the upper-right corner of the current visual.
   - From the Query pane, right-click on a visual, and click **Delete**.

   **Note:** You can use the Undo and Redo options on the Quick Access Toolbar to reverse or
   redo any prior actions.

**Renaming a Visual**

You can rename a visual on the canvas or within your visualization. You may want to do this for
presentation and organizational purposes, as each visual has a default label (for example, Bar
1, Bar 2, and Bar 3). You can change these labels by renaming the visual in the Query pane.

Once new labels are in place, it is easier to recognize which visual you want to select at any
given time.

Using the shortcut menu for a visual in the Query pane, you can also rename your visual.

**Procedure:**  How to Rename a Visual

1. Create a visualization with one or more chart, map, or grid.
2. In the Query pane, right-click the visual number for which you want to modify the title.
3. Click **Rename**.
4. In the Edit Title dialog box, enter a new name for the visual.
5. Click **OK**.
   The visual is renamed in the Query pane and the new title is reflected at the top of the
   selected visual.
Using Paper-Clipping to Group Values in a Visual

Paper-clipping gives you the advantage of lassoing values in a visual to create logical groups within your selected dimension. Paper-clipping uses the core functionality of dynamic grouping, giving you access to grouping capabilities that meet your business needs. You can also add additional groupings or fields to an existing group, and rename the groups and values, giving you control over how the information displays.

When you paper-clip values together, a new group is created using the naming convention of dimensiongroup_1. You can add values to this group by lassoing this grouped component, along with any additional components you want to add. These new values become part of that existing group.

**Note:** If you group two values and then add another value to that grouping, you must manually rename the group in order to update its display.

If you lasso other values in your visualization, and you do not capture or include a previously defined grouping, a new grouping is created for the selected fields in the current dimension. It is labeled using the original dimension label (dimensiongroup_1), but a new, unique grouping is created for these values. You can see the groupings by right-clicking the group in the Query pane and selecting *Edit Group*. If you want to add new values to an existing group, you must lasso the existing group, in addition to the fields that you want to add to it, in order to combine the additional fields into the existing grouping.
To enable paper-clipping, lasso the values that you want to group, release the mouse, and from the menu that displays, select \textit{Group n Selection}, where \( n \) is the dimension associated with the values you select. This menu is shown in the following image.

\begin{figure}[h]
\centering
\includegraphics[width=\textwidth]{chart.png}
\caption{Example of a chart with paper-clipping menu.}
\end{figure}

\textbf{Note:} Paper-clipping allows you to group on the first BY field only. In the example above, the first BY field is Product Category. If you are working with a matrix chart and you apply this rule, you are only able to group on the first BY field. In addition, you cannot group on a numeric field (for example, \texttt{Sales-Year}). In this case, if the numeric field was the first BY field, grouping is not available.
Once you group the values, they display in a unique group on the relevant axis. The group label is based on the original values stored for those components. For example, in the previous image, we grouped Camcorder and Computers in the PRODUCT_CATEGORY_1 group, as shown in the following image.

Once you create a group, you can easily perform the following functions:

- **Edit group.** Opens the Edit Group dialog box, where you can edit the values in the current group. For example, you can add additional values into the current group or delete them. For more information on editing an existing group, see *Dynamic Grouping*.

- **Rename group.** Enables you to rename the group using the Rename Group dialog box. The revised name displays along the relevant axis and replaces the existing field name in the Query pane.

- **Rename x.** Enables you to rename the group name (x) that is assigned based on your grouping. This is particularly useful in cases where space is an issue in your visualization. This revised value also replaces the original group name in the Edit Group dialog box.

- **Ungroup x.** Ungroups the values of the group (x) that were previously grouped.

- **Ungroup All.** Ungroups all existing groups, returning the visualization to its original state.

  **Note:** Upon ungrouping all groups, the original dimension displays as a group in the Query pane, by default. However, no grouping is applied.
These options are shown in the following image.

**Note:** You can also edit an existing group by right-clicking the group in the Query pane and selecting *Edit Group.*
If you want to add another value to an existing group, lasso the existing group and the new value. From the menu, click *Merge with x*, where x is the value of the existing group, as shown in the following image.
The new value is added to the existing group. You can then rename the group so that its label contains all values in the group. You can optionally label it with a new, unique name. This option is shown in the following image.

![Image of grouped values]

**Note:** You can also use the Edit Group dialog box to rename groups or groupings. For more information, see *Dynamic Grouping*.

You can use the following procedures to create and manage your paper-clipped values.

**Procedure:** How to Paper-Clip Two or More Values Together

1. In visualization mode, create a bar chart with one measure and one dimension. The bar chart displays.
2. Lasso two or more columns in the visualization.
3. From the menu that displays, click *Group n Selection*, where n is the name of the dimension in your bar chart.
   The two values are paper-clipped together, or grouped, as indicated on the x-axis.

   **Note:** If you have swapped the orientation of your visualization, the paper-clipped values display on the y-axis.

**Procedure:** How to Merge an Additional Value into an Existing Group

1. In visualization mode, create a bar chart with one measure and one dimension. The bar chart displays.
2. Lasso two or more columns in the visualization.

3. From the menu that displays, click Group \( n \) Selection, where \( n \) is the name of the dimension in your bar chart. The two values are paper-clipped together, or grouped, as indicated on the x-axis.

   **Note:** If you have swapped the orientation of your visualization, the paper-clipped values will display on the y-axis.

4. Lasso this existing group, as well another column, to merge this additional value into the group.

5. From the menu that displays, click Merge with \( x \), where \( x \) is the name of the group you originally created. This value is merged into the existing group.

   **Note:** The name of the group is not dynamically updated. In order to reflect the contents of the revised group, you must edit the group using the right-click menu option or the Edit Group option that is available in the Query pane.

**Procedure:** How to Rename an Existing Group

1. In visualization mode, create a bar chart with one measure and one dimension. The bar chart displays.

2. Lasso two or more columns in the visualization.

3. From the menu that displays, click Group \( n \) Selection, where \( n \) is the name of the dimension in your bar chart. The two values are paper-clipped together, or grouped, as indicated on the relevant axis.

4. Lasso the grouped column and from the menu that displays, click Rename \( x \), where \( x \) is the existing label of the group.

5. In the Rename Value dialog box, enter the new name for the group.

6. Click OK. The group is renamed, as shown on the relevant axis.

   **Note:** Optionally, you can rename a group using the Edit Group dialog box. This is available when you right-click on a grouped value in the Query pane and click Edit Group. For more information, see Dynamic Grouping.
Using Multi Drill in Visualization Mode

Similar to the functionality that is available in Chart mode, you can create multiple drill down links on a measure field in a visualization. This enables you to define custom links to other reports or websites, making it easy to link content from internal and external sources. Once defined, these links display on the shortcut menu that displays when you hover over a riser, as shown in the following image.
You create multiple drill downs using the Drill Down dialog box, which you can access from the Links group on the Field tab. In the Query pane, click a measure to enable the Field tab. In the Links group, click Drill Down. The Drill Down dialog box displays, as shown in the following image.

Note: When creating a drill down in Visualization mode, the Auto Link Target option is not available.

For more information and instructional guidance, see Using Multi Drill.

Creating Matrix Charts

Matrix charts are powerful, comparative tools. They provide enough detail to show a trend and they organize information in a categorical fashion.

Matrix charts display data in a grid, showing the comparative values on either axis. They provide you with a quick glance at trends over time, giving you a succinct synopsis of a situation (for example, sales or investment trends).

You can use various formats in your matrix chart (for example, pie or line chart).
In the following example, quarterly revenue data is reviewed by product category, for a range of years (2014 - 2016, specifically). Using a bar chart for the matrix, you can review how gross profit for each product category shifts over time.

![Matrix Bar Chart Example](chart-image)

You can plot one value on the X axis and one value on the Y axis. For example, sales against region. You can also plot just one value for the rows or columns in the matrix chart.

**Procedure:** How to Create a Matrix Bar Chart

1. Launch InfoAssist in Chart or Visualization mode.
   
   ☑ In Chart mode, on the Format tab, in the Chart Types group, click Bar chart.
   
   ☑ In Visualization mode, on the Home tab, in the Visual group, click Change and click Bar chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:

   ☑ Vertical Axis - one or more data fields
Procedure: How to Create a Matrix Line Chart

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Line chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Line chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Matrix Rows - one data field
   - Matrix Columns - one data field

   Note: You can also double-click a data field to add it to your Query field containers.

The matrix line chart displays on the canvas. You can add additional fields for comparative purposes. In visualization mode, you can also view underlying data by hovering over any particular point on the matrix line chart.

Procedure: How to Create a Matrix Area Chart

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Area chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

- Vertical Axis - one or more data fields
- Horizontal Axis - one data field
- Matrix Rows - one data field
- Matrix Columns - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

A matrix area chart displays on the canvas. You can add additional data fields for comparative purposes. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix area chart.

**Procedure:** How to Create a Matrix Pie Chart

1. Launch InfoAssist in Chart or Visualization mode.

   - In Chart mode, on the *Format* tab, in the *Chart Types* group, click *Pie chart*.
   
   - In Visualization mode, on the *Home* tab, in the *Visual* group, click *Change* and click *Pie chart*.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:

   - Measure - one data field

     **Note:** Each unique measure field is represented by a separate pie chart.

   - Color - one data field
   - Matrix Rows - one data field
   - Matrix Columns - one data field

   **Note:** You can also double-click a data field to add it to your Query field containers.

   The matrix pie chart displays on the canvas. You can add additional data fields for comparative purposes, or to create another pie chart unique to the additional measure fields you select. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix pie chart.
Procedure: How to Create a Matrix Ring Pie Chart

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a chart dialog box, click Pie, then click Ring Pie.
   - Click OK.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Ring Pie.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
   - The following Query field containers must be populated for this chart:
     - Measure - one data field
     - Color - one data field
     - Matrix Rows - one data field
     - Matrix Columns - one data field
   - Note: You can also double-click a data field to add it to your Query field containers.

   The matrix ring pie chart displays on the canvas. You can add additional fields for comparative purposes, or to create another pie chart unique to the additional measure fields you select. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix ring pie chart.

Procedure: How to Create a Matrix Circular Gauge

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a chart dialog box, click Special, then click Gauge.
   - Click OK.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Gauge.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.
   - The following query field containers must be populated for this chart:
     - Measure - one data field. Data in this category is used to indicate the value of the selected measure, which displays within the gauge.
Note: Since the gauge relies on a constant (measure field), each intersection of the matrix chart is calculated using that measure along with the various matrix rows and columns in the matrix chart.

- Matrix Rows - one data field.
- Matrix Columns - one data field.
- Tooltip - one or more data fields. The fields that you add provide you with the ability to review additional related, underlying data for different measures. Tooltips are optional.

Note: You can also double-click a data field to add it to your Query field containers.

The matrix circular gauge displays on the canvas. You can select additional measure fields for which to include in the tooltip.

Using Active Technologies

This topic provides an overview of Active Technologies and discusses security and active cache processing. It includes additional information about the features of the product that will help you use it. It is intended for administrators and developers who are responsible for creating active reports, charts, and dashboards.

This topic also describes the features of an Active Technologies report, which is a report that is enabled to use the full capabilities of Active Technologies. An Active Technologies report is also called an active report.

Active Technologies Report Overview

An active report is a report that is designed for offline analysis. When using an active report, you can:

- Interact with the data, using analysis options similar to those found in an Excel® workbook, without any connection to a server. Analysis options include filtering, sorting, charting, and much more.

- Work offline without any additional plug-ins or programs. An active report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems.

- Save the report on a local machine with active report functionality. Since no connection to a server is required to view the data or use the analysis options, you can save and use the report anywhere.
Performance may vary across browsers due to browser-specific memory limitations. For very large reports, Internet Explorer® may produce an error. For more information, refer to the Microsoft® website.

When working with an active report, you can:

- Filter or highlight data.
- Sort data within any column in ascending or descending order.
- Apply calculations to columns and choose the location at which to display results.
- Control the display of data by hiding columns, freezing columns, limiting the number of rows per page, and using graphic visualization to compare column values.
- Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.
- Apply a global filter to multiple reports within the same HTML page.
- Export report data and chart data.
- Restore original report settings.
- Run active reports on your mobile device with the Opera browser (Version 8.60 U2 or higher) installed. See the Opera website for a list of supported devices.
- Run active reports on your iPhone® mobile device. For the best performance results, it is recommended that you set a maximum of 500 records for a mobile report.

Some active report functionality is drag and drop based, and thus not supported with iPhone.
The following image shows an HTML active report. The shortcut menu is open for the Sale Unit(s) column, with the Calculate Avg operator selected.

<table>
<thead>
<tr>
<th>Store Region</th>
<th>Business Sub Region</th>
<th>Revenue</th>
<th>Sale Unit(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>Africa</td>
<td>$26.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td></td>
<td>$37</td>
</tr>
<tr>
<td></td>
<td>Europe</td>
<td>$396.2</td>
<td></td>
</tr>
<tr>
<td>North America</td>
<td>Canada</td>
<td>$51.1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>East</td>
<td>$39.0</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Mexico</td>
<td>$12.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Midwest</td>
<td>$80.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>$1.5</td>
<td></td>
</tr>
<tr>
<td></td>
<td>South</td>
<td>$77.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td>$4.4</td>
<td></td>
</tr>
<tr>
<td></td>
<td>West</td>
<td>$382.3</td>
<td></td>
</tr>
<tr>
<td>Oceania</td>
<td>Australia-New Zealand</td>
<td>$1.2</td>
<td></td>
</tr>
<tr>
<td>South America</td>
<td>SA-Port</td>
<td>$25.9</td>
<td></td>
</tr>
<tr>
<td></td>
<td>SA-Span</td>
<td>$1.2</td>
<td></td>
</tr>
</tbody>
</table>

14 of 14 records, Page 1 of 1
The following image shows the options that are available at the cell level for a report in active report format. Included are the options that reflect Auto Drill, Multi Drill, and Auto Linking functionality. For more information, see *Customizing Content*.

Security Features

You can password protect an active report. This feature restricts users from viewing the report by requiring them to enter a password before opening the report. The data is encrypted using the 256-bit Advanced Encryption Standard (AES) specification. The password is used as the key for decrypting and encrypting the data. Therefore, the password is not stored in the report, and you do not need a connection to go back to the server for password verification.

The HTML page that you receive contains both the JavaScript and the data for the report so that you can interact with the data in a disconnected mode. Internet Explorer detects the JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions explicitly the detection of active content, which is the JavaScript. The same warning appears when pop-ups are blocked in the browser.
**Handling a Large Amount of Data**

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the WebFOCUS Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when active cache is enabled. Since active cache uses on-demand paging functionality, WebFOCUS Viewer is not supported.

The active report with active cache option in the clustered server environment, using Cluster Manager (CLM), will maintain the connection with the WebFOCUS Reporting Server on which the temporary cache is created. This enables the retrieval of subsequent pages from the browser, while the report is in the same browser session.

The active cache feature uses a POST instead of a GET in an HTTP request.

**Distribution and Viewing Considerations**

Active Technologies stores an active report as an HTML file. The HTML file created by Active Technologies contains both the report data and the JavaScript code that enables you to interact with the data in disconnected mode.

An active report is designed for distribution to users who need to perform offline analysis and interactive functions without connection to a server.

You can save an active report from your web browser to another location. You can also send an active report to another person by email, as an HTML attachment. However, when you distribute an active report, you must keep in mind how it will be viewed.

For example, when you send an active report as an HTML attachment to email, many client email programs on a mobile device can block the JavaScript in the attachment. A third-party tool, such as the Mobile Faves App for a mobile device, may be used to correctly view the attachment.

If you try to view an active report in a web browser, and JavaScript is blocked or disabled on your web browser, you will receive a message reminding you that JavaScript must be enabled on the browser. If you are using a mobile device, the message directs you to use the Mobile Faves App. If the Mobile Faves App is not installed, you can download it from the App Store® for iOS devices or from the Google Play™ store for Android™ devices. In the message, App Store and Google Play store are hyperlinks to the Mobile Faves App.
The message is displayed on the Desktop or on a supported mobile device when JavaScript is disabled in a web browser used to open an online or offline active report. It is also displayed on the Preview pane or window of an application used to preview the content of an offline active report.

The following image shows JavaScript disabled in Google Chrome™.
Usage Notes for Active Technologies

The following apply to browser support.

- ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Therefore, any Active Technologies feature that requires the use of ActiveX controls is not available in Microsoft Edge. These features include the following, which are accessible in other browsers at run time, using the column drop-down menu on an active report:
  - Send as E-mail (supported only in Internet Explorer)
  - Save Changes (supported only in Internet Explorer)
  - Export to XML (Excel) when active cache is disabled

- If you are using a Firefox browser and you export an AHTML report to Excel, the file extension that displays is incorrect (for example, .xls.xls). You can override this default value using the browser settings. Specifically, if you click the Always ask me where to save files radio button, located under Options, you will be prompted, upon download, to either open or save the file. You can then provide a name and extension for the file.

The following apply to Active Technologies reports.

- If multiple report components with different security passwords are included in an AHTML document, the password for the last report component is used.

- Active reports employ left and right cell padding, by default. This enables you to view the active report consistently, without the concatenation of any values or spacing issues related to the cell padding. In cases where these settings are not defined in the StyleSheet, the default settings for the left and right cell padding are used.

- By default, Active Technologies displays the name specified in the Master File to identify a column in an ACROSS group on a tabular active report that has only one display field. With the following WebFOCUS SET command, you can display the title specified in the Master File, instead of the name, to identify the column:
  
  ```
  SET ACRSVRBTITL = ON
  ```

  Active Technologies derives the title from the TITLE attribute in the Master File (for example, TITLE = 'Product ID'). It derives the name from the FIELDNAME or FIELD attribute (for example, FIELD = PCD).

  InfoAssist does not allow you to create or modify your active report procedures with a text editor. In Business User Edition, you must issue the SET ACRSVRBTITL = ON command in a server profile (for example, edasprof.prf). When issued in edasprof.prf, the setting is applied globally. It affects all users and all procedures run in Business User Edition.
For more information on customizing the server profile in WebFOCUS Business User Edition, see *Managing the Server or Global Profile*.

- The Sort Ascending, Sort Descending, and Restore Original options are accessible on a column drop-down menu on an active report. When active cache is enabled on the active report, the Restore Original option does not return the report output to its original state after sorting the data. Instead, you receive the following message: Warning: Original sort could not be determined.

The following applies to filtering Active Technologies content.

- When using active content in Cache Mode, filtering may not work properly if the content contains a text field (for example, TX50). As a workaround, consider using an alphanumeric field (for example, A50).

The following apply to Active Technologies charts:

- When working with filters in an AHTML chart, certain filtering options do not display if you have only one column on which to filter and it has a decimal format which includes a decimal point. In this case, the Filter Chart and Exclude from Chart filtering options are not available in the chart tooltip at run time.

- As of Release 8.2 Version 02, the chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional relevant field containers for these chart types, which can be used to specify fields in a specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field containers that are part of the chart attribute syntax.

  In InfoAssist, specific field containers appear for each chart type.

- When you run an active chart, the output displays a chart toolbar with a number of options that you can select. These options are represented by icons. The active chart toolbar provides an Aggregation icon that allows you to select the aggregation method (that is, the type of calculation, such as Sum or Avg) that will be used on the selected data in the chart.

  If you run an active chart that does not have a measure field to which an aggregation method can be applied, the Aggregation icon:

  - Appears on the chart toolbar, but cannot be selected.

  - Displays None as the aggregation method. None is dimmed on the label. It indicates that there will be no aggregation performed on, or applied to, the selected data in the chart.
Once you run the active chart with data that applies to an aggregation method, the Aggregation icon is activated. Its label reflects the aggregation method currently in use (for example, Sum).

The following applies to Active Technologies tools.

- The comma inclusion edit option is not implemented in Rollup tables and Pivot tables when active cache is enabled.

The following apply when using the Export to Excel functionality.

- When using the Export to Excel option while creating and generating an active report with active cache enabled, the request will be generated in XLSX format, rather than EXL2K. This applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

  The export behavior is controlled by the WebFOCUS Reporting Server, and an ActiveX plugin is not required for Internet Explorer. When the export is performed, an Office Open XML document is produced, which you can download and save in the required format (default is .xlsx).

- When using the Export to XML (Excel) option with active cache disabled, the export behavior is controlled by the active JavaScript layer.

  An ActiveX plugin is required for Internet Explorer. This is used to export the output directly into Microsoft Excel, enabling you to save the document in the required format (.xlsx or .xls depending on the Microsoft Excel version installed).

  In Firefox and Chrome, when the export is performed, an MS Office XML document is produced, which you can download and save in the required format (the default is .xls).

  In Microsoft Edge, the Export to XML (Excel) option is not supported. The option is available with active cache disabled, but when the export is performed, the output is displayed as text inside the browser window.

The following apply when using mobile devices.

- The Chrome browser Force enable zoom Accessibility setting on Android mobile devices overrides a website request to prevent zooming. If this setting is enabled when executing an AHTML report on an Android mobile device using Chrome, it interferes with active report functionality, such as FREEZE and manual resizing. The Accessibility setting needs to be disabled for active reports to be fully functional.
Creating an Active Technologies Report

An active report is a self-contained report that is designed for offline analysis.

**Procedure:** How to Create an Active Technologies Report

With InfoAssist in Report mode, you can perform this procedure in Query Design view or Live Preview.

1. On the Home tab, from the Format group, click Output File format and click *active report*.
2. Populate the report with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto canvas.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

**Active Technologies Report Menu Options**

Menu options for an active report are described in the following table.

**Note:** The following options described in the table require the use of ActiveX controls. Since Microsoft Edge does not support ActiveX technology, these options are not available in that browser:

- Send as E-mail
- Save Changes
- Export to XML (Excel) when active cache is disabled

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Ascending</td>
<td>Sorts the column in ascending order.</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sorts the column in descending order.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters the data. Options are:</td>
</tr>
<tr>
<td></td>
<td>• Equals</td>
</tr>
<tr>
<td></td>
<td>• Not equal</td>
</tr>
<tr>
<td></td>
<td>• Greater than</td>
</tr>
<tr>
<td></td>
<td>• Greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>• Less than</td>
</tr>
<tr>
<td></td>
<td>• Less than or equal to</td>
</tr>
<tr>
<td></td>
<td>• Between</td>
</tr>
<tr>
<td></td>
<td>• Not Between</td>
</tr>
<tr>
<td></td>
<td>• Contains</td>
</tr>
<tr>
<td></td>
<td>• Contains (match case)</td>
</tr>
<tr>
<td></td>
<td>• Omits</td>
</tr>
<tr>
<td></td>
<td>• Omits (match case)</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate</td>
<td>Calculation types that you can apply to the column:</td>
</tr>
<tr>
<td></td>
<td>- Clear</td>
</tr>
<tr>
<td></td>
<td>- Clear All</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field.</td>
</tr>
<tr>
<td></td>
<td>For numeric fields, you can also apply:</td>
</tr>
<tr>
<td></td>
<td>- Sum</td>
</tr>
<tr>
<td></td>
<td>- Avg</td>
</tr>
<tr>
<td></td>
<td>- Min</td>
</tr>
<tr>
<td></td>
<td>- Max</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct</td>
</tr>
<tr>
<td></td>
<td>- % of Total</td>
</tr>
<tr>
<td>Chart</td>
<td>Creates an active chart from the report. Options are Pie, Line, Column, and Scatter.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Lists the fields available to create a table.</td>
</tr>
<tr>
<td>Pivot (Cross Tab)</td>
<td>Lists the fields available to create a Pivot table.</td>
</tr>
<tr>
<td>Visualize</td>
<td>Adds visualization bars to, or removes them from, the selected column. The Visualize option is available for numeric data columns.</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Suppresses the display of the selected column in the report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Columns</td>
<td>Lists the names of the columns that are hidden in the report, allowing you to individually restore a column. Select the name of a specific column in the hidden columns list to restore that column to the report.</td>
</tr>
</tbody>
</table>
| Freeze Column      | Freezes the report at a particular point so that columns to the left of the freeze point remain in view while the user scrolls through the other report columns.  
**Note:** If the report can be fully viewed in the browser window, freeze is not applied. The Freeze column option is not available for expandable report (Accordion) views. |
<p>| Unfreeze All       | Unfreezes the columns.                                                                                                                                                                                    |
| Grid Tool          | Opens the Grid Tool, which you can use to change the column order, select multiple columns to sort ascending or descending, hide and show columns, add a calculation result to a column, and add subtotals to the active report. |
| Chart/Rollup Tool  | Opens the Chart/Rollup Tool, which you can use to select multiple group fields to generate the chart or rollup table. The Chart/Rollup Tool contains a list of columns available in the active report to add to Group By and Measure fields. Drag the columns into the field that you want. |
| Pivot Tool         | Opens the Pivot Tool, which you can use to select multiple group fields to generate the chart or pivot table. The Pivot Tool contains a list of columns available in the active report to add to Group By, Across, and Measure fields. Drag the columns into the field that you want. |
| Show Records       | Opens the Show Records menu option to list the number of records available for display per page in the report. Select a number (for example, 10) to display, per page. Default displays the number of records (lines) per page that is specified in the WebFOCUS report procedure. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>Options to display comments under cells or hide indicators for comments in the active report output.</td>
</tr>
<tr>
<td>Send as E-mail</td>
<td>Enables you to save the current state of the active report and send the report as email.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings.</td>
</tr>
<tr>
<td></td>
<td>This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Save Changes</td>
<td>Saves the current state of the active report.</td>
</tr>
<tr>
<td></td>
<td>When you save an active report using the browser Save as option, the report is saved in its original default state. In the browser Save</td>
</tr>
<tr>
<td></td>
<td>as dialog box, it is recommended that you select the Webpage, HTML Only save option to ensure that the page is saved properly.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings.</td>
</tr>
<tr>
<td></td>
<td>This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Export</td>
<td>When active cache is enabled, exports all records or filtered only records to HTML, CSV, Excel, or PDF.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> active cache is enabled on an active report when you click Pages On Demand on the Format tab, in the Navigation group.</td>
</tr>
<tr>
<td></td>
<td>When active cache is disabled, exports all records or filtered only records to HTML, CSV, or XML (Excel). To use this feature, you</td>
</tr>
<tr>
<td></td>
<td>must enable ActiveX in your browser security settings.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints all records or filtered only records.</td>
</tr>
<tr>
<td>Window</td>
<td>Displays reports in a cascade or separate tabs.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
</tbody>
</table>

**Active Technologies Cell Menu Options**

When you are working in active report format, the following data cell options display.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down</td>
<td>Enables you to drill down one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Drill up</td>
<td>Enables you to drill up one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Auto Links</td>
<td>Displays a list of target reports that are linked to the Auto Link enabled report. This option displays for reports that have Auto Linking enabled.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enables you to add comments about data in your report. The result is an annotation that displays when you hover over it at run time.</td>
</tr>
<tr>
<td>Highlight Value</td>
<td>Enables you to highlight a particular value in your report.</td>
</tr>
<tr>
<td>Highlight Row</td>
<td>Applies highlighting to the selected row in your report.</td>
</tr>
<tr>
<td>Unhighlight All</td>
<td>Removes any applied highlighting from values or rows in your report.</td>
</tr>
<tr>
<td>Filter Cell</td>
<td>Enables you to filter the output, showing only a selected row of data.</td>
</tr>
<tr>
<td>Remove Cell Filter</td>
<td>Removes any applied cell filters.</td>
</tr>
</tbody>
</table>

**Configuring Active Technologies Report Options**

You can configure active report options, including menu options, based on user role, through the active report options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the *active report options* button. The button is available when active report is selected as the output type.
The active report options dialog box contains the following tabs:

- **General**
- **Menu Options**
- **Colors**
- **Advanced**

**General Tab**

Use the General tab to set common properties specific to active reports.

The General tab contains the following options:

- **Display.** This area contains options to set the window to cascade or tabs, and options to freeze columns.
  - **Window.** Select the window setting. The options are Cascade and Tabs.
  - **Freeze Columns.** Select the columns you would like to freeze. You can also select None.

- **Page Options.** This area contains options to set the number of records per page, enable the display of page information, edit the alignment, and set the location of the page information.
  - **Records Per Page.** Select or type the number of records that you would like to display per page. The default value is 57.
  - **Display Page Information.** Select this option to display page navigation information. Clear this option to disable the display of page navigation information.
  - **Alignment.** Click the appropriate button to set the alignment of the page navigation information. Options are Left, Center, and Right.
  - **Location.** Select the location for the page navigation information. The options are Top Row and Bottom Row.

**Menu Options Tab**

Use the Menu Options tab to select a user type and which options to display in the menu.
The Menu Options tab contains the following options:

- **User Type.** The options are Power, Analyst, Basic, and Custom.
  - **Power.** This is the default user type. It enables all functionality.
  - **Analyst.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original, Save Changes, and Accordion.
  - **Basic.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.
  - **Custom.** If you select a combination of options that does not match one of the existing user types (Power, Analyst, Basic), the User level name that appears in the User Type field is Custom. This is not a default user type or a selectable user type. It indicates that options for this user do not match any of the existing user types.

The options available according to user type include the following:

- **Show Records.** Shows all records or specific numbers of records.
- **Freeze.** Freezes and unfreezes columns.
- **Hide/Unhide.** Hides and shows columns.
- **Export.** Exports data to HTML, CSV, Excel, or PDF if active cache is enabled, or to HTML, CSV, or XML (Excel) if active cache is disabled.
- **Sorting.** Sorts data in ascending or descending order.
- **Pivot.** Lists the fields available to create a Pivot table.
- **Window Type.** Shows windows as cascade or tabs.
- **Send as Email.** Enables you to save the current changes and send a report as email.
- **Print.** Prints all records or filtered-only records.
- **Advanced Tools.** Accesses the Chart/Rollup, Pivot, and Grid Tools.
- **Filter.** Opens the Filter Selection dialog box.
- **Calculations.** Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct, % of Total.
- **Chart.** Converts a report to a pie, line, bar, or scatter chart.
Visualize. Adds data visualization bars to a report.

Rollup. Performs rollup on data.

Comments. Adds comments.

Restore Original. Restores the active report to the default state specified in the report procedure.

Save Changes. Saves the current changes.

Accordion. Produces accordion reports.

Grid Tool. Opens the Grid Tool dialog box.

Colors Tab
Use the Colors tab to select colors for various objects on the report.

The Colors tab contains the following options:

Page. This area contains options to set the colors for the font and background of the page text.

Font. Opens the Color dialog box, where you can select the font color.

Background. Opens the Color dialog box, where you can select the background color for the page text.

Row Selection. This area contains options to set the colors that appear when you point to or select a row on the report.

Hover. Opens the Color dialog box, where you can select the color that the row becomes when you hold the mouse over the row.

Selected. Opens the Color dialog box, where you can select the highlight color that the row becomes when you use the highlight option.

Visual. This area contains options to set the colors for the data visualization bars.

Positive. Opens the Color dialog box, where you can select the color for a data visualization bar that represents a positive number.

Negative. Opens the Color dialog box, where you can select the color for a data visualization bar that represents a negative number.
Calculations. This area contains options to set the colors for values in a calculation.

- **Font.** Opens the Color dialog box, where you can select the font color for the calculation.

- **Background.** Opens the Color dialog box, where you can select the background color for the calculation.

Menu. This area contains options to change the color of the menu.

- **Normal**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus.
  - **Background.** Opens the Color dialog box, where you can select the background color for the column menus.
  - **Border.** Opens the Color dialog box, where you can select the color for the border of the column menus.

- **Hover**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus when you point to them.
  - **Background.** Opens the Color dialog box, where you can select the background color that appears behind options on the column menus when you point to them.

Advanced Tab

Use the Advanced tab to control the number of rows retrieved from active cache and to add security settings.

**Note:** Active cache is enabled when you select *active report* as the output type, and click *Pages On Demand* on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

- **active cache.** Enables a report to cache the data in a binary file and return the data to the output window in pre-set increments.

- **Rows Retrieved.** Select the number of rows retrieved in the output. The default value is 100.

- **Security.** This area allows you to set a password to access the report and enable expiration by date or by days.
Note: When setting security options for active reports, be aware that security options can be set for each individual component on the canvas, but only one password can be set for the entire document.

Freezing Column Headings in Active Reports

When working with In-Document Analytics (Active Technologies) reports, you can freeze column headings. The Freeze option in the GUI tools allows you to define a scroll area within the data of your report and lock the column heading titles in place, enabling you to scroll through the data within the container. Report headings, footings, and grand totals are also locked, so that these also stay in view while you scroll the data in your report. This is particularly useful when you are creating a large report, for which there may be multiple pages.

When you enable the column title freeze feature and run your report, a thin scroll bar displays to the right side of the report, as shown in the following image.

<table>
<thead>
<tr>
<th>State Province</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>Gross Profit</th>
<th>Revenue</th>
<th>MSRP</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aarai</td>
<td>$507,745.50</td>
<td>$420,429.73</td>
<td>$255,532.24</td>
<td>$673,177.24</td>
<td>$403,615.93</td>
<td>$868,456.14</td>
</tr>
<tr>
<td>Ambaz</td>
<td>$3,150.00</td>
<td>$200.20</td>
<td>$1,490.23</td>
<td>$2,924.23</td>
<td>4,043.43</td>
<td>13,283.01</td>
</tr>
<tr>
<td>Aminco</td>
<td>$46,907.00</td>
<td>$2,746.64</td>
<td>$16,210.26</td>
<td>$50,117.26</td>
<td>7,503.91</td>
<td>220,945.11</td>
</tr>
<tr>
<td>Acre</td>
<td>$50,487.00</td>
<td>$3,223.50</td>
<td>$23,479.81</td>
<td>$53,652.81</td>
<td>9,391.05</td>
<td>255,545.96</td>
</tr>
<tr>
<td>Adela</td>
<td>$102,228.00</td>
<td>$6,014.96</td>
<td>$37,905.50</td>
<td>$139,790.50</td>
<td>146,906.45</td>
<td>423,090.41</td>
</tr>
<tr>
<td>Adagia</td>
<td>$2,024.00</td>
<td>$899.50</td>
<td>$714.79</td>
<td>$3,038.79</td>
<td>3,328.37</td>
<td>9,095.53</td>
</tr>
<tr>
<td>Adyamna</td>
<td>$10,413.00</td>
<td>$1,989.96</td>
<td>$6,806.42</td>
<td>$12,216.42</td>
<td>23,200.20</td>
<td>88,436.16</td>
</tr>
<tr>
<td>Aglyke-kanariana</td>
<td>$9,506.00</td>
<td>$444.19</td>
<td>$3,746.34</td>
<td>$13,252.34</td>
<td>13,668.33</td>
<td>46,645.40</td>
</tr>
<tr>
<td>Aguascalientes</td>
<td>$26,921.00</td>
<td>$2,091.27</td>
<td>$24,205.99</td>
<td>$123,170.99</td>
<td>128,218.30</td>
<td>379,715.70</td>
</tr>
<tr>
<td>Acre</td>
<td>$6,053.00</td>
<td>$422.59</td>
<td>$2,775.95</td>
<td>$9,350.95</td>
<td>9,791.54</td>
<td>28,920.95</td>
</tr>
<tr>
<td>Aisen del General Carlos Ibáñez del Campo</td>
<td>$162,647.00</td>
<td>$13,290.73</td>
<td>$59,823.51</td>
<td>$222,470.51</td>
<td>235,763.20</td>
<td>691,816.95</td>
</tr>
<tr>
<td>Aisen del Gran Chaco</td>
<td>$14,033.00</td>
<td>$967.59</td>
<td>$6,164.63</td>
<td>$20,197.63</td>
<td>21,054.62</td>
<td>62,326.27</td>
</tr>
<tr>
<td>Aiken</td>
<td>$32,094.00</td>
<td>$2,596.07</td>
<td>$11,605.78</td>
<td>$44,506.78</td>
<td>47,077.04</td>
<td>138,545.47</td>
</tr>
<tr>
<td>Aiken county</td>
<td>$10,501.00</td>
<td>$919.49</td>
<td>$4,054.95</td>
<td>$14,559.95</td>
<td>14,947.44</td>
<td>44,459.83</td>
</tr>
<tr>
<td>Alti</td>
<td>$14,461.00</td>
<td>$2,959.99</td>
<td>$4,961.59</td>
<td>$9,422.54</td>
<td>19,108.54</td>
<td>58,859.63</td>
</tr>
<tr>
<td>Al Balu al Aminar</td>
<td>$14,354.00</td>
<td>$1,021.62</td>
<td>$3,785.31</td>
<td>$16,089.31</td>
<td>19,060.93</td>
<td>56,945.17</td>
</tr>
<tr>
<td>Al Buphan</td>
<td>$3,900.00</td>
<td>$195.50</td>
<td>$1,568.30</td>
<td>$5,490.30</td>
<td>5,963.30</td>
<td>16,824.90</td>
</tr>
<tr>
<td>Al Uslanadzah</td>
<td>$8,371.00</td>
<td>$433.40</td>
<td>$2,973.82</td>
<td>$11,344.82</td>
<td>11,777.98</td>
<td>34,906.54</td>
</tr>
<tr>
<td>Al Ilnamah</td>
<td>$4,426.00</td>
<td>$238.66</td>
<td>$1,805.86</td>
<td>$5,632.56</td>
<td>5,993.02</td>
<td>11,666.58</td>
</tr>
<tr>
<td>Al Jizan</td>
<td>$7,561.00</td>
<td>$347.00</td>
<td>$2,766.75</td>
<td>$10,272.75</td>
<td>10,974.75</td>
<td>31,577.25</td>
</tr>
<tr>
<td>Al Wadi al Jizel</td>
<td>$4,650.00</td>
<td>$194.00</td>
<td>$1,876.84</td>
<td>$5,734.84</td>
<td>5,909.74</td>
<td>17,534.32</td>
</tr>
<tr>
<td>Almatina</td>
<td>$1,565,341.00</td>
<td>$103,996.16</td>
<td>$629,798.77</td>
<td>$2,307,940.77</td>
<td>2,310,448.79</td>
<td>6,286,236.91</td>
</tr>
<tr>
<td>Alagao</td>
<td>$256,256.00</td>
<td>$18,394.84</td>
<td>$100,781.61</td>
<td>$360,039.01</td>
<td>376,403.81</td>
<td>1,112,846.27</td>
</tr>
<tr>
<td>Alaksa</td>
<td>$5,987,967.00</td>
<td>$337,102.82</td>
<td>$2,011,411.46</td>
<td>$7,099,370.46</td>
<td>7,436,880.40</td>
<td>21,872,348.14</td>
</tr>
<tr>
<td>Alberta</td>
<td>$5,980,749.00</td>
<td>$405,231.37</td>
<td>$2,001,176.80</td>
<td>$8,384,125.80</td>
<td>8,747,560.88</td>
<td>29,836,236.84</td>
</tr>
<tr>
<td>Alabama</td>
<td>$42,593.00</td>
<td>$2,271.65</td>
<td>$18,212.61</td>
<td>$60,065.61</td>
<td>63,076.97</td>
<td>186,056.34</td>
</tr>
</tbody>
</table>
When you mouse over the thin scroll bar, it turns into a full scroll bar, making it easier to scroll through your report data. This scroll bar is shown in the following image.

If your report has more columns than can fit in the output container, you can employ the horizontal scroll bar at the bottom of your report.

**Note:** Scroll bars do not display if there is no scrollable data. Thus, if the data displayed fits the size of the container, scroll bars do not display.

You can enable the column heading freeze feature for In-Document Analytics reports in the GUI tools using the Freeze button on the Format tab of the ribbon, in the Navigation group. Enabling the Freeze option will add HFREEZE=ON in the stylesheet section of the report procedure, as shown in the following example.
Once you have enabled the column heading freeze feature, you must run your report to view the report with scroll bars.

**Procedure:** How to Freeze Column Titles in Reports

You can freeze column headings in your In-Document Analytics (Active Technologies) reports.

1. Open InfoAssist.
2. Build your report.
3. Set the output format to Active Report (AHTML).
5. Run the report to view the frozen column titles.
6. A scroll bar displays, enabling you to scroll through your data, vertically, as shown in the following image.

<table>
<thead>
<tr>
<th>Customer</th>
<th>Sales Province</th>
<th>Cost of Goods</th>
<th>Discount</th>
<th>Gross Profit</th>
<th>Revenue</th>
<th>MSRP</th>
<th>TOTAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aarjai</td>
<td></td>
<td>$6,507.745</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>$2,459.73</td>
<td></td>
<td>$2,555.32</td>
<td>$9,073.177</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>$3,547.23</td>
<td>$1,547.23</td>
<td>$4,994.43</td>
<td>$9,493.635</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abracon</td>
<td></td>
<td>$46,907.00</td>
<td>$2,746.54</td>
<td>$18,216.05</td>
<td>$60,117.38</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Accera</td>
<td></td>
<td>$59,687.00</td>
<td>$3,228.36</td>
<td>$23,475.68</td>
<td>$83,162.81</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Acme</td>
<td></td>
<td>$112,328.00</td>
<td>$6,514.56</td>
<td>$37,905.59</td>
<td>$156,750.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adina</td>
<td></td>
<td>$2,324.07</td>
<td>$389.58</td>
<td>$714.79</td>
<td>$10,000.79</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Adityman</td>
<td></td>
<td>$15,214.00</td>
<td>$1,195.26</td>
<td>$6,006.42</td>
<td>$21,219.52</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aljostar</td>
<td></td>
<td>$15,214.00</td>
<td>$1,195.26</td>
<td>$6,006.42</td>
<td>$21,219.52</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Aguarantine</td>
<td></td>
<td>$59,821.00</td>
<td>$2,991.37</td>
<td>$24,205.99</td>
<td>$123,170.59</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Achi</td>
<td></td>
<td>$6,583.00</td>
<td>$2,775.59</td>
<td>$6,406.95</td>
<td>$19,781.54</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Allian de Geraldo Carlos (Bene)</td>
<td></td>
<td>$152,647.00</td>
<td>$13,292.73</td>
<td>$59,823.51</td>
<td>$222,745.01</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Azcan del Graf. c (Ibenez del Campo)</td>
<td>$14,633.00</td>
<td>$882.59</td>
<td>$8,154.63</td>
<td>$20,197.03</td>
<td>$21,986.62</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ackerhaus</td>
<td>$32,904.00</td>
<td>$2,560.78</td>
<td>$11,605.78</td>
<td>$44,560.78</td>
<td>$47,017.84</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ackerous county</td>
<td>$10,501.00</td>
<td>$391.49</td>
<td>$4,954.95</td>
<td>$14,555.50</td>
<td>$14,947.44</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Akele</td>
<td>$14,451.00</td>
<td>$255.99</td>
<td>$4,961.55</td>
<td>$19,442.55</td>
<td>$19,798.54</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al Bahar al Ahmar</td>
<td>$14,254.00</td>
<td>$2,021.62</td>
<td>$3,750.31</td>
<td>$16,030.31</td>
<td>$19,060.93</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al Bahshar</td>
<td>$3,890.00</td>
<td>$1,655.00</td>
<td>$1,986.50</td>
<td>$5,495.50</td>
<td>$5,563.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al Iskandarouh</td>
<td>$8,371.00</td>
<td>$333.00</td>
<td>$2,973.58</td>
<td>$11,344.58</td>
<td>$11,777.98</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al Ismailiyah</td>
<td>$4,624.00</td>
<td>$230.50</td>
<td>$1,806.95</td>
<td>$5,632.95</td>
<td>$6,063.00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al Jizah</td>
<td>$7,461.00</td>
<td>$347.00</td>
<td>$2,765.75</td>
<td>$10,237.75</td>
<td>$10,574.75</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Al Yaqui al Jadil</td>
<td>$4,650.00</td>
<td>$194.00</td>
<td>$1,676.84</td>
<td>$5,734.84</td>
<td>$5,995.74</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alabama</td>
<td>$1,506,341.00</td>
<td>$103,496.19</td>
<td>$620,799.77</td>
<td>$2,207,140.77</td>
<td>$2,310,548.78</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Abagais</td>
<td>$259,256.00</td>
<td>$16,364.64</td>
<td>$100,761.51</td>
<td>$360,030.01</td>
<td>$376,403.61</td>
<td>$1,112,846.27</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alberen</td>
<td>$5,807,697.00</td>
<td>$337,192.82</td>
<td>$2,011,411.46</td>
<td>$7,090,378.46</td>
<td>$5,436,495.40</td>
<td>$5,839,234.14</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alberta</td>
<td>$5,960,749.00</td>
<td>$405,231.37</td>
<td>$2,361,176.68</td>
<td>$5,341,925.08</td>
<td>8,747,156.15</td>
<td>$29,628,238.84</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alsacis</td>
<td>$42,593.00</td>
<td>$2,271.65</td>
<td>$18,212.61</td>
<td>$60,005.61</td>
<td>$63,076.67</td>
<td>$186,058.34</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andorra</td>
<td>$560,420.00</td>
<td>$4,005.42</td>
<td>$3,234.78</td>
<td>$573,679.20</td>
<td>$577,884.65</td>
<td>$591,987.09</td>
<td></td>
</tr>
</tbody>
</table>

### Note: If you have numerous columns in your report, you can employ the horizontal scroll bar at the bottom of the report.

### Creating an Active Technologies Chart

An active chart is a chart that is designed for offline analysis. For more information, see Active Technologies Report Overview on page 158.

### Procedure: How to Create an Active Technologies Chart

With InfoAssist in Chart mode, you can perform this procedure in Query Design view or Live Preview.

1. On the Home tab, from the Format group, click Output File format and click active report.
2. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.

   The chart appears on the canvas.

3. Populate the chart with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.
Active Technologies Options for Charts

Menu options for an active chart are described in the following table.

**Note:** For charts that employ the new attribute syntax, only the following four icons display: More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the Remove Filter icon displays.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Options</td>
<td><strong>New.</strong> Creates a new instance of the chart. This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><strong>Group By (X).</strong> Changes groups by the horizontal sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Add (Y).</strong> Adds a vertical sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>X-Axis.</strong> Specifies a measure or dimension sort field. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Y-Axis.</strong> Specifies a measure. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Arrange By.</strong> Specifies the marker color. The marker color depends on the field assigned to the color attribute. If no field is assigned to this category, then all of the markers will be the same color. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Export to.</strong> Exports to Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td></td>
<td><strong>Stacked.</strong> Stacks the risers on top of each other, with the length of each riser representing the data value. Applies to column charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Top.</strong> Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top. Applies to pie charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend.</strong> Draws a trendline and equation label for an individual series. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart/Rollup Tool.</strong> Opens the Chart/Rollup Tool, which you can use to select multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool contains a list of columns available in the active report and Group By and Measure sort fields. Drag the columns into the desired sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working with the Chart/Rollup Tool for active charts (specifically those with the new chart attribute syntax), the Series tab is not supported. It is available with charts that are created with tabular reports or stand-alone charts that do not use the new chart attribute syntax.</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original.</strong> Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Column</td>
<td>Displays data as a column chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Displays data as a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Displays data as a line chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Displays data as a scatter chart.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td>Advanced Chart</td>
<td>Opens the Chart/Rollup Tool.</td>
</tr>
<tr>
<td>Original Chart</td>
<td>Restores the active chart to the chart type specified in the report procedure.</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup). This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and Distinct. The default value is Sum.</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area of the chart and then clicking the Filter Chart or Exclude from Chart option from the chart tooltip.</td>
</tr>
</tbody>
</table>

Creating an Active Technologies Dashboard

You can create an active dashboard by inserting multiple content types, such as reports, charts, images, and text, into a document. An active dashboard will run any report or chart using the active output format, even if the report or chart itself is not in active output format.

You can also insert active dashboard prompts into a document to act as filters for the reports and charts on the dashboard. You can cascade (chain) prompts to populate them based on the selections from the previous prompts.

The output format of the active dashboard must be active report in order to add active dashboard prompts.

Active Technologies Dashboard Prompts

The Active Dashboard Prompts group contains buttons that insert active dashboard prompts into your dashboard. This group is only visible when the output format of the dashboard is set to active report. You can access the active dashboard prompts on the Insert tab, in the active dashboard prompts group.

The following are the types of active dashboard prompts that you can use to apply filters to an active dashboard:

- **Drop Down.** Inserts a drop down prompt placeholder in the upper-left corner of the canvas.
- **List.** Inserts a list prompt placeholder in the upper-left corner of the canvas.
- **Checkbox.** Inserts a check box prompt placeholder in the upper-left corner of the canvas.
- **Radio Button.** Inserts a radio button prompt placeholder in the upper-left corner of the canvas.
- **Text.** Inserts a text area prompt placeholder in the upper-left corner of the canvas.
**Note:** The display of values populated in active dashboard prompts is dependent on the data setting. For example, if sample data is turned on, then active dashboard prompts will show sample data, such as:

WF_RETAIL1
WF_RETAIL2
WF_RETAIL3

**Target Reports**

When you bind a field to an active dashboard prompt, the default target report is the report from which you dragged the field. You can add or remove target reports from an active dashboard prompt through the active dashboard properties dialog box. For more information on using the active dashboard properties dialog box, see *Using Multiple Reports as Targets and Sources* on page 186.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name or AS name).
- The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title and the title is changed, the report is automatically removed as a target.

**Procedure:**  **How to Add an Active Technologies Dashboard Prompt to a Dashboard**

This procedure describes how to begin to create a dashboard by creating one report and binding a single prompt to one of the fields of the report.

With InfoAssist in Document mode:

1. On the Home tab, from the Format group, click Output File format and click *active report*.
2. On the Insert tab, in the Reports group, click *Report*.

A placeholder appears on the canvas.

3. Drag fields onto the canvas, or into the Query pane, to create the report and start building the dashboard.

4. On the Insert tab, in the *active dashboard prompts* group, select a dashboard prompt to insert into the document.

An active dashboard prompt appears in the upper-left corner of the canvas. If the report is located in the upper-left corner of the canvas, you will have to drag the prompt off of the report.
5. Select the report and bind one of its data source fields to the prompt in one of the following ways:

- **Query pane**: Select the report. From the Query pane, drag the field that you want to bind onto the prompt.

- **Report on the canvas**: Click the report on the canvas. You can now edit it. Highlight the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

**Note**: Once an active dashboard prompt is added to the canvas, the document is locked in an active output format. You cannot change the active report format if there are prompts present on the canvas. To switch to a non-active output format, you must remove all prompts.

**Using Multiple Reports as Targets and Sources**

You can add multiple reports and charts to an active dashboard. Each report can have multiple prompts associated with it.

**Procedure**:  **How to Build a Dashboard With Multiple Reports as Targets and Sources**

The following procedure describes how to set up active dashboard prompts for two reports on a dashboard. In the example that is used, the first report contains information about the categories of electronics products sold in various regions. The Product,Category field will be bound to a group of radio buttons. Each radio button will represent a particular product category of electronics. When you select a radio button for a product category, for example, Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of electronics consumers. The Gender field will be bound to a drop-down list. The list will display the values, F (female) and M (male). When you select a gender from the drop-down list, the report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.
2. Create an active dashboard by adding two reports with the following components, respectively:

   **Report 1:**
   - Product,Category
   - Store,Business,Region
   - Discount
Gross Profit

**Report 2:**

- Gender
- Customer, Continent
- Product, Category

3. On the Insert tab, in the Active Dashboard Prompts group, add the following active dashboard prompts to the dashboard, positioning them relative to each respective report.

- **Radio Button:** This prompt will be used for Report1.
- **Drop Down:** This prompt will be used for Report2.

For more information on working with active dashboard prompts, see *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 185.

4. Right-click the radio button active dashboard prompt for which you want to bind a field to and click **Properties**.

The active dashboard properties dialog box opens.

The Prompts list displays the two prompts (for example, radiobutton_1 and radiobutton_2) that were added to the dashboard in step 3.

5. From the Report drop-down menu, select the report that contains the field to which you want to bind an active dashboard prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for the region report (Report1), as shown in the following image.
The next step describes how to bind the Product, Category field from the region report to the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the active dashboard prompt.

In this example, the Product, Category field has been selected for the radio buttons list (radiobutton_1), as shown in the following image.

![Diagram showing Active Dashboard Properties window with Report and Field options]

**Note:** You can optionally specify an ascending or descending sort order for the current scenario.

7. Click OK.

The prompt is now bound to the field on the dashboard.
In the following image, the radio buttons list is bound to the Product, Category field. It displays all product categories by which a user can filter the report.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Store Business Region</th>
<th>Discount</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>EMEA</td>
<td>$2,437,956.41</td>
<td>$15,898,776.98</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$3,416,809.19</td>
<td>$22,879,859.37</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$153,257.58</td>
<td>$1,027,460.88</td>
</tr>
<tr>
<td>Camcorder</td>
<td>EMEA</td>
<td>$2,840,963.46</td>
<td>$19,928,603.81</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$4,075,160.76</td>
<td>$28,304,171.49</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$185,793.84</td>
<td>$1,309,721.34</td>
</tr>
<tr>
<td>Computers</td>
<td>EMEA</td>
<td>$1,700,675.30</td>
<td>$12,147,362.23</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$2,999,148.76</td>
<td>$20,556,914.70</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$100,862.80</td>
<td>$753,505.60</td>
</tr>
<tr>
<td>Media Player</td>
<td>EMEA</td>
<td>$4,678,461.09</td>
<td>$22,897,933.25</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$6,522,133.78</td>
<td>$31,364,927.54</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$304,865.09</td>
<td>$1,499,928.75</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>EMEA</td>
<td>$5,428,981.57</td>
<td>$34,639,882.85</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$7,744,502.52</td>
<td>$49,228,757.29</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$341,022.82</td>
<td>$2,214,130.64</td>
</tr>
<tr>
<td>Televisions</td>
<td>EMEA</td>
<td>$1,518,099.74</td>
<td>$6,990,404.98</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$2,013,911.63</td>
<td>$9,358,461.12</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$102,362.82</td>
<td>$462,120.21</td>
</tr>
<tr>
<td>Video Production</td>
<td>EMEA</td>
<td>$1,066,117.73</td>
<td>$7,195,930.82</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$1,552,040.11</td>
<td>$10,272,127.15</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$73,964.80</td>
<td>$460,856.91</td>
</tr>
</tbody>
</table>

The following steps describe how to bind the Gender field in the gender report (Report2) to the drop-down list prompt.

8. Right-click the Drop Down active dashboard prompt for which you want to bind a field and click **Properties**.

The active dashboard properties dialog box opens again.
Notice that combobox_2, the prompt selected on the dashboard, is selected in the Prompts list.

9. From the Report drop-down menu, select the report (Report2) that contains the field to which you want to bind an active dashboard prompt.

The next step describes how to bind the Gender field from the gender report to the drop-down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the active dashboard prompt.

Once the Gender field has been selected, Report2 (gender report) appears in the Targets list and Report1 (region report) appears in the Candidate Reports list.

**Note:** To move a report from the Candidate Reports list box to the Targets list box, select it and click the *Add to List* arrow. To remove a report from the Targets list box, select it and click the *Remove from List* arrow. You can select multiple reports by holding down the Ctrl key and clicking each one.

11. Click OK.
The prompt is now bound to the field on the dashboard. You can now filter the gender report by female or male, as shown in the following image.
**Procedure: How to Change the Field**

You can change the field to which the active prompt is bound.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active prompt to a field.
2. Right-click the active dashboard prompt that you want to configure, and click Properties. The active dashboard properties dialog box opens.
3. From the Field menu, select a different field.
   A warning message alerts you that changing the source field for the prompt will remove the existing prompt and any dependent (child) prompts from the cascades.
4. Click OK to close the warning.
5. Click OK to close the active dashboard properties dialog box.
The active dashboard prompt is updated with the new source field.

**Procedure: How to Change the Filter Condition**

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active dashboard prompt to a field, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 185.

2. Right-click the active dashboard prompt that you want to work with, and from the shortcut menu, select *Properties*.

   The active dashboard properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the active dashboard prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater than or equal to.

4. Click *OK*.

   The filter condition is applied to the active dashboard prompt.

**Procedure: How to Add Multiple Prompts to a Dashboard**

1. Create an active dashboard in Document mode, or open an existing dashboard containing at least one report, and add at least two active dashboard prompts, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 185.

2. Bind the fields to prompts that you have added, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 185.

**Procedure: How to Cascade Prompts**

When you have more than one prompt on the canvas, you can cascade prompts to populate them based on the selections of the previous prompts. Cascading prompts have a parent-child relationship, in which the parent filters the available options of the child.

An active prompt can be the parent of more than one other prompt, but cannot be a child of more than one prompt.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind at least two active prompts to fields.

2. Right-click the active dashboard prompt that you want to configure, and click *Properties*.

   The active dashboard properties dialog box opens.

3. Click *Cascades*. 
By default, a cascade named Cascade1 appears in the Cascades section of the active dashboard properties dialog box.

- You can click the Create a new cascade button to create a new cascade.
- You can click the Delete selected cascade button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.
5. From the Available Prompts list box, select the prompt that you want to add.
6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.

Note: You can remove prompts from the Selected Prompts list box by selecting them and clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and 6.

By default, the hierarchy of the prompts is determined by the order in which they are added to the Selected Prompts list. The cascade of the prompts is from top to bottom. The prompts that come first in the Selected Prompts list are the parents of the lower prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt list box and clicking the Move Up and Move Down arrows.

9. Click OK.

The cascade is created.

10. Run the report.

Note: If you set up more than one cascade, the cascade that you interact with last is the one that filters the report.

Using Navigation Options for Reports

When working with reports, you can use the following options to customize output display and navigation.

- Table. Generates standard browser output. This is the default.
- Table of Contents. Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking Table of Contents opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time.

You can also select options to view the entire report or remove the table of contents.
Note:

- The Table of Contents option is activated only when HTML, active report, Excel, or PowerPoint output format is selected.

- You cannot use the Table of Contents option with the Accordion feature.

- **Freeze.** Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output.

- **Pages On Demand.** Provides access to two distinct features depending upon the output type that you have selected.

  - **HTML.** If you select this output type, and click *Pages on Demand*, then the report opens in the WebFOCUS Viewer.

  - **active report.** If you select this output type, and click *Pages on Demand*, then active cache is enabled. For more information on active cache, see *Using the Active Cache Option* on page 114.

- **Auto Drill.** Provides access to Auto Drill functionality, which enables you to navigate the hierarchy of your data at run-time. For more information, see *Using Auto Drill*.

  **Note:** Auto Drill functionality is only available for the HTML and active report output formats.

### Creating Maps to Illustrate Trends

Using InfoAssist, you can create maps to identify patterns or trends in your data. By converting data into values that can be displayed on a map, you are able to visualize scenarios, illustrate hot spots, and identify potential problem areas. For example, a law enforcement agency may use mapping functionality to identify areas of higher crime within the locations they cover. You can also use maps to determine how places are related, understand where things are located, and identify the best actions to take. By illustrating trends on a map, a decision maker can identify patterns easily, and reach conclusions sooner.
An early example of how maps can be used to illustrate trends is the case of Dr. John Snow, an epidemiologist who was one of the first to use data to map occurrences of cholera to find the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to visualize a trend that showed higher incidences of cholera closest to water pumps. This example is shown in the following image.

Maps also allow you to measure size, shape, and distribution to detect and quantify patterns, and even perform predictive analytics. An example of how maps can help detect and quantify patterns is the scenario in which a state agency used a WebFOCUS mapping application to solve a problem with their food stamp system. Using this application, odd food stamp redemptions, such as rounded numbers transactions, were discovered. By plotting those transactions on a map, the agency discovered that the redemptions appeared in the same geographic location. Upon further investigation, the agency identified that individuals were selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to others instead using them as intended. This map example is shown in the following image.

<table>
<thead>
<tr>
<th>Citizen</th>
<th>Date</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jane Smith</td>
<td>01/03/2015</td>
<td>35.26</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>01/05/2015</td>
<td>44.12</td>
</tr>
<tr>
<td>Jane Smith</td>
<td>01/10/2015</td>
<td>12.42</td>
</tr>
<tr>
<td>John Wilson</td>
<td>01/02/2015</td>
<td>100.00</td>
</tr>
<tr>
<td>John Wilson</td>
<td>01/08/2015</td>
<td>50.00</td>
</tr>
<tr>
<td>John Wilson</td>
<td>01/11/2015</td>
<td>75.00</td>
</tr>
<tr>
<td>Mary Johnson</td>
<td>01/03/2015</td>
<td>23.24</td>
</tr>
<tr>
<td>Mary Johnson</td>
<td>01/06/2015</td>
<td>14.32</td>
</tr>
<tr>
<td>Mary Johnson</td>
<td>01/11/2015</td>
<td>34.88</td>
</tr>
</tbody>
</table>
When working with maps, the concepts of location intelligence and business intelligence are important to understand. A Geographic Information System (GIS) captures, stores, analyzes, manages, and presents data linked to a location, while Business Intelligence (BI) relies on the conversion of raw data into meaningful information. Location intelligence is the process of analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow the recognition of patterns in your data, including the visualization and discovery of geospatial outliers, which would not be easily discovered if you use the technology independently and separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view symbol layers for data bound to a geo-location, such as state, country, and ZIP code, in an integrated map viewer. Using metrics from your data, you can also visualize geographic roles or dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or assigned to a data field when you create a map.

**InfoAssist and Esri Integration**

Using WebFOCUS InfoAssist with the Esri integration, you can create maps that help you illustrate or identify trends, so that you can take action quickly. WebFOCUS architecture provides the framework in which this system operates. Using a Javascript map viewer, you can navigate the interface easily, as shown in the following image.
In addition, this integration utilizes the capabilities of Esri by leveraging the ArcGIS Javascript API and content. Specifically, you can integrate data into maps with published content in ArcGIS Online platform. For more information, see [http://www.esri.com/software/arcgis/arcgisonline](http://www.esri.com/software/arcgis/arcgisonline). Additionally, by using this integration, you can include information about demographics, spending habits, crime, and lifestyle to maps that contain your data. These maps include layers with extensive demographic or reference detail and topography and allow you to view information about people, businesses, climate, and much more.

You can create the following maps in InfoAssist:

- **Choropleth.** A common thematic map that uses geographical measures (for example, states and countries), representing the values aerially while employing a varying intensity of colors. It is useful for visualizing location-based data, trends, and distributions across a geographic area. The color hues for Choropleth maps are dictated by the legend, based on the selected measure, enabling you to determine data concentration across your map.

- **Proportional Symbol (Bubble).** A map that represents coordinates, such as an address or intersection, using symbols of different sizes to represent any measure. These maps focus on specific areas, for which data concentrations may vary. When the data concentration is larger, the bubble will be bigger.

Both maps can be created in Chart or Visualization mode. Built-in zooming capabilities allow you to drill down to a specific geographic area of focus easily. This allows you to get a closer look at regional or local data, draw inferences, and make recommendations, without changing the initial view of your data.

In Chart mode, you can also use the Auto Drill and Auto Linking features that are available when you create charts or reports in InfoAssist. In Visualization mode, you can also drill up and down within different levels in a data hierarchy in a map. Auto Drill allows you to navigate through the geographical hierarchy of your map data at run time. You can use this information to visualize the same measure at different geographical hierarchies, such as Countries to States and States to Cities. Auto Linking allows you to connect to related charts or reports in your environment that share similar data parameters.

Using the Esri integration in InfoAssist, you can also add the following layers to your map:

- **Backgrounds.** Display a layer that positions data as it is located, in context to other geographical features, such as streets, terrain, and imagery. Some standard Background options may combine road, aerial, and topographic data using a variety of symbols. Hosted on ArcGIS, you can change your background at any time, to review your data in a different context.
When you apply a Background to your map, its appearance changes. You can then adjust the view of your data, showing different terrain or geographical views. Backgrounds provide at least 17 levels of zoom. For more information, see https://developers.arcgis.com/javascript/jsapi/esri.basemaps-amd.html.

- **Reference Layers.** Display a layer of boundaries and locations that range from a continental scale to country, state, and even local neighborhood. For example, if you are viewing World data on electricity usage, you may want to add a Reference Layer that displays the borders and concentration of your data within each country.

- **Demographic Layers.** Display a layer of information about people and businesses in a specific demographic area. This includes the United States and 120 other countries. Demographic Layers are thematic maps that provide additional information about the location, such as spending habits, population, and lifestyles. You can add Demographic Layers to a map about sales data, to identify new locations for stores, based on the spending habits for a specific area.

Both mapextent and the Layers menu functionality are applied to your map when you select a Background, Reference Layer, or Demographic Layer. Mapextent is an automatic view of the map. Layers is a menu that appears on the map and provides access to options that allow you to adjust the information that is being displayed.

The map example in the following image shows the use of layers.

![Map Example Image](image-url)

**Note:** Backgrounds, Demographic Layers, and Reference Layers can be accessed from the Format tab for maps in both Chart and Visualization mode. These layers are static, standard options that Esri provides for use with InfoAssist, and do not change based on the data source that you select.
Configuring an Esri On Premise Environment

The Esri On Premise functionality enables you to download and access mapping files through the use of a local Application Programming Interface (API). Once you download and configure the API, you do not need an internet connection to utilize the robust mapping features that Esri provides. For information on downloading and configuring the API that controls this feature, see *How to Download and Configure the ArcGIS JavaScript API* on page 200.

The Esri On Premise functionality provides you with local access to Esri mapping files. This is particularly useful if you are away from your office or without an Internet connection. You may also be using a mobile device, such as an iPad or smartphone with a large screen, without an Internet connection. The following mapping components are supported when using the Esri On Premise functionality:

- **Offline Basemaps.** Basemaps are an offering from ArcGIS. Standard basemaps are provided for your use offline. For example, there is an Oceans basemap and a Terrain with Labels basemap. In InfoAssist, these basemaps are also known as backgrounds. In an online setting, there are 10 basemaps available. In order to use offline basemaps, you need to use a tiled mapservice published in the ArcGIS Server.

- **Offline Geographic Roles.** Geographic Roles are used to visualize measures with commonly known dimensions (for example, Country, State, Cities, and so on). These provide the location information often in the form of (x/y) needed to plot on a map. Geographic roles are pre-defined for online users through ArcGIS Online. In InfoAssist, a geographic role defines the geographic component that you can select when creating a map (for example, State or Continent). For an offline user, the options that display can be customized in the geoservices.xml file. For more information, see *Customizing the List of Geographic Roles* on page 220.

**Note:** Demographic Layers are not supported in an Esri On Premise environment.

**Procedure:** *How to Download and Configure the ArcGIS JavaScript API*

You can use this procedure to download and configure the API that controls the Esri On Premise environment.

1. In your browser, navigate to the following URL to download the API: [https://developers.arcgis.com/downloads](https://developers.arcgis.com/downloads)

2. Sign in to access the download options that are available to you.
3. Select Version 3.15 of the ArcGIS API for JavaScript, as shown in the following image.

![ArcGIS API for JavaScript](image)

- Size: 55Mb
- MD5: 0962ba11d1abb05a9aa152374944ca9e

4. Click API to download the API.

5. In drive:`\ibi\config\web_resource`, create a folder named arcgis_api.

6. Open the *arcgis_js_v315_api.zip* file downloaded in step 4 and navigate to `arcgis_js_v315_api\arcgis_js_api\library\3.15\3.15`.

7. Extract the files in that folder to the `drive:`\ibi\config\web_resource\arcgis_api folder.

8. Next, verify the path to the API in the WebFOCUS Administration Console, as shown in the following image.

![WebFOCUS Administration Console](image)

**Note:** This is the path to which you extracted the API files.

This field identifies the path to the internal ArcGIS Javascript API Source that develops ESRI-based maps. This setting is blank, by default, indicating that the use of the internal API source to develop ESRI maps is not activated. The API that is referenced is `https://js.arcgis.com/3.15/`, by default. To direct WebFOCUS to use the internal ArcGIS Javascript API to develop ESRI maps, enter the path to the local API files that you extracted into this setting.

**Note:** This path should be a relative path that is accessible within the local WebFOCUS install.
9. Click **Save**.

10. Next, open the following two local API files:

   - `drive:ibi\config\web.resource\arcgis_api\init.js`
   - `drive:ibi\config\web.resource\arcgis_api\dojo\dojo.js`

   In both files, search for `HOSTNAME_AND_PATH_TO_JSAPI`. Replace `'//' + 
   "[HOSTNAME_AND_PATH_TO_JSAPI]dojo" with `'//' + HOSTNAME_AND_PATH_TO_JSAPI + 
   "dojo"

11. In the WebFOCUS Administration Console, click **Clear Cache** to clear the browser cache. Your configuration is complete.

**Creating and Customizing Maps in InfoAssist**

The following procedures provide step-by-step instructions on how to create and customize maps.

As you create your maps, you can use the following built-in map viewer features:

- You can use the plus (+) and minus (-) symbols, `+`, within the map to zoom in and out of different areas of the map. You can also click your left mouse button to zoom in to a specific location.

  - Like all HTML5 visualizations, the highlighted markers and regions on a map support drill, multi-drill, auto-linking, and informational tooltip features.

  - When working with maps in Chart mode, you can use the Pan / Selection button to alternate between the Pan and Selection controls. This option is in the upper-right corner of the map.

  - When working with maps in Visualization mode, you can toggle the Pan or Selection button to make a selection. The Pan control allows you to click, hold, and move the map with your mouse. The Selection control allows you to lasso a specific area of the map and select data in the map.

**Procedure:** **How to Create an Esri Choropleth Map**

**Note:** The default option of creating a map utilizes the ArcGIS Javascript API that Esri provides.

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the **Format** tab, in the **Chart Types** group, click **Choropleth**.
In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

A blank map displays and the Layer field container is enabled, as shown in the following image.

2. Add a Geolocation field to the Layer field container.
This field, which already has a geographic role assigned, is denoted with a Layer icon, 🌍, in the Data panel, as shown in the following image. You can also hover over a data field to view the geographic role assignment.

For more information, see Geographic Roles on page 217.

The canvas refreshes, and your map displays.

3. Before saving your map, to add insight, you can also do following:
   - Click Run, to preview your map.
   - Add a measure or dimension to the Color field container, to color your chart by that underlying data value. When you add a measure or dimension field to the Color field container, a legend displays for that data value. If you specify a dimension in the Color field container, the label changes to Color BY.
   - Add a dimension or measure to the Tooltip field container, which will display tooltip information when you place your mouse over an area of the map.
   - Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.
Procedure: How to Create an Esri Proportional Symbol (Bubble) Map

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Proportional Symbol.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and select Proportional Symbol.

   A blank map displays and the Layer field container is enabled.

2. Place a data field with a defined geographic role in the Layer field container.

   This field, which already has a geographic role assigned, is denoted with a Layer icon, in the Data panel, as shown in the following image. You can also hover over a data field to view the geographic role assignment.

For more information, see Geographic Roles on page 217.
A basic bubble map displays, as shown in the following image.

3. Before saving your map, to add insight, you can also do the following:
   - Click Run, to preview your map.
   - Add a measure or dimension to the Color field container, to color your chart by that underlying data value.
   - Add a measure to the Size field container, to control the size of the bubbles on your map.
   - Add a measure to the Tooltip field container, to display tooltip information when you place your mouse over an area of the map at run time.
   - Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.

Procedure: How to Assign a Geographic Role to a Data Field

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
1. In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

2. In the Data pane, select a data field without a geolocation assignment.

3. Perform one of the following tasks to open the Map dialog box and assign a geographic role:

   - Right-click the desired data field, click Map As and select a geographic role, as shown in the following image.

   ![Map As Menu]

   - Drag the desired data field into the Layer field container.
The Map dialog box displays, as shown in the following image.

4. In the Map dialog box, select a geographic role. For example, State.

   **Note:** When specifying a geographic role, you can use Name or an ISO-2 value for countries. The ISO-2 codes are recognized worldwide, as published in http://www.iso.org/iso/country_codes

   The Map dialog box refreshes and shows the Depends on section, as shown in the following image.
5. In the Depends on section, choose from the following options:

- **Field.** Identifies a specific field on which the geographic role depends. For example, you can select Country or Continent.

- **User Defined.** Enables the definition of a specific value from the data source. Selections can be as simple as a specific country. For example, you can select US.

The Geographic Role field automatically populates based on the hierarchy of your data source. For example, if your primary geographic role was State, and in your metadata hierarchy, State depends on Country, this option displays.

6. Click **OK**.

If you used the Map As option, you must place the data field with the defined geographic role in the Layer field container. If you placed a data field in the Layer field container and defined a geographic role, the field is automatically added to the Layer field container.

A basic map displays, as shown in the following image.

![Map Image](image-url)

**Note:** If you used the Map As option, the Depends on section automatically displays, since a geographic role was selected at that time.
7. Before saving your map, to add insight, you can also do following:
   - Click Run, to preview your map.
   - Add a measure or dimension to the Color field container, to color your chart by that underlying data value.
   - Add a measure to the Size field container, to control the size of the bubbles on your map.
   - Add a measure to the Tooltip field container, to display tooltip information when you place your mouse over an area of the map at run time.
   - Add a Background, Demographic Layer, or Reference Layer.

8. Click Save to save your map.

Procedure: **How to Change the Geographic Role of a Geolocation Field**

You can change the geographic role assignment of any geolocation field using the following steps.

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

2. From the Data pane, right-click a geolocation field and click Map As.

3. Select a geographic role.
   The Map dialog box displays using the selected Geographic Role.

4. In the Map dialog box, optionally select a geographic role from the drop-down list. For example, Country.
   **Note:** This changes the selection that you made on the Map As list.

5. Accept the default value for Stored As, or choose a new value from the drop-down list, for example, ISO code. Stored As indicates how the data values are represented in the table.

6. Click OK.
   The geographic role changes for the selected Geolocation field in the Data pane, and the map refreshes using the new geolocation that you specified.
Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map in InfoAssist.
2. On the Format tab, expand the Map group and click Background, as shown in the following image.

3. Select one of the following options:

- World Street Map
- Terrain with Labels
Creating Maps to Illustrate Trends

- Oceans Basemap
- OpenStreetMap
- World Imagery
- Light Gray Canvas
- National Geographic World Map
- Dark Gray Canvas
- None

**Note:** The Imagery with Labels Background provides the terrain for your map, ranging from land contours to city streets.

Once you make a selection, the background of the map refreshes. You can continue to change your background until it displays the desired information.

**Procedure: How to Add Demographic Layers to a Map**

1. Create a new map or open an existing map in InfoAssist.
2. On the *Format* tab, expand the *Map* group and click *Demographic Layers*. 
3. Select from various population and lifestyle groups, as shown in the following image.

![Image of Demographic Layers]

**Note:** These are pre-defined demographic profiles, provided by ArcGIS. You can select multiple options in either category to gain additional insight into your data. Specifically, each Demographic Layer has its own profile and provides a layering option, when comparing values across different layers or profiles.

4. Click **OK**.
The Demographic Layers that you select are applied to your map. The map engine displays the different groups with unique hues and coloring. You can use the Table of Contents or Layers option, to toggle between the different layers that you have specified. The Layers option is shown in the following image.

![Layers Image]

Note: You can select and clear the check boxes to enable the display of one or more Demographic Layers to compare and contrast the different demographic scenarios.

Procedure: How to Add Reference Layers

1. Create a new map or open an existing map in InfoAssist.
2. On the Format tab, expand the Map group and click Reference Layers.
The Reference Layers dialog box displays, as shown in the following image.

![Reference Layers dialog box]

3. Select one or more Reference Layers, such as World Countries, to add to your map, and then click **OK**.
Your map refreshes, and the definitions and borders of the References Layers display on the canvas. You can use the Table of Contents or Layers option, to toggle different Reference Layers in your map. These options are shown in the following image.

Reference:  **Query Field Containers by Map Type**

This section presents the Query field containers that display for both charts and visualizations, by map type.

<table>
<thead>
<tr>
<th>Query field container</th>
<th>Chart mode</th>
<th>Visualization mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer.</strong> One data field, specifically a field containing location data (for example, State).</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td><strong>Color.</strong> One data field.</td>
<td>✔️</td>
<td>✔️</td>
</tr>
</tbody>
</table>
### Geographic Roles

This section contains information on the geographic roles that are supported for Esri maps in InfoAssist.

<table>
<thead>
<tr>
<th>Geographic Role</th>
<th>Description</th>
<th>Maps Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTINENT</td>
<td>World Continents</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>World Countries</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>STATE</td>
<td>World Admin Divisions</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>CITY</td>
<td>World Cities</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>COUNTY</td>
<td>World Counties</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>POSTAL-CODE</td>
<td>Postal Code</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
</tbody>
</table>

**Note:** This is a new, simplified list of geographic roles (dimensions) that you can utilize when creating a map chart. This unified list of roles provides worldwide mapping of administrative boundaries down to the postal code level. In InfoAssist, the new roles display, by default, when assigning a geographic role. They are also available for assignment from the Map As feature in the Data pane.

The following table summarizes additional geographic role information.
**Note:** All of the following roles are geographic roles, with the exception of Latitude and Longitude, which are coordinates.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role Format</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Full</td>
<td>ADDRESS_FULL</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>ADDRESS_LINE</td>
</tr>
<tr>
<td>City</td>
<td>Name</td>
<td>CITY</td>
</tr>
<tr>
<td>Continent</td>
<td>ISO-3166 code</td>
<td>CONTINENT_ISO2</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>CONTINENT</td>
</tr>
<tr>
<td>Country</td>
<td>FIPS code</td>
<td>COUNTRY_FIPS</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-2 code</td>
<td>COUNTRY_ISO2</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-3 code</td>
<td>COUNTRY_ISO3</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>Country (NUTS level 0)</td>
<td>NUTS code</td>
<td>NUTS0_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS0</td>
</tr>
<tr>
<td>District (NUTS level 3)</td>
<td>NUTS code</td>
<td>NUTS3_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS3</td>
</tr>
<tr>
<td>Geometry area</td>
<td></td>
<td>GEOMETRY_AREA</td>
</tr>
<tr>
<td>Geometry line</td>
<td></td>
<td>GEOMETRY_LINE</td>
</tr>
<tr>
<td>Geometry point</td>
<td></td>
<td>GEOMETRY_POINT</td>
</tr>
<tr>
<td>Latitude</td>
<td></td>
<td>LATITUDE</td>
</tr>
<tr>
<td>Longitude</td>
<td></td>
<td>LONGITUDE</td>
</tr>
<tr>
<td>Postal code</td>
<td></td>
<td>POSTAL-CODE</td>
</tr>
<tr>
<td>Role Name</td>
<td>Role Format</td>
<td>Geographic Role</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Province (NUTS level 2)</td>
<td>NUTS code</td>
<td>NUTS2_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS2</td>
</tr>
<tr>
<td>Region (NUTS level 1)</td>
<td>NUTS code</td>
<td>NUTS1_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS1</td>
</tr>
<tr>
<td>State</td>
<td>FIPS code</td>
<td>STATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>STATE</td>
</tr>
<tr>
<td>US County FIPS</td>
<td>FIPS code</td>
<td>USCOUNTY_FIPS</td>
</tr>
<tr>
<td>US city</td>
<td>FIPS code</td>
<td>USCITY_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCITY</td>
</tr>
<tr>
<td>US county</td>
<td>Name</td>
<td>USCOUNTY</td>
</tr>
<tr>
<td>US Postal code</td>
<td>3 digits</td>
<td>ZIP3</td>
</tr>
<tr>
<td></td>
<td>5 digits</td>
<td>ZIP5</td>
</tr>
<tr>
<td>US state</td>
<td>Abbreviation</td>
<td>USSTATE_ABBR</td>
</tr>
<tr>
<td></td>
<td>FIPS code</td>
<td>USSTATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USSTATE</td>
</tr>
<tr>
<td></td>
<td>US ISO subdivision code</td>
<td>STATE_ISO_SUB</td>
</tr>
</tbody>
</table>

The following table illustrates the geographic roles and their dependencies. Level 1 indicates the highest level of hierarchy and level 5 is the lowest level of hierarchy.
<table>
<thead>
<tr>
<th>Region</th>
<th>Hierarchy Level</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>1</td>
<td>COUNTRY, COUNTRY_ISO_CC</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>USSTATE, USSTATE_ABBR, USSTATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>USCOUNTY, USCOUNTY_FIPS</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>USCITY, USCITY_FIPS</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>ZIP3, ZIP5</td>
</tr>
<tr>
<td>World</td>
<td>1</td>
<td>CONTINENT, CONTINENT_ISO_CC</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>COUNTRY, COUNTRY_FIPS, COUNTRY_ISO_CC, COUNTRY_ISO2, COUNTRY_ISO3</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>STATE, STATE_ISO_SUB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>

**Customizing the List of Geographic Roles**

Customers with Enterprise Data often have map layers that represent their territories, events, or logistical information. These are published as Map Services to either a subscription based in the Esri Cloud (ArcGIS.com) or on an internal portal. This portal is available with ArcGIS Server 10.3 installations. More information can be found at http://server.arcgis.com/en/portal/.

InfoAssist comes with a configuration file (geo_services.xml) that contains elements that describe all of the geographic roles, geographic hierarchies, URLs to the map services, and base maps available to InfoAssist. This file is located in the catalog directory under the server home directory:

c:\ibi\srvnn\home\catalog

where:

*nn*

Is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.
The geographic role selections that you can make in InfoAssist are built dynamically using this configuration file. Each role definition in the configuration file, when selected in InfoAssist, generates metadata and a request that is sent to Esri in order to download the appropriate map and place the markers or polygons on the map.

A geographic role can be part of a hierarchy. For example, the World geographic role is at the top of a hierarchy that contains continents, countries, states, and cities. These hierarchies are also described in the geo_services.xml file.

To add a custom geographic role, you must add the necessary parameters for the geography to this file.

You can also customize the geographic roles available by deleting geographic role definitions from the <GEO_ROLES> object. To configure Esri On Premise, you should remove any geographic role definition that references a URL that points to a location outside of your locally hosted Esri server.

Following standard XML syntax rules, each element is enclosed in element start and end tags (<elementname>, </elementname>), and attribute values are enclosed in double quotation marks (").

**Reference:** Geographic Role Definitions

A geographic role is stored as a geo_role element in the geo_roles object of the geo_services.xml file. A geographic role must be defined with:

- An ID that will identify the role in the configuration file.
- A format and length for the data to be returned.
- A role name.
- A display title for the role name (to appear as a selection in Map dialog box in InfoAssist).
- An optional role format (if the role can have multiple formats, such as a name and an abbreviation).
- A display title for the format.
- A role type (geography for polygons, geometry for geometry points, geometry areas, or geometry lines, or coordinate for longitude or latitude).
- An optional vocabulary rule element containing vocabulary elements for associating the role with a field in the metadata.
The syntax is

```xml
<geo_role id="id" value_size="size" unified="false" role_name="rname"
          role_name_title="rname_title" role_format="rformat"
          role_format_title="rformat_title" geo_type="gtype"
          type="datatype" >
    <vocabulary_rules>
      <vocabulary>vrule</vocabulary>
    </vocabulary_rules>
</geo_role>
```

where:

**id="id"**

Is an alphanumeric uppercase value, up to 50 characters, used to identify the geographic role.

**type="datatype"**

Is the data type for the ID. Can be one of the following.

- "alpha" for alphanumeric data, formats An or In.
- "integer" for integer numeric data, format In.
- "numeric" for fractional numeric data, formats Pn.m, Dn.m, or Fn.m.
- "text" for text data, format TXn.

**value_size="size"**

Is the optional number of characters in USAGE format length (any, if not set).

**role_name="rname"**

Is the name of the geographic role.

**role_name_title="rname_title"**

Is the title of the geographic role, to be displayed in the Map dialog box for selection.

**role_format="rformat"**

Is an optional format for the geographic role, useful when the role can be referenced using multiple formats, such as a name, an ISO code, and an abbreviation. Standard role titles include the following.

- **NAME.** Specifies that the role defines the name of a geographic entity, such as Florida.
- **ABBR.** Specifies that the role defines an abbreviation, such as FL.
ZIP3. Specifies that the role defines a 3-digit zip code.

ZIP5. Specifies that the role defines a 5-digit zip code.

FIPS. Specifies that the role defines a FIPS (Federal Information Processing Standard) code.

ISO2. Specifies that the role defines an ISO 3166-2 code published by the International Organization for Standardization (ISO).


LINE. Specifies that the role defines one line of a role, just as an address line.

FULL. Specifies that the role defines a full geographic role, such as a full address.

role_format_title="rformat_title"

Is an optional title for the format of the geographic role. It will be shown in parentheses along with the role title in the Map dialog box, for example, State (Abbreviation).

geo_type="gtype"

Is one of the following predefined role types.

- "geography" for geographic objects, such as country or state.
- "geometry" for geometry objects, such as geometry point, geometry line, and geometry area.
- "coordinate" for coordinates, such as latitude and longitude.

<vocabulary>vrule</vocabulary>

Is an element that consists of a group of vocabulary elements that explicitly describe column names for the geographic role. These rules will be used to select the best geographic data for the role.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be satisfied). Each vocabulary element contains words enclosed with special characters. Words in the rule element are connected by the Boolean logic operation AND (all need to be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a place holder for any sequence of characters. If an element contains more than one word, each word has to be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in the column name. Minus indicates that the word must not be found in the column name.
Once you have added a geographic role definition, you can run the geo_srv_roles procedure on the Reporting Server to see that the parameters were added correctly.

**Example:**  **Sample Geographic Role Definitions**

The following defines the State Abbreviation geographic role. The role ID is USSTATE_ABBR. The role name is USSTATE with a role format of ABBR. The titles that show in the Map dialog box are US state (Abbreviation). The format is A2, and the vocabulary rules specify that the characters state must be present, but the characters iso, capital, and population must not be present. The geo type is geography, indicating that the returned data will be a geographic area.

```xml
<geo_role
  id="USSTATE_ABBR"
  value_size="2"
  type="alpha"
  role_name="USSTATE"
  role_name_title="US state"
  role_format="ABBR"
  role_format_title="Abbreviation"
  geo_type="geography">
  <vocabulary_rules>
    <vocabulary>%state%-%iso%-%capital%-%population%</vocabulary>
  </vocabulary_rules>
</geo_role>
```

The following is a role definition for latitude values. The role ID is LATITUDE. The role name is also LATITUDE. Its format is numeric. The title that displays in the Map dialog box is Latitude. The geo type is coordinate, indicating that the returned data will be points. The vocabulary rules specify that the characters latitude must be present.

```xml
<geo_role
  id="LATITUDE"
  type="numeric"
  role_name="LATITUDE"
  role_name_title="Latitude"
  geo_type="coordinate">
  <vocabulary_rules>
    <vocabulary>%latitude%</vocabulary>
  </vocabulary_rules>
</geo_role>
```
The following is the definition for the city role. The ID is CITY. The role name is also CITY. Its format is NAME. The title that displays in the Map dialog box is City (Name). The definition has a set of vocabulary elements. Only one of the elements in the list must be true. Therefore, the characters city, or town, or country plus capital, or state plus capital must be present.

```xml
<geo_role
  id="CITY"
  type="alpha"
  role_name="CITY"
  role_name_title="City"
  role_format="NAME"
  role_format_title="Name"
  geo_type="geography">
  <vocabulary_rules>
    <vocabulary>%city%-%population%</vocabulary>
    <vocabulary>%town%-%population%</vocabulary>
    <vocabulary>%country%+%capital%-%population%</vocabulary>
    <vocabulary>%state%+%capital%-%population%</vocabulary>
  </vocabulary_rules>
</geo_role>
```

**Reference:** Geographic Role URI Definitions

After adding a geographic role, you must add its URI to the <URIS> object in the geoservices.xml file. The syntax is.

```xml
<uri description="description">
  <returned_geometry>type</returned_geometry>
  <returned_georole>role</returned_georole>
  <url type="esri" authorization="auth" synonym="">
    "url_to_georole"
  </url>
  <parameters>
    <parm order="number" parm_name="pname" parm_georole="parmrole"/>
  </parameters>
</uri>
```

where:

"description"

Is a description for the geographic role to which the URI is pointing.

*type*

Is any supported geometry type, such as GEOMETRY AREA.

*role*

Is the name of the returned geographic role.

"auth"

Is the type of authentication needed to access this geographic role. Valid values are:

- **silent.** Authentication credentials are configured in the Adapter for Esri.
Creating Maps to Illustrate Trends
none. No authentication is needed.
named. Credentials must be explicitly provided by the user on a login screen.
on premise. Authentication is configured by the locally hosted ArcGIS server.
"url_to_georole"

Is the URL for the geographic role.
parm order="number"

Is the number of a parameter needed to retrieve the correct geographic role.
parm_name="pname"

Is the name of the parameter associated with parm order.
parm_georole="parmrole"

Is the name of the geographic role associated with parm order.
Once you have added the URI, you can run the geo_srv_map_uris procedure on the Reporting
Server to see that the parameters were added correctly.
Note: You must add the base URL to the list of proxy URLs in the esri_arcgis_rest.xml file. For
example:
<ESRI_URL URL="//services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS"
DESCRIPTION="Custom Data" />

Reference:

Adding the WebFOCUS Retail Regions Geographic Role
These steps describe how to add the WebFOCUS Retail Regions geographic role to the
geo_services.xml file.
1. Open the geo_services.xml file. The default location is:
C:\ibi\WebFOCUSnn\srv\home\catalog\geo_services.xml

where:
nn

Is your release of WebFOCUS. For example, 82 for release 8.2.
2. Add the role to the end of the GEO_ROLES object:
<geo_role id="REGION" value_size="50" unified="false"
role_name="WF_Region" role_name_title="WF_Region"
role_format="NAME" role_format_title="NAME"
geo_type="geography" type="alpha" >
<vocabulary_rules>
<vocabulary>+%region%</vocabulary>
</vocabulary_rules>
</geo_role>

226

Information Builders


The ID is REGION. The role name is WF_Region. Its format is NAME. The title that displays in the Map dialog box is WF_Region. The definition has a vocabulary rule. The characters region must be present.

Run the geo_srv_roles procedure on the Reporting Server to see that the role was added correctly. The output is shown in the following image.

List of grouped GEO.Roles

<table>
<thead>
<tr>
<th>ROLE_NAME_TITLE</th>
<th>ROLE_FORMATTITLE</th>
<th>GEO_ROLE</th>
<th>GEO_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Full</td>
<td>ADDRESS_FULL</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>ADDRESS_LINE</td>
<td>geography</td>
</tr>
<tr>
<td>City</td>
<td>Name</td>
<td>CITY</td>
<td>geography</td>
</tr>
<tr>
<td>Continent</td>
<td>ISO-3166 code</td>
<td>CONTINENT_ISO2</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>CONTINENT</td>
<td>geography</td>
</tr>
<tr>
<td>Country</td>
<td>FIPS code</td>
<td>COUNTRY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-2 code</td>
<td>COUNTRY_ISO2</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-3 code</td>
<td>COUNTRY_ISO3</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>COUNTRY</td>
<td>geography</td>
</tr>
<tr>
<td>County</td>
<td>Name</td>
<td>COUNTY</td>
<td>geography</td>
</tr>
<tr>
<td>Geometry area</td>
<td>.</td>
<td>GEOMETRY_AREA</td>
<td>geometry</td>
</tr>
<tr>
<td>Geometry line</td>
<td>.</td>
<td>GEOMETRY_LINE</td>
<td>geometry</td>
</tr>
<tr>
<td>Geometry point</td>
<td>.</td>
<td>GEOMETRY_POINT</td>
<td>geometry</td>
</tr>
<tr>
<td>Latitude</td>
<td>.</td>
<td>LATITUDE</td>
<td>coordinate</td>
</tr>
<tr>
<td>Longitude</td>
<td>.</td>
<td>LONGITUDE</td>
<td>coordinate</td>
</tr>
<tr>
<td>Postal code</td>
<td>.</td>
<td>POSTAL-CODE</td>
<td>geography</td>
</tr>
<tr>
<td>Seattle Onprem Neighborhoods</td>
<td>Seattle Neighborhoods</td>
<td>SEATON_NBRHDS</td>
<td>geography</td>
</tr>
<tr>
<td>State</td>
<td>FIPS code</td>
<td>STATE_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO subdivision code</td>
<td>STATE_ISO_SUB</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>STATE</td>
<td>geography</td>
</tr>
<tr>
<td>US city</td>
<td>FIPS code</td>
<td>USCITY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCITY</td>
<td>geography</td>
</tr>
<tr>
<td>US county</td>
<td>FIPS code</td>
<td>USCOUNTY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCOUNTY</td>
<td>geography</td>
</tr>
<tr>
<td>US postal code</td>
<td>3 digits</td>
<td>ZIP3</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>5 digits</td>
<td>ZIP5</td>
<td>geography</td>
</tr>
<tr>
<td>US state</td>
<td>Abbreviation</td>
<td>USSTATE_ABBR</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>FIPS code</td>
<td>USSTATE_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USSTATE</td>
<td>geography</td>
</tr>
<tr>
<td>WF_Region</td>
<td>NAME</td>
<td>REGION</td>
<td>geography</td>
</tr>
</tbody>
</table>
3. Add the URI to the map server layer for this role at the end of the URIS object:

```xml
<uri description="WF Retail Regions">
  <returned_geometry>GEOMETRY_AREA</returned_geometry>
  <returned_georole>REGION</returned_georole>
  <parameters_georoles>
    <parm position="1" parm_georole="REGION" />
  </parameters_georoles>
  <urls>
    <url type="esri" authorization="none" synonym=""
      value="/services7.arcgis.com/L95Wwv90jg7as/ArcGIS/rest/services/wfretail_sub_regions/FeatureServer/0"
      provider="Esri">
      <keys key="default" />
      <parameters_names>
        <parm position="1" parm_name="SUB_REGION" />
      </parameters_names>
    </url>
  </urls>
</uri>
```

**Note:** You must add the base URL to the list of proxy URLs in the esri_arcgis_rest.xml file. For example:

```xml
<ESRI_URL URL="/services7.arcgis.com/L95Wwv90jg7as/ArcGIS" DESCRIPTION="Custom Data" />
```

Optionally, on the Reporting Server, run the geo_srv_map_uris procedure to see if the parameters were added correctly. The output is shown in the following image.

![List of mapping URIs with signatures](image-url)
You will now be able to select this role from the Map As menu the next time you start WebFOCUS, as shown in the following image.

**Example:** Using the WebFOCUS Retail Regions Role in a Map Layer

This example configures a map layer using the WF_Region role.
In the Data pane, right-click a field that contains subregion data, for example. On the shortcut menu, select Map As and then select the WF_Region role, as previously illustrated. The output is shown in the following image:

Customizing the List of Basemap Definitions

You can add custom basemaps for use with maps.

Adding a Custom Basemap

The list of basemaps available to InfoAssist is built dynamically on the server using the list of <basemap> objects in the geo_services.xml file, which is located in the catalog directory under the server home directory:

c:\ibi\srvnn\home\catalog

where:

nn

Is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.
The following are some sample standard basemap definitions from this file that exist prior to customization.

```xml
<BASEMAPS>
...
<basemap custom="false" default="false" name="streets"
    title="World Street Map" icon="qb/streets_map_108x72.png" />
<basemap custom="false" default="false" name="satellite"
    title="World Imagery" icon="qb/imagery_map_108x72.png" />
<basemap custom="false" default="false" name="terrain"
    title="Terrain with Labels" icon="qb/terrain_map_108x72.png" />
<basemap custom="false" default="true" name="gray"
    title="Light Gray Canvas Map" icon="qb/gray_map_108x72.png" />
...
</BASEMAPS>
```

The properties defined for the standard basemaps are `custom` (which is `false` for the standard basemaps), `default`, `name`, `title`, and `icon`.

To define a custom basemap, you must define these properties for your custom basemap, and add a URL that points to the map service that has the basemap image.

**Note:** Any basemap you add must be a tiled map layer.

You can also customize the list of basemaps by deleting basemap definitions from the `<basemaps>` object. To configure Esri on Premise, you should remove any basemap definition that references a URL that points to a location outside of your locally hosted Esri server.

The syntax for a basemap definition is

```xml
<basemap custom="boolean" default="boolean" name="mapname"
    title="maptitle" icon="url_to_icon" url="url_to_basemap" />
```

where:

- `custom="boolean"` Specifies whether the basemap is standard or custom. Valid values are true and false. To add a custom basemap, specify custom="true".

- `default="boolean"` Specifies whether this basemap should be the default basemap if the user does not select a basemap. Valid values are true and false.

- `name="mapname"` Is a name for the basemap.

- `title="maptitle"` Is a title that will display in the Basemap drop-down list in the list of basemaps in InfoAssist.
Is the location of a thumbnail image for the basemap.

url="url_to_basemap"

Is the URL to the map service that provides the basemap.

After you add the basemap definition, you can run the geo_srv_basemaps procedure to see if the parameters were added correctly.

Example: Adding a Custom Basemap

The following <basemap> object defines the soil survey basemap.

<basemap name="soil_survey" custom="true" default="false" title="Soil_Survey_Basemap"
icon="https://server.arcgisonline.com/arcgis/rest/services/Specialty/Soil_Survey_Map/MapServer/info/thumbnail"
url="https://server.arcgisonline.com/ArcGIS/rest/services/Specialty/Soil_Survey_Map/MapServer" />

Add this definition to the list of basemap objects in the geo_services.xml file. Note that the entire URL string must be on one line in the file, even if it breaks in this document because of the page size.

Optionally, on the Reporting Server, run the geo_srv_basemaps procedure. The output is shown in the following image.

Creating Maps to Illustrate Trends
When you create a map, your custom basemap appears in the Basemap drop-down list in InfoAssist, as shown in the following image.
Building InfoMini Applications

InfoMini applications are built from an InfoAssist report and contain a subset of InfoAssist functionality available at run time.

You can build an InfoMini application and provide the run-time user with the option to interact with and edit the report.

Understanding InfoMini Applications

When you create a report in InfoAssist, you have the option to activate InfoMini. You can run a report with InfoMini activated, which creates an InfoMini application. An InfoMini application contains a subset of the functionality available in the full version of the report or chart. You can limit or expand the functionality that is available to the user at run time when you build the report in InfoAssist.

An InfoMini application opens in its own browser window when it is run from within InfoAssist to test. An InfoMini application does not open in its own browser window in the portal or in any other application that you build yourself.

An InfoMini application has many of the components an InfoAssist report has, with the following exceptions:

- The main menu is not accessible.
The New, Open, and View code buttons on the Quick Access Toolbar are not available.

Certain tabs and groups are unavailable or limited.

The status bar is not accessible.

The navigation taskbar is not accessible.

InfoMini does not support referencing existing procedures.

For more information on the available components and their functionality, see InfoAssist Application Window.

Using the InfoMini Button

The InfoMini button can be found on the Format tab, in the Destination group. You can click the InfoMini button to activate the InfoMini option. With the InfoMini button active, you can run a report to open the InfoMini application.

To deactivate the InfoMini option, click the InfoMini button again. There must be at least one option selected from the InfoMini button menu for InfoMini to be activated.

You can set the options available to the user at run time from the menu on the InfoMini button. If you select an option from the menu when the InfoMini button is inactive, the InfoMini option is activated. The options are:

- Format Tab
- Slicers Tab
- Run Immediately
- Run Deferred

When you select an option from the menu, a check mark appears next to the option. The check mark indicates the option is available for the user at run time within the InfoMini application. If you select a checked option to clear it, the check mark disappears, and the option is no longer available through the InfoMini application. If you clear all of the options from the menu, InfoMini is deactivated. All options are selected by default.

The Run Immediately option enables reports to run immediately when InfoMini first launches. You might want to clear this option so that the user can choose a format and pick slicers before running a report.
Understanding the InfoMini Layout

The Resources panel is not available in InfoMini. If no options are selected from the InfoMini button when the application runs, an error message displays, indicating that you must select at least one tab.

From the Format tab, you can access the Output Types group, with the following exceptions:

- The Destination and Features groups, which are on the Format tab in InfoAssist, are not available in an InfoMini application.
- The Other button, which is on the Format tab, in the Chart Types group in InfoAssist, is not available in an InfoMini application.
- The InfoMini button, which is on the Format tab, in the Destination group in InfoAssist, is not available in an InfoMini application.

The Output Types group contains commands to create output in any of the supported formats. For reports and charts, you also have access to the Auto Linking group. This group contains options for enabling the functions of Auto Linking, a feature that allows you to create a suite of referenceable reports and charts in your enterprise.

For more information on the functionality of the available groups on the Format tab, see Format Tab.

From the Slicers tab, you can access the Options, Record Limit, and Slicer Group groups, with the following exceptions:

- The New Group option, which is on the Slicers tab, in the Options group in InfoAssist, is not available in an InfoMini application.
- The Update Preview option, which is on Slicers tab, in the Options group in InfoAssist, is not available in an InfoMini application.
- The Preview list, which is on the Slicers tab, in the Record Limit group in InfoAssist, is not available in an InfoMini application.

For more information on the functionality of the available groups on the Slicers tab, see Creating Slicers.
Creating an InfoMini Application

To create an InfoMini application in InfoAssist, build a report as you normally would, then activate InfoMini and add the functionality you want the user to have available to them at run time. For more information on what functionality is available to InfoMini applications, see Understanding InfoMini Applications on page 234.

Procedure: How to Activate InfoMini

1. With a report or chart open, click the Format tab.
2. In the Destination group, click InfoMini.
   
   **Note:** At least one option from the InfoMini menu must be selected in order to activate InfoMini. By default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in a new report. For more information on enabling InfoMini options, see How to Enable and Disable InfoMini Application Options on page 237.

   The InfoMini button is highlighted and the InfoMini mode is activated. For more information about running an InfoMini application, see How to Test an InfoMini Application on page 237.

Procedure: How to Enable and Disable InfoMini Application Options

You can choose which options will be available at run time in an InfoMini application. By default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in a new report. For more information about the functionality of each option, see Understanding InfoMini Applications on page 234.

1. With a report or chart open, click the Format tab.
2. Click the arrow next to the InfoMini button. A menu of available tabs and options displays.
   
   InfoMini does not have to be active for you to access the menu. When you select an option from the menu, InfoMini is activated.
3. From the menu, select any options you want to display in your InfoMini application.

Procedure: How to Test an InfoMini Application

1. With an InfoAssist report open, activate InfoMini as described in How to Activate InfoMini on page 237.
2. Enable the options that you want, as described in How to Enable and Disable InfoMini Application Options on page 237.
3. Run the report.
An InfoMini application opens in a new window.

**Procedure:**  **How to Interact With an InfoMini Application**

With an InfoMini application open, you can edit the application using the functionality that was enabled in InfoAssist. You have access to certain options, depending on which options were enabled.

You have the ability to alter the InfoMini application at run time. Changes to the application are not reflected on the canvas dynamically and you must run the report to see the updates.

1. Run a report with InfoMini activated, as described in *How to Test an InfoMini Application* on page 237.
   
   An InfoMini application opens in a new window.

2. By default, the ribbon is hidden in an InfoMini application. To display the ribbon, do one of the following:
   
   - Click one of the tabs (Format or Slicers).
   - Click the down arrow next to the Help icon.
   
   The available options on these tabs provide the same functionality as they do in InfoAssist. You can use this embedded functionality to change the report at run time.

3. After making your changes, click *Run* to see an updated version of the report.

**Viewing Data Behind Visuals**

You can use InfoAssist to analyze your data by creating or building interactive visualizations. As you develop these visualizations, you can create different views of the data, and find patterns or trends.

As you gain insight and spot patterns, you may want to share only the underlying data that comprises a specific visual with others in your enterprise. You can do this using the data options, as shown in the following image.

The Show data option provides options for you to view and share this data. The Export data option enables you to export the data specific to your visualization in a summary or detailed format. You can also review related data by using the Show Data with Related Columns option.
The Show Data with Related Columns functionality allows you to review more specific underlying data based on the fields that you have selected. Specifically, it displays data related to other fields that are part of the dimension hierarchy that you select. For example, if you selected the Product,Category dimension field, the related column data would include data from the Product,Subcategory and Model dimension fields, because these data fields are part of that dimension hierarchy.

Similar to the Show data option, the Show Data with Related Columns option provides more detailed data based on the data fields that you select. You can sort and review the data columns, which display in a separate browser window. Depending on the size and breadth of your dimension hierarchy, a multiple page report may be produced.

**Note:** You can export data in .xls or .csv format.

When you select the option to show data or show data with related columns, a report is generated in a separate browser window. This report is an active report, which you can review, sort, and modify using the drop-down menus that are available.

When you point to the Export Data option, you can:

- Export data in summary format, which includes totals for categories based on the data fields that you selected for your visual.
- Export more granular data based on the data values that you selected in your visual.

**Note:**

- When exporting data using the Summary or Data Detail options, you can save the resulting data file, which is in Microsoft® Excel® format, to your local machine for further analysis and sharing.
- The maximum number of records that can be exported is 100,000.

**Procedure:** How to Show the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, click Show Data.

A new browser window opens. This window displays the data for your visual as a WebFOCUS active report. You can use this active report to create and share lightweight, browser-based data discovery analytics that are portable, and only require access to a browser.
Procedure: How to Show Data With Related Columns

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, click Show Data with Related Columns.

A new browser window opens. This window displays the data for your visual as a WebFOCUS active report. You can use this active report to sort and work with the underlying hierarchical data in your visual.

Procedure: How to Export the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, point to Export Data, and then click one of the following:

   - Summary. A prompt appears, asking you to open or save a Microsoft Excel file. This file is a summary of your data from a high level for a general analysis, as shown in the following image.

     | A      | B                        | C            | D            |
     |--------|--------------------------|--------------|--------------|
     | Product Category | Product Name       | Revenue       | Gross Profit |
     | 1       | Accessories             | $9,341,397.65 | $2,354,397.65|
     | 2       | Cycle Energy Quick with Refresh Charger | $1,508,212.41 | $666,612.41  |
     | 3       | Denon AH-D5000 Over-Ear Headphones  | $9,272,133.77 | $2,477,303.77|
     | 4       | Grado RS11 Reference Series Headphones | $9,452,243.25 | $2,208,713.25|
     | 5       | Universal Remote         | $14,419,020.31 | $4,401,161.31|
     | 6       | Control                  | $9,301,960.89  | $1,518,520.89|
     | 7       | Anywhere Kit with Tabletop Sensor | $11,401,805.70 | $2,616,237.70|
     | 8       | Anywhere Kit for Home Theater | $14,276,128.75 | $4,825,372.75|
     | 9       | Headphones               | $8,028,218.25  | $4,049,178.25|
     | 10      | Samsung OEM 2.0 Amp Travel Charger | $2,514,022.50  | $1,303,511.50|

   - Data Detail. Generates a detailed report that provides specific data regarding your data analysis.

Creating Multi-Y Axis Comparative Visuals

When creating a chart with more than one measure (numeric) field, you can split the Y axis to create multiple charts, based on each unique measure field.

Note: Measure fields are selected from the Data pane and display under the Vertical Axis (Y) in the Query pane.
This functionality is useful when analyzing trends for multiple measure fields, as you can view data for each measure field separately within the same chart, as shown in the following image.

![Image of Multi-Y Axis Comparative Visual]

This functionality is available for Bar, Bar Stacked, Line, Area, and Area Stacked charts.

**Procedure: How to Create a Multi-Y Axis Comparative Visual**

1. Launch InfoAssist in visualization mode.
3. Select one of the following visual types: Bar, Bar Stacked, Line, Area, or Area Stacked.
   
   **Note:** Bar Stacked is the default visual type.
4. Add multiple measure fields to the visual. For example, Gross Profit and Revenue.
5. Add at least one dimension field to the visual. For example, Product Category.
6. In the Query pane, right-click Vertical Axis.
7. Click Multi-Y split.

   The chart changes to display individual charts for each measure field.

   **Note:** You can revert your chart to an integrated display by right-clicking Vertical Axis and then clicking Multi-Y split.
Creating HOLD Files

A HOLD file is the output of a report request stored in a file that you can use as input to another WebFOCUS procedure.

You can then create new report requests that extract data from the HOLD file, resulting in a multi-step report.

HOLD files can be created to use in a report, chart, document, or visualization.

Valuable Applications of HOLD Files

A HOLD file is valuable when you want to do the following:

- Extract fields from a large data source for faster and more efficient retrieval in subsequent requests.
- Store virtual field values or summary values calculated in one request for further processing in another request.

Storing HOLD Files

HOLD files can be created for immediate use and saved temporarily or they can be stored for future and repeated use.

Output Formats for Reports

You can save a HOLD file for a report in the following formats:

- Binary (*.ftm)
- FOCUS (*.foc). For more information, see FOCUS Format Index Fields on page 246.
- Comma Delimited with Titles (*.csv)
- Plain Text (*.ftm)
- Tab Delimited (*.tab)
- Tab Delimited with Titles (*.tab)
- Database Table (*.sql)

**Note:** The Database Table output is only available when working against an SQL database.

- SQL Script (*.sql)
- Hyperstage (*.bht)
Note: The Hyperstage output is only available when the reporting server has a Hyperstage adapter configuration.

- XML (*.xml)
- JSON (*.json)
- Visual Discovery AE (*.txt)

Note: The Visual Discovery AE output option is only available with a Visual Discovery Analyst Edition license.

Creating Hold Files

This section contains examples of how you would use a HOLD file.

Note:

- Across fields are not allowed in HOLD files.

- Using the Change Title option in the Query pane, you can change the title of a field prior to creating a HOLD file. A blank space in the title will be replaced by an underscore. This functionality enables you to control the names used for the fields included in the HOLD file, and makes it easier to find the fields when creating report.

- When creating a HOLD file, the Temporary dialog box displays only those reporting server applications to which you have access.

- When a report contains a HOLD procedure, dots or periods (.) in the AS name of the Define field are automatically converted to an underscore (_).

- You can use Auto Linking when working with HOLD files. For more information, see Using the Auto Linking Feature to Link Content.

Procedure: How to Create a Tabular Report From a HOLD File

To create a tabular report from a HOLD file, begin by creating a report.

1. In the Open dialog box, select the wf_retail_lite Master File.

2. Add the following measure fields to the report:

   - Cost of Goods
   - Discount
   - Gross Profit
3. Add the following dimension fields to the report:

- Product Category
- Product,SubCategory
- Sale,Year


   The Temporary dialog box opens.

5. In the Temporary dialog box, name the HOLD file, keep the default file type, Binary (*.ftm), and click Save.

6. At the bottom of the canvas, click Create Report.

   The custom database structure displays in the Resources panel. The canvas is returned to a default blank state, enabling the development of a new report using the HOLD file.

7. From the HOLD file, drag Quantity,Sold to the canvas.

8. On the canvas, select the Quantity,Sold column heading.

9. On the Field tab, in the Display group, click Aggregation and then click First Value.

   Note: The heading changes to FST Quantity Sold.

10. Select the FST Quantity Sold heading.

11. On the Field tab, in the Display group, click Hide Field to hide Quantity,Sold, as it will be used in a subsequent calculation.

12. On the Data tab, in the Calculation group, click Summary (Compute).

13. In the Summary Field (COMPUTE) dialog box, do the following:

   - In the Format field, type D8.2%.
   - Double-click the Quantity,Sold field to add it to the formula box.
   - Add / 100 after the Quantity Sold field to calculate the percentage.

14. Click OK to close the dialog box.

15. Drag Product,Category to the By Query field container.

16. In the Query pane, select the Product,Category field.

17. On the Field tab, in the Break group, select Subtotal to create Subtotals on Product,Category.
18. Drag Product, Subcategory to the By Query field container.
19. Drag Sale, Year to Across.

The final report displays.

Procedure: How to Rearrange HOLD File Components

The following procedure describes how to rearrange file components in a HOLD file.

**Note:** This procedure creates a binary HOLD file and a subquery to illustrate how to rearrange HOLD files. It also shows the result of this rearrangement.

1. Create a new document, using the wf_retail_lite Master File for the data source.
2. On the Insert tab, in the Reports group, click Report. Populate the report with the following fields from the Data pane:
   - Gross Profit
   - Quantity, Sold
   - Revenue
   - Product, Category
   - Product, Subcategory
3. On the Home tab, in the Format group, click File to create a HOLD file.
   In the Temporary dialog box, enter a name for the file. For example, File1_binary.
4. Click Save.
5. Create a report using the HOLD file, specifying Product, Category, Product, Subcategory, and Quantity, Sold.
6. Next, using the following steps, add a subquery SQL script for use as a filter on the first report.
   a. On the Data tab, in the Data Source group, click Switch.
      Select the original master file (wf_retail_lite.mas).
   b. Locate and double-click the Product, Category dimension field.
      This creates a second report, which you can drag and resize as needed on the Document canvas.
   c. Create a filter on Product, Category, where the product category is equal to Televisions.
7. With the new component selected, click the Home tab and in the Format group, click File.

   In the File name field, enter File2_subquery and select the SQL Script (*.sql) format from the file types menu.

8. Click Save.

9. Rearrange the order of the HOLD files so that the File2_subquery is positioned above the File1_binary HOLD file using the following steps:

   a. Right-click Files in the Query pane and click Arrange Files, as shown in the following image.

      ![Arrange Files dialog box](image)

      The Arrange Files dialog box opens.

   b. Using the Arrange Files dialog box that displays, select File2_subquery and click Move Up to move the file above File1_binary.

   c. Click OK.

10. Edit the first report and create a filter using the subquery.

11. Click OK to exit the Create a filtering condition dialog box.

    Your report is refreshed to reflect the filtering you have applied.

**FOCUS Format Index Fields**

FOCUS is the only format that supports an index field. The maximum number of fields to index is four. If the file format is FOCUS, then Index appears on the Query pane.

**Creating a Subquery Filter Using a HOLD File**

You can create a subquery using a HOLD file. A subquery is a nested query that is added to the Where clause of an SQL statement. A subquery is valuable because it is highly reusable.
**Procedure:** How to Create a Subquery Filter Using a HOLD File

This procedure describes how to create a subquery filter using a HOLD file created in the previous procedure.

1. Build a report.
2. On the Data tab, in the Filter group, click *Filter*.
   
   The Filter dialog box opens.
3. In the Filter dialog box, from the Type drop-down menu, select *Subquery* as the filter type for the left-most part of the expression.
4. From the Subquery drop-down menu, select *In list* as the comparison operator.
5. From the list of subqueries, select the subquery that was created (in this example, File1) for the right-most part of the expression.
6. Click *OK*.
   
   The report is filtered by the subquery that you created.

**Note:** To view the SQL statements generated by the request, go to the Quick Access Toolbar, open the Run drop-down menu, and select *SQL Trace*.

---

**Working With Alerts**

In the business climate today, cutting costs and increasing profitability are critical. Organizations create and distribute reports for evaluating and taking action when management-defined conditions are not met. The evaluation can largely be automated using Alert reporting.

Alert reporting automates the evaluation of a defined condition to determine whether or not a report should be submitted. Recipients of the report know before they open it that they are receiving this report because there is an exception in their area of responsibility. This topic introduces and describes how you can create Alerts in WebFOCUS.

**Alert Reporting**

A data-driven Alert is an event that is prompted by a guideline that you define. This guideline can vary from the simple to the complex. For example, a simple guideline is to alert a sales manager when an order that exceeds $1 million is entered. An example of a more complex guideline is to alert a department manager when cumulative expenses exceed budget for any category. The report sent to the manager as a result of the Alert might show the most recent transactions, the amounts, and the sources.
Alert reporting is an integrated feature of WebFOCUS Managed Reporting and ReportCaster. An Alert report can be run interactively or by authorized users. You can use ReportCaster to schedule and distribute an Alert report. Burst capability can send targeted information to the people who need it, so that there is less information for each person to analyze.

Alerts work with all email clients. They are supported on the following mobile devices: iPhone®, iPad®, and email enabled mobile phones. Alerts can also be sent to any PC or laptop computer with email capability.

Alerts provide the following:

- **Alert tools.** Using Alert Assist, you can quickly set up test conditions (rules) that determine if an Alert condition should be triggered (true). This is called the Alert test. When the Alert test is triggered (true), the Alert result is run. An Alert result can be an existing report procedure or you can create the Alert result using InfoAssist.

- **Scheduling flexibility.** Optionally, you can schedule an Alert to run as often as every minute to evaluate the Alert test conditions.

**Components of an Alert**

An Alert consists of the following:

- Alert test
- Alert result

An Alert test is required to check whether or not a set of defined test conditions (rules) is met (true or false). An Alert test can be a WebFOCUS Test, which is a simple TABLE request that you create to define the condition to test for. Alternatively, an Alert test can be a Test for File Existence, which checks for the existence of a file that is accessible to the WebFOCUS Reporting Server to which the Alert test is submitted. The file does not need to be in the APP PATH. It just needs to be in a location where it can be found by the Reporting Server.

The Test for File Existence file does not need to be an actual file with an extension. Testing for the existence of a folder is also valid.

If the Alert test is triggered (true), returns records, the Alert result request is processed. You have the option of creating the result report or selecting an existing report stored in the WebFOCUS repository that you are authorized to run.

**Alerts Created in the Browser**

When you select a new Alert from the Home page, the WebFOCUS Alert Assist tool opens for the creation of components. Alert Assist is a Bindows™ application that is launched in a separate browser window.
The browser tab uses the generic name Alert\textit{n}, where \textit{n} is an index number starting at 1. All subsequent Alerts increase by 1. If you save the Alert, the dialog box is automatically set up with this generic name. However, you can change the name as desired.

If you select \textit{WebFOCUS Test} in the browser, you are prompted to create the Alert test using InfoAssist. The version of InfoAssist that is invoked does not have field styling, heading, footing, or report options. The Alert test determines whether or not a specified condition is true. It is not the report that is displayed as the result of the Alert.

You can create the Alert result using InfoAssist, this time with all the available styling and report options. Alternatively, you can select an existing report stored in the WebFOCUS repository that you are authorized to run.

\textbf{Note:} It is recommended that you select an existing report for the Alert result request, as it is available to edit, run interactively, or schedule independently of the Alert. If you create the Alert result using InfoAssist within Alert Assist, you need to use Alert Assist and select the open option again to edit the request, because the Alert test and the report to be run are contained within the Alert procedure.

\textit{Procedure:} \textbf{How to Launch WebFOCUS Alert Assist}


2. From the Home page, on the actions bar, click \textit{More}, and then click \textit{Alert}.

3. WebFOCUS Alert Assist opens.
Alert Assist Overview

When you create an Alert in the web browser, it invokes Alert Assist and then InfoAssist. Alert Assist has a user interface similar to InfoAssist. The following image shows the WebFOCUS Alert Assist interface.

Alert Assist Main Menu

In the upper-left corner of the browser window is the Application button, which provides access to the Alert Assist Main Menu. This menu contains the Save, Save As, Run, Close, and Exit options. Some of these options are also on the Alert Assist Quick Access toolbar.
The following image shows the expanded Alert Assist Main Menu.

### Save

Saves the Alert. This option is disabled until both parts of the Alert are created.

### Save As

Saves the current Alert with a new name. The Save As dialog box displays a field where you can type the new name. This option is disabled until both parts of the Alert are created.

### Run

Submits the Alert procedure to the Reporting Server. This option is active when both parts of the Alert have been created. The output always opens in a new browser.

### Close

Closes the current Alert and prompts you to save any changes.

### Exit

Exits the Alert Assist and prompts you to save any pending changes to the open Alert.
Alert Assist Quick Launch Toolbar

The Alert Assist Quick Launch toolbar contains the following buttons:

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Save Alert" /></td>
<td>Saves the Alert. This option is disabled until both parts of the Alert are created.</td>
</tr>
<tr>
<td><img src="image" alt="Revert Action" /></td>
<td>Reverts back by undoing one action.</td>
</tr>
<tr>
<td><img src="image" alt="Redo Action" /></td>
<td>Moves forward by redoing one action.</td>
</tr>
<tr>
<td><img src="image" alt="View Code" /></td>
<td>Displays the Alert procedure code in a read-only window.</td>
</tr>
<tr>
<td><img src="image" alt="Submit Alert" /></td>
<td>Submits the entire Alert procedure to the Reporting Server. This option is active when both parts of the Alert have been created. The output always opens in a new browser.</td>
</tr>
</tbody>
</table>

Ribbon

Under the Alert Assist Quick Access toolbar is a ribbon. When Alert Assist first opens, none of the ribbon options are activated.
You must select the Test node or Result node to activate the New option, as shown in the following image.

You must create a Test to activate the remaining options, as shown in the following image.
The ribbon contains the following options:

**Navigation Group**

**New**
Displays a menu from which you can choose to create a new WebFOCUS report or WebFOCUS test, open an existing report, or test for file existence. This button is active when the Test node or Result node is selected. You can also find these options in the shortcut menus for the Test node and Result node.

**Open**
Invokes InfoAssist so that you can make changes to the report when an Alert test or Alert result is selected. The Open option is only activated after a report test is created.

**Edit**
Opens the report on FILENAME data source dialog box when an Alert test or Alert result is selected. You can then edit the report in a text editor.

**Run**
Runs the report in a new browser window when an Alert test or Alert result is selected.

**Delete Group**

**Delete**
Removes the report from the Test or Result node.

**The Life of an Alert**
Authorized users can run an Alert test interactively and optionally schedule it to be distributed by ReportCaster.
The following image shows basic Alert processing.

1. Using Alert Assist or the Alert Wizard, you can create an Alert test and designs the report that is run if the Alert condition is true.

2. If the Alert test is true, the WebFOCUS Reporting Server runs the Alert result.

3. If the Alert test is false, the Alert result is not run.
The following image shows scheduled Alert processing.

1. Using Alert Assist or the Alert Wizard, you can create an Alert test and designs the report that is run if the Alert condition is true.

2. If desired, an Alert schedule is created using ReportCaster.


4. When the ReportCaster Distribution Server processes a scheduled Alert procedure, it is submitted to the Reporting Server to evaluate if the Alert test is true.
   a. If the Alert test is false, the Alert is returned to the queue for the next scheduled time.
   b. If the Alert test is true, the Reporting Server runs the Alert result and returns the results to the ReportCaster Distribution Server. The ReportCaster Distribution Server distributes the Alert result to the recipients, as specified in the schedule.

Creating and Scheduling an Alert

The following procedures describe how to create an Alert test, and Alert result using Alert Assist, and how to schedule an Alert with ReportCaster.
Procedure:  How to Create an Alert Test

1. In the Alert Assist main window, right-click the Test node, and then point to New, as shown in the following image.

2. Select one of the following options:

   - **WebFOCUS Test.** Allows you to create a new report in a scaled-down version of InfoAssist. Proceed to step 3.

   - **Test for File Existence.** Allows you to select an existing report. Proceed to step 6.

   **Note:** The scaled-down version of InfoAssist is used to create basic TABLE requests with HOLD (not PCHOLD FORMAT) statements. It generates procedure syntax that is written to the Alert the same way as in earlier WebFOCUS releases. The Edit option on the ribbon allows you to open the editor and manually enter the procedure code or edit existing procedure code. When the test is saved from the editor, the syntax needs to be validated as having an ON TABLE HOLD statement, a prerequisite for an Alert test.

3. When you select **WebFOCUS Test**, InfoAssist opens. Select a Master File from the Open dialog box.

4. Create your report as desired, and then save it.

5. Close InfoAssist to return to Alert Assist.

6. When you select **Test for File Existence**, type the full path to the file accessible to the Reporting Server that you want to check exists. Do not use a file name or folder path that includes spaces.
Testing a folder for existence is also valid. Type the full path to the folder accessible to the Reporting Server. If the file is located, the Alert is triggered (true) and the Alert result report is run.

7. Click OK to save the Alert test.

Procedure: How to Create an Alert Result

1. In the Alert Assist main window, right-click the Result node, point to New, and then point to New Report, as shown in the following image.

2. Select one of the following options:

   - **New Report.** Allows you to create a new report, chart, document, or dashboard, using the full version of InfoAssist. Proceed to step 3.

   - **Existing Report.** Allows you to choose from the existing reports in the tree. Proceed to step 5.

3. If you select New Report, the Open dialog box opens. Select a Master File.

   InfoAssist opens, and you can create the report that will be run when the Alert test is triggered (true).

4. Save your report, and close the InfoAssist window to return to Alert Assist. Proceed to step 9.
5. If you select Existing Report, the Open dialog box opens. Select a report you are authorized to run from the tree.

6. Click Open.

   The Open dialog box closes and the selected report appears under the Result node.

7. Select Save from the Alert Assist menu. The Save As dialog box opens.

8. Type the Alert Title, and click OK.

9. Close Alert Assist to return to the Home page.

   The Alert result is automatically run if the Alert test report is triggered (true). If you are authorized to schedule reports for distribution, you can optionally schedule the Alert.

   **Note:** As you use Alert Assist to create reports, you may see messages that state Report Saved. Your changes to the report have been saved, but they are not written to the WebFOCUS Repository until the Alert is saved. If you exit Alert Assist before you click Save in the Alert Assist menu, the Alert is not saved.

**Procedure: How to Schedule an Alert**

1. From the Home page, right-click the Alert and then point to Schedule, and choose either Email, Printer, or Repository.
The ReportCaster Basic Scheduling tool opens in a new browser window, as shown in the following image.

2. On the Distribution tab, specify the destination information for where you want the report to be distributed.

3. Click the Task tab, and then click Alert.

The Alert Options dialog box opens, as shown in the following image.
4. Select one of the following Alert Options:

- **Automatically Reset.** This option continues to run the schedule at the specified time and checks to confirm that the Alert test is no longer true before the Alert test is evaluated again. It is best to use this option when you do not want to receive the Alert result again until after the exception condition has been addressed and occurs again. For example, when the quantity in inventory is greater than 20,000, the Alert is triggered. You do not want to receive the report again until after the inventory is less than or equal to 20,000 for all products and then goes back over 20,000 again.

- **Continue After Alert.** This option continues to run the schedule at the specified time and distribute the report each time that the Alert test is true. It is best to use this option when you want to be notified at the interval specified in the schedule that the Alert test is true.

- **Deactivate Schedule After Alert.** This option deactivates the schedule after the Alert is triggered. The schedule has to be activated again for the Alert test to run after the Alert is triggered. It is best to use this option for one-time Alert tests. This is the default value.

- **Delay.** This option is best used when you want to allow a specific period of time to address the Alert test but want to be notified again if the Alert test has not been met. You can restart the Alert after a maximum of 99 hours, days, weeks, months, or years.

As you complete the creation of the schedule, remember to consider the burst option to distribute specific report values, instead of the entire report. When a report is burst, the distribution information must be provided in a distribution list for email distribution. The email distribution option is the most effective for Alert reports because of the push versus pull notification through email.

5. Select the *Properties* tab and type a title and summary for the scheduled report.

6. Click the *Recurrence* tab and specify when and how often to run the schedule.

7. If you wish to receive notifications of the Alert distribution, click the *Notification* tab and specify the destination information for where you want the notification to be sent.

8. Click *Save* and close the ReportCaster Basic Scheduling tool.

   The schedule report now appears in the repository, and you can access it from the Home page.
Checking Scheduled Alerts

When an Alert test is false (and therefore not activated), the Alert result report is not run. When an Alert schedule runs, information about the Alert test evaluation (true or false) and any error or warning messages that occur during schedule or Alert processing are written to the log file.

In order to track the completion of a scheduled Alert, or errors that occurred during processing without checking the log report for the Alert schedule, we recommend that you use the Schedule Notification option.

In the Scheduling tool, the Notification tab allows you to specify:

- The terms for supplying notification (Never, which is the default value, Always, or On Error).
- The level of detail in the notification (full notification or brief notification).
- The email addresses to distribute the notification information to.

Using Sample Data to Create and Schedule an Alert

A data-driven Alert is an event that is prompted by a guideline that you define. This guideline can vary from the simple to the complex. The following tutorial describes how to create a simple Alert that is triggered when the cost of goods exceeds the revenue for a brand. This type of Alert could help a company decide whether they should continue to carry a specific brand, based on the money loss throughout a given timeframe.

To follow this tutorial, you must have access to the WebFOCUS Retail sample data source.

**Example:**  **Creating and Scheduling an Alert**


2. From the Home page, on the actions bar, click More, and then click Alert.
The Alert Assist tool opens in a new browser window, as shown in the following image.

3. Click the Test node.

4. On the Home tab, in the Navigation group, click New, and then click WebFOCUS Test.

   WebFOCUS InfoAssist opens.

5. From the Open dialog box, choose the wf_retail Master file.

6. Add the following fields to your report:

   - Product Category
   - Brand
   - Cost of Goods
   - Revenue

   Before you complete your report, you must add the Where condition that defines the criteria that you want to be met.

7. On the Data tab, in the Filter group, click Filter.

   The Create a filtering condition dialog box opens.

8. Double-click the Double-click or press F2 to edit! text.

   The drop-down menus for Fields and Subqueries, Operators, and Values open.
9. Make the following selections:

- In the Field drop-down menu, click *Cost of Goods*.
- In the Operators drop-down menu, click *Greater than*.
- In the Value drop-down menu, click *Field*, and then select *Revenue*.

The following image shows the finished Where condition.

10. Click OK.

11. Save your report and close InfoAssist.

Your report now shows under the Test node in the Alert Assist browser window.

12. Click the *Result* node. On the *Home* tab, in the *Navigation* group, point to *New*, point to *New Report*, and then click *Report*.

WebFOCUS InfoAssist opens.

Since your Alert Test is checking for revenue loss, in this tutorial you want the final report to have a field that highlights the loss. This field is not available by default. You can create it.

13. From the Open dialog box, choose the `wf_retail` Master file.

14. On the *Data* tab, in the *Calculation* group, click *Detail*.

The Detail Field (Define) dialog box opens.

15. In the Field input box, type *Loss*.

16. In the expressions field, create the following expression, as shown in the image below:
"Revenue" - "Cost of Goods"

You can type the expression directly into the expression field or choose the fields from the data tree.

17. Click OK.

The Data pane refreshes and now displays the new field, Loss.

18. Add the following fields to your report:

- Brand
- Quantity,Sold
- Loss
- Sale,Quarter

To ensure that the Alert Result generates the correct report when the test criteria is met, you must add the same Where condition as the one you added to the Alert Test.

19. Repeat steps 8-11 to add the Where condition.

You can style the report that gets distributed by adding a header.


The Header & Footer dialog box opens.
21. Type **Brand Revenue Loss 2018**.

22. Click OK.

23. Save your report, and close InfoAssist.

   Once both Test and Result are completed, you can save the Alert procedure.

24. In the Alert Assist browser window, click the Save button.

   The Save As dialog box opens.

25. In the Title field, type **Brand Revenue Loss Alerts**, and then click Save.

   Your new Alert now displays in the Home page and can be scheduled.

   You can schedule the report to be distributed through email, repository, or sent directly to a printer. In this tutorial, you want a monthly email to be sent.

26. From the Home page, right-click the Alert that you created, point to Schedule, and then click Email.

   The ReportCaster Basic Scheduling tool opens, as shown in the following image.

27. Click the Task tab, and under the Scheduling Object area, click Alert.

   The Alert Options dialog box opens.
28. Click **Continue After Alert** and then click **OK**.

This means that the schedule continues to run at the specified time and distribute the report each time that the Alert test is true. Other options include Automatically Reset, Deactivate Schedule After Alert, and Delay.

29. Click **Properties**.

30. In the Summary area, type **This Alert procedure monitors the revenue loss by brand**.

31. Click **Recurrence**. In this example, you want to schedule the Alert procedure to run monthly on the last day of every month, as shown in the following image.

32. Click **Distribution**.

33. Complete the **To**, **From**, and **Reply Address** fields with the email addresses. In this tutorial, you can use your own email address to test the Alert. In the Subject field, type **Brand Revenue Loss Alerts**.
The following image shows an example of the Distribution tab.

Additionally, you can set notifications of the Alert distribution. Click Notification and fill in the fields, as required.

34. Click Save.

The Save As dialog box opens.

35. In the Title field, type Brand Revenue Loss Alert Schedule and click OK.

The Alert Schedule now displays in the Home page.

36. Close the ReportCaster Basic Scheduling Tool.

37. To test the Alert, before it is scheduled to run, right-click the Alert Schedule, and then click Run.

A prompt will ask you if you want to run the schedule.

38. Click OK.

The email addresses that you identified earlier will receive the Alert Report, shortly.
The following images show examples of the Alert email and Alert report.

Creating Reporting Objects

With WebFOCUS Managed Reporting, a developer can easily transform complex views of data into simple objects labeled with common business terminology that every user can understand, such as Weekly Sales or Revenue. Developers or Managers create Reporting Objects that present available data using terms and formats meaningful to users. Users can then use Reporting Objects as templates for the creation of a wide range of reports and charts.

This topic describes Reporting Objects and how you can use them in WebFOCUS.
Reporting Object Tool

Reporting Objects are stored in folders in the tree within domain folders under the Content folder. They can include selection criteria (WHEREs), JOINs, virtual fields (DEFINEs), filters, and other WebFOCUS statements, as well as reports or charts supplied as templates.

**Note:** A Reporting Object will not show in the repository when the user cannot functionally use the Reporting Object.

The browser Reporting Object tool allows you to create, edit, test, run, or delete a Reporting Object or its components. The main interface, as shown in the following image, consists of a static Quick Launch toolbar, a ribbon of context-sensitive options, and a window that displays the components of the Reporting Object with which you are working.

![Reporting Object Tool](image)

**Reference:** Reporting Object Tool Quick Launch Toolbar

The Reporting Object tool Quick Launch toolbar is a static menu whose commands apply to the entire Reporting Object, not simply to the particular component that you have selected. The following table describes each command in the Reporting Object tool Quick Launch toolbar.
<table>
<thead>
<tr>
<th>Button</th>
<th>Shortcut Keys</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="RO.png" alt="Reporting Object" /></td>
<td>None</td>
<td>Reporting Object tool main menu</td>
<td>Launches a menu allowing you to Save, Save As, Run, and Exit.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+S</td>
<td>Save</td>
<td>Saves the Reporting Object.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Z</td>
<td>Undo</td>
<td>Undoes the last action.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+Y</td>
<td>Redo</td>
<td>Repeats the last action.</td>
</tr>
<tr>
<td></td>
<td>None</td>
<td>View code</td>
<td>Displays Reporting Object code in a read-only window.</td>
</tr>
<tr>
<td></td>
<td>Ctrl+R</td>
<td>Run</td>
<td>Runs the Reporting Object.</td>
</tr>
</tbody>
</table>

**Reference:** Reporting Object Tool Ribbon

The Reporting Object tool ribbon is a menu whose commands apply to what you have selected, whether that is the Reporting Object as a whole, a particular component, or an individual example of a component. For example, a particular filter or filter group, if you have selected one, rather than selecting the entire Filter component.

The following table describes each command on the Reporting Object tool ribbon.
<table>
<thead>
<tr>
<th>Button</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="New.png" alt="New" /></td>
<td>New</td>
<td>Creates a new join, DEFINE statement, filter, or WHERE statement.</td>
</tr>
<tr>
<td><img src="Open.png" alt="Open" /></td>
<td>Open</td>
<td>Launches InfoAssist to create or edit a report or chart, or launches the appropriate tool to create or edit a join, DEFINE statement, filter, or WHERE statement.</td>
</tr>
<tr>
<td><img src="Edit.png" alt="Edit" /></td>
<td>Edit</td>
<td>Opens component source code in the text editor.</td>
</tr>
<tr>
<td><img src="Properties.png" alt="Properties" /></td>
<td>Properties</td>
<td>Renames the selected filter or filter group.</td>
</tr>
<tr>
<td><img src="Run.png" alt="Run" /></td>
<td>Run</td>
<td>Runs the selected component.</td>
</tr>
<tr>
<td><img src="Delete.png" alt="Delete" /></td>
<td>Delete</td>
<td>Deletes the selected item.</td>
</tr>
<tr>
<td>Button</td>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Delete All]</td>
<td>Delete All</td>
<td>Deletes all items of the type selected, for example, all WHERE statements, all filters in a particular group, or all filters in every group if the Filter component itself is selected.</td>
</tr>
</tbody>
</table>

**Procedure:** How to Create a Reporting Object


2. From the Home page, on the actions bar, click More, and then click Reporting Object.
   The Open dialog box opens, prompting you to select a Master File.

3. Select a Master File and click OK.
   The Reporting Object tool appears.

**Procedure:** How to Edit a Reporting Object

Right-click the Reporting Object and select Edit.

**Note:** Double-clicking the Reporting Object runs the Reporting Object rather than allowing you to edit it.

**Procedure:** How to Save a Reporting Object

1. Press Ctrl+S or click the Save icon on the Quick Launch toolbar.
   The Save dialog box opens.

2. Type the name of the new Reporting Object in the Title field and click OK.
   From now on, clicking Save or pressing Ctrl+S saves the Reporting Object without launching the Save dialog box.

**Running a Reporting Object From the Browser**

You can run a Reporting Object or any individual component of it from the browser. You can run a Reporting Object in the following ways:

- Select the object in the Reporting Object tool and click Run, or right-click the object and click Run.
Right-click the Reporting Object on the Home page and select Run, or point to Run and click Run in new window or Run Deferred.

The Run option in the Reporting Object tool is enabled regardless of the setting of the Only Run as a Deferred Report property.

**Expected Behavior of Running a Reporting Object**

When you select and run a Reporting Object, the expected behavior is as follows:

- When you define a Report or Chart component, all components of the Reporting Object run.
- When you define a Report and Chart component, an HTML page opens, which enables you to select which component to run.
- When you define filters in a Reporting Object, an HTML page opens, which enables you to select from the defined filters of the Reporting Object.
- When you define parameters in a report or chart and the Reporting Object Prompt for Parameters property is specified, an HTML page opens, which prompts you for parameter values.
- Reporting Object components are validated prior to run time. This means that errors are found and corrected more easily, since errors in individual components are detected prior to run time.
- If you attempt to run a Reporting Object that is created without using the Report or Chart component, you receive the message:

  *Your request did not return any output to display.*

  **Possible causes:**
  - No data rows matched the specified selection criteria.
  - Output was directed to a destination such as a file or printer.
  - An error occurred during the parsing or running of the request.

**Properties of a Reporting Object**

From the WebFOCUS Home page, you can view or edit the properties of a Reporting Object by right-clicking the object and selecting *Properties*. The Reporting Object Properties dialog box opens.
Components of a Reporting Object

A Reporting Object may contain any of the following types of components, which are run in the order of precedence, as listed:

- Preprocessing Other (custom code that runs before all other components)
- Joins
- DEFINE statements
- Filters, when applicable
- WHERE statements
- Report or chart templates
- Postprocessing Other (custom code that runs after all other components)

Users using the Reporting Object to create a report do not see the DEFINE statements, WHERE statements, or JOIN commands defined in the Reporting Object, which are issued automatically every time a user accesses the Reporting Object. However, the report or chart components, including headers, footers, and styling features, are visible to authorized users who can use them to create their own customized report.

The filters defined in the Filter component are applied only if the user of the Reporting Object activates them when the report or chart based on the Reporting Object is run.

Preprocessing Other Component

The Preprocessing Other component contains custom code that must run before all other components. You can use the text editor in the component to create and edit code or to paste the code that you have copied from another application.

To create or edit a Preprocessing Other component, do one of the following:

- Double-click the component.
- Select the component and click Edit on the ribbon.
- Right-click the component and select Edit.

The Preprocessing Other text editor appears.

Note:

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.
Commands in the Preprocessing Other component should not return a displayable answer set.

Reference: Considerations for Amper Auto Prompting With the Preprocessing and Postprocessing Other Components

When using Amper Auto prompting, users may be prompted to supply amper variable values for parameters that the private user content does not reference. These scenarios are directly related to the internal processing of reports created using a Reporting Object.

Auto prompting considerations and expected behavior must be understood when referencing amper variables within a Reporting Object. For information on the Amper Auto prompting facility, see Using Filters to Customize the Display of Data and Creating Reports on page 23. The specification of values for the amper variables in the Reporting Object Other component using –DEFAULT, –DEFAULTH, or –SET commands will assign a default value for amper variables in a report request to avoid a FOC error for not specifying a value. A consideration for –DEFAULTH and –SET is that Amper Auto prompting does not prompt for amper variables that have values assigned using –DEFAULTH and –SET.

Whether a user is prompted by the Amper Auto prompting facility for amper variables assigned a default value using the –DEFAULT command is dependent on the setting of the WebFOCUS Client configuration parameter, IBIMR_prompting. When IBIMR_prompting is set to XMLPROMPT, users are prompted for amper variable values, and default values are displayed in fields in which the default values have been specified. When IBIMR_prompting is set to XMLRUN, users are not prompted for values when all amper variables have been assigned a default value. For more information on setting the IBIMR_prompting parameter, see Changing Application Settings.

Reference: Creating a Reporting Object That Uses a HOLD File

Suppose that your company has a data warehouse and you need a Reporting Object that uses an extract from that data warehouse. In your Preprocessing Other component, you create a HOLD file from the data warehouse, and then you use that HOLD file in each Reporting Object component. You can clear the JOIN command and delete the HOLD file in the Postprocessing Other component so that it is not mistakenly used again the next time that the Reporting Object is used.

This task has the following steps:

1. Create a HOLD file in the Preprocessing Other component.
2. Create a new Join component with two joins.
3. Use the Report component to create a new report in InfoAssist.
4. Clear the JOIN command and delete the HOLD file in the Postprocessing Other component.
5. Run the Reporting Object, and then view the object source to verify that the output is correct.
6. Verify that the HOLD file does not exist in the location in which it was created.

**Example:** Creating a HOLD File With the Preprocessing Other Component

1. Create a Reporting Object with wf_retail_lite as the Master Filer.
2. Select the Preprocessing Other component and click *Edit*.
3. Type the following code:

   ```
   TABLE FILE retail_samples/wf_retail_lite
   PRINT WF_RETAIL_LITE.WF_RETAIL_SALES.COGS_US
   WF_RETAIL_LITE.WF_RETAIL_SALES.QUANTITY_SOLD
   WF_RETAIL_LITE.WF_RETAIL_SALES.REVENUE_US
   BY WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_YEAR
   BY WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_MTH
   BY WF_RETAIL_LITE.WF_RETAIL_SALES.ID_SALES
   BY WF_RETAIL_LITE.WF_RETAIL_PRODUCT.MODEL
   WHERE WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_YEAR EQ 2018;
   WHERE WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_QTR EQ 1;
   ON TABLE HOLD AS baseapp/Extract01 FORMAT BINARY
   END
   ```

4. Click Save, and then close the text editor.
5. To verify that the component works properly, select the Preprocessing Other component and click *Run*.

   The following output is produced:
   
   ```
   0 NUMBER OF RECORDS IN TABLE=  251081  LINES=  251081
   ```

**Joins**

A join is a temporary connection between two or more data sources that share at least one common field. After you join two data sources, each time that WebFOCUS retrieves a record from the first data source (the host file), it also retrieves the matching records from the second data source (the target file).

For more information on joining data sources, see *Joining and Blending Data*.
Note:

- When you join two FOCUS data sources, the target file field must be indexed or the join must be a WHERE-based join. If you attempt to link to a non-indexed target file, the Reporting Object tool offers you the opportunity to create a WHERE-based join. For more information on creating WHERE-based joins, see *Joining and Blending Data*.

- Since every procedure creates a new session on the Reporting Server when it is run, the duration of your connection is always limited to a single procedure. Therefore, any join issued at the beginning of a procedure is in effect only for those report requests that are called in the same procedure.

**Procedure:** How to Create a Join

1. Right-click the *Joins* component and select *New*, or select the *Join* component and click *New* on the ribbon.

   The Join tool opens, displaying the data source associated with the Reporting Object.

2. Create a join using the Join tool.

   For more information on using the Join tool, see *Joining and Blending Data*.

3. When you are finished, click *OK* to return to the Reporting Object tool.

**Procedure:** How to Delete a Join

To delete a join, right-click the join and select *Delete*, or select the join and click *Delete* on the Quick Launch toolbar.

**Procedure:** How to Rename a Join

1. In the Join tool, select a join by clicking its connector line, and then click *Edit* on the Join toolbar.

   The Edit Join dialog box opens.

2. Type a new description in the Description box and click *OK* to return to the Join tool.

   The new description appears under the Join component in the Reporting Object tool. The internal name used for the join remains the same name assigned to the join when you created it.

   **Note:** The Description field is limited to 8 characters.
Procedure: How to View or Edit Join Syntax in a Text Editor

1. Select the join and click Edit on the ribbon, or right-click the join and select Edit.
   The join code is displayed in a text editor.

2. Make the desired changes and click Save to return to the Reporting Object tool. To exit without making any changes, click Close.

Virtual Fields (DEFINE Statements)

A virtual field is a field whose value is not stored in the data source but can be calculated from the data that is there. A virtual field takes up no storage space. It is created only when a user accesses the Reporting Object that includes the virtual field.

You use the Define tool to create a virtual field. Using this tool, you specify the virtual field name and format, and the expression that defines the field. An expression enables you to combine fields, constants, predefined functions, and operators into an operation that produces a single value. When you define a virtual field, you must specify a field format type, length, and appropriate display options.

For more information about defining fields, see Creating Virtual Fields.

Procedure: How to Create a Virtual Field

1. Right-click the Defines component and select New, or select the Define component and click New on the ribbon.
The Define tool dialog box opens, as shown in the following image.

2. Create a virtual field using the Define tool.
   For more information about the Define tool, see .

3. Click OK to save the virtual field and return to the Reporting Object tool.
   The virtual field now appears in the field list when a user accesses this Reporting Object.

**Note:**

- The field list shown in the Define tool is not updated to display new virtual fields until you exit from the Define tool and reopen it. If you are creating a virtual field (DEFINE statement) that uses a previously created virtual field in the expression, you must save the first virtual field before creating the second one.

To save the first virtual field, exit from the Define tool by clicking OK. Reopen the Define tool to create the second field. Alternatively, you can type the name of the first virtual field in the expression instead of selecting it from the field list. In this case, you do not need to exit and reopen the Define tool.

- Since every procedure creates a new session on the Reporting Server when it is run, the duration of your connection is always limited to a single procedure. Therefore, any DEFINE statements issued at the beginning of a procedure are in effect only for those report requests that are called in the same procedure.
Procedure: How to Edit a Virtual Field

Existing virtual fields appear under the Defines node, as shown in the following image.

1. Right-click the virtual field that you want to edit and select Open, or select the virtual field and click Open on the ribbon.

   The Define tool dialog box opens, displaying the selected field.

2. Make changes to the field name, expression, or format, and click OK to return to the Reporting Object tool.

Procedure: How to View or Edit a Virtual Field in the Text Editor

1. Right-click the virtual field that you want to view or edit as text and select Edit, or select the virtual field and click Edit on the ribbon.

   The Text Editor opens, displaying the selected field.

2. Make changes to the field name, expression, or format, and click OK to return to the Reporting Object tool.

Procedure: How to Delete a Virtual Field

1. Right-click the virtual field that you want to delete and select Delete, or select the virtual field and click Delete on the ribbon.

2. To delete all virtual fields at once, right-click the Defines component and select Delete All, or select the component and click Delete All on the ribbon.

Filters

Filters enable users to quickly select predefined criteria that limit the data included in a report or chart. Filters are selection criteria (WHERE statements) that you create for users, who then select the filters needed to limit the data in a report or chart without having to create their own selection criteria.
In order to create a filter, you must create the filter group and define the filters that make up the group.

**Note:** The Undo and Redo functions are not available for the Filter component until you have created at least one filter.

For more information about filters, see *Using Filters to Customize the Display of Data*.

**Procedure:** How to Create a Filter Group

1. Right-click the *Filters* component and select *New*, or select the *Filter* component and click *New* on the ribbon.
   
   The Reporting Object Filter Group dialog box opens.

2. In the Filter Group Name field, type a descriptive name for the filter group folder.
   
   Make the filter group name as explicit as possible, because users depend on this name to select the correct filter to apply to their reports.

3. Click *OK*.
   
   You are returned to the Reporting Object tool. The filter group folder appears below the Filter component node.

**Procedure:** How to Define a Filter

1. Right-click the Filter group to which you would like to add a filter and select *New*, or select the Filter group folder and click *New* on the Quick Launch toolbar.
   
   The Reporting Object Filter dialog box opens.

2. In the Filter Name field, type a descriptive name for the filter and click *Add New* if you plan to create multiple filters, or click *OK* if you plan to create only one filter.
   
   Make the filter names as explicit as possible, because users depend on these names to select the correct filter to apply to their reports.
The Advanced Filter dialog box opens, as shown in the following image.

3. Use the Advanced Filter dialog box to create the filter.
   For more information about defining filters, see Using Filters to Customize the Display of Data.
4. When you have created the filter, click OK.
   If you clicked Add new in step 2, the New Filter dialog box opens. If you clicked OK in step 2, you are returned to the Reporting Object tool.

**Procedure: How to Edit a Filter**

Existing filters appear under the Filter group beneath the Filters node, as shown in the following image.

1. Right-click the filter that you want to edit and select Open, or select the filter and click Open on the ribbon.
   The Advanced Filter dialog box opens, displaying the selected filter.
2. Make your changes and click OK to return to the Reporting Object tool.

**Procedure: How to Rename a Filter or Filter Group**
1. Right-click the filter or filter group that you want to rename and select Properties, or select the filter or filter group and click Properties on the ribbon.
2. Type the new filter or filter group name in place of the current one and click OK.

**Procedure: How to Delete a Filter or a Filter Group**
1. Right-click the filter or filter group that you want to delete and select Delete, or select the filter or filter group and click Delete on the ribbon.
2. To delete all filters at once, right-click the Filter component and select Delete All, or select the component and click Delete All on the ribbon.

**Procedure: How to View or Edit a Filter in the Text Editor**
1. Right-click the filter that you want to view or edit as text and select Edit, or select the filter and click Edit on the ribbon.
   - The text editor opens, displaying the selected filter.
2. Make your changes and click OK to return to the Reporting Object tool.

**Reference: Filter Considerations With Amper Auto Prompting**
When Amper Auto prompting is used (Prompt for Parameters is selected in the Advanced tab of the Reporting Object properties), there are scenarios in which users are prompted to provide amper variable values in selection criteria (WHERE statements) in the Reporting Object that the user did not save with the report. This is due to the internal processing of reports created from Reporting Objects. You can avoid this issue by using the Filter component to predefine selection criteria for users to include in reports. Only the filter or filters that users select for inclusion in their reports are evaluated by the WebFOCUS Amper Auto prompting facility.

**Selection Criteria (WHERE Statements)**
WHERE statements or selection criteria, restrict the data retrieved to only those records that meet the conditions that you specify. Filters are selection criteria that run when the user selects the filter in WebFOCUS. Other selection criteria run when the user opens the Reporting Object, preventing data values that do not meet the criteria from being available to the user.

**Procedure: How to Create Selection Criteria**
1. Right-click the Where Statements component and select New, or select the component and click New on the ribbon.
The New Filter dialog box opens.

2. Double-click the red text or press F12 to edit the WHERE statement.
   
   For more information on creating selection criteria, see Using Filters to Customize the Display of Data.

3. When you have created the selection criterion, click OK to return to the Reporting Object tool.

**Report Component**

The Report component creates a report template and saves it in a Reporting Object. The report template is used when a new report is created off the Reporting Object.

To create a report template, double-click the Report component, or right-click the component and select Open. InfoAssist opens, allowing you to create a report template.

**Note:**

- To open the report source code in the text editor instead of InfoAssist, right-click the Report component and select Edit. Manual changes to the code may make the report incompatible with InfoAssist.

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.

- If the Reporting Object contains both a report and a chart, the user is asked whether to run the object as a report or chart. The Reporting Object cannot be run simultaneously as both.

- When Amper Auto prompting is used (Prompt for Parameters is selected in the Advanced tab of the Reporting Objects properties), there are scenarios in which users are prompted to provide amper variable values in selection criteria (WHERE statements) in the Reporting Object that the user did not save with the report. This is due to the internal processing of reports created from Reporting Objects. You can avoid this issue by using the Filter component to predefine selection criteria for users to include in reports. Only the filter or filters that users select for inclusion in their reports are evaluated by the WebFOCUS Amper Auto prompting facility.

**Chart Component**

The Chart component works exactly like the Report component. The Chart component creates a chart template and saves it in a Reporting Object. Authorized users can use the chart template to create a chart that suits their needs and then save the new chart.
To create a chart template, double-click the Chart component, or right-click the component and select Open. InfoAssist opens, allowing you to create a chart template.

For more information on using InfoAssist, see the WebFOCUS InfoAssist User's Manual.

**Note:**

- To open the chart source code in the text editor instead of InfoAssist, right-click the Chart component and select Edit. Manual changes to the code may make the chart incompatible with InfoAssist.

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.

- If the Reporting Object contains both a report and a chart, the user is asked whether to run the object as a report or chart. The Reporting Object cannot be run simultaneously as both.

- When Amper Auto prompting is used (Prompt for Parameters is selected in the Advanced tab of the Reporting Object properties), there are scenarios in which users are prompted to provide amper variable values in selection criteria (WHERE statements) in the Reporting Object that the user did not save with the report. This is due to the internal processing of private reports created from Reporting Objects. You can avoid this issue by using the Filter component to predefine selection criteria for users to include in reports. Only the filter or filters that users select for inclusion in their reports are evaluated by the WebFOCUS Amper Auto prompting facility.

### Postprocessing Other Component

The Postprocessing Other component contains custom code that must run after all other components. You can use the text editor in the component to create and edit code, or to paste the code that you have copied from another application.

To create or edit a Postprocessing Other component, double-click the component, or select the component and click Edit on the ribbon. Alternatively, right-click the component and select Edit. The Postprocessing Other dialog box opens.

**Note:**

- Syntax and error checking is not performed on the commands that you type until the Reporting Object is run.

- Commands in the Postprocessing Other component should not return a displayable answer set.
Creating Shortcuts and URLs

The use of shortcuts and URLs can simplify workflow and provide additional context to your analytics. The following sections explain how to use shortcuts and URLs and describe how to create these content items in your repository.

Creating Shortcuts

You can create shortcuts to repository files and Master files. Once a shortcut to a Master file is created, you can use it to build visualizations and reports. Once a shortcut to a repository file is created, you can copy, delete, edit, and run this item. You can also publish and share your shortcuts to make them available for other users and groups.

Procedure: How to Create a Shortcut to a Repository File

1. Select the domain or folder where you want your new shortcut to reside.

2. On the actions bar, click Shortcut.

   The New Shortcut dialog box opens.

3. Click Browse.

   The Select dialog box opens.

4. Using the Breadcrumb Trail, navigate to the resource of your choice, such as folder, report, chart, or visualization, and then click Select.

   The Title field populates with the name of the original item, and the word Shortcut. For example, if you create a shortcut to the item Chart1, the shortcut title will be Chart1 - Shortcut.

5. Optionally, you can edit the Title and populate the Summary field.

6. Click OK.

   The new shortcut appears in the selected location.

Procedure: How to Create a Shortcut To a Master File

1. Select the domain or folder where you want your new shortcut to reside.

2. On the actions bar, click Shortcut.

   The New Shortcut dialog box opens.
3. Click the Master File radio button, as shown in the following image.

4. Click Browse.

   The Select dialog box opens.

5. Navigate to the Master file you want to create a shortcut, and then click Select.

   The Title field populates with the name of the original item.

6. Optionally, edit the Title and populate the Summary field.

7. Click OK.

   The new shortcut appears in the selected directory.

---

**Creating URLs**

You can create URLs to webpages and store them within the repository. These URLs can further enhance analytics, by providing an additional interactive context to your data. You can run a URL from the Home page, use it in a portal, or add it to a personal page. If your URL is optimized for use in an iFrame, you can embed it within a container on a page. You can also publish and share a URL to make it available to other users and groups.

**Procedure:** How to Create a URL

1. Select the domain or folder where you want your new URL to reside.

2. On the actions bar, click URL.
The New URL dialog box opens.

3. Type a Title for the URL, type the address of the URL, and then click **OK**.

The URL now appears in your selected location.

**Procedure**: **How to Embed an iFrame-Optimized URL in a Portal or Page**

1. Copy an iFrame-optimized URL from the web, as shown in the following image.

2. Select the domain or folder where you want your new URL to reside.

3. On the actions bar, click **URL**.

The New URL dialog box opens.

4. Populate the Title field, and paste the copied URL in the URL field.
5. Remove any iFrame-related syntax that surrounds your URL. An example of these are shown in the following images.

![URL example 1](image1)

![URL example 2](image2)

6. Click OK to close the New URL dialog box.

Your URL item is complete and ready to be displayed in a portal or page.

7. Using WebFOCUS Designer or the Portal Designer, add your new URL to a portal or page.

The URL content displays within the container, similar to other content items, as shown in the following image.

![Portal Design Example](image3)

### Creating Blogs

You can create blogs and include them in your collaborative portals. A blog is an interactive content item that operates as commonly seen blogs on the internet, and allows users to post and view comments. Blogs abide by the same security rules that apply to other items in the repository. You can publish, unpublish, hide, and move blogs between domains or folders. You can also share blogs with other users and groups.

**Procedure: How to Create a Blog**

1. Select the domain or folder where you want your new blog to reside.

2. On the actions bar, click **Blog**.

Information Builders
The New Blog dialog box opens.

3. Type the requested information in the dialog box, as follows.
   - **Title.** Identifies the blog in the content area.
   - **Summary.** Provides an optional explanation of the blog. It is displayed in the tool tip, when you hover over the blog.

4. Click OK.
   The new blog item appears in the selected location.

5. Right-click your new blog, and then click **Edit.**
   The Comments window opens.

6. Click the **Add comment** link to add a new comment.

7. Once you are done adding and editing comments, click **Post,** and close the Comments window.

8. You can optionally interact with comments using the following commands:
   - Click the **Refresh** icon to refresh comments.
   - Click the **Search** button, and type a key word or words in the search field, to search through comments. You can specify the search criteria by clicking the drop-down arrow and selecting search criteria, such as user name, content, or meta tags. Click the Search button again to close the search field.
   - Click the **Remove All** button to remove all comments from all users. Remove All is only available to users with the Manage Comments privilege.

You can now publish, share, and add your blog to a portal page or portal.

**Working With Portal Pages**

Portal pages are a vital part of the Business User Edition portal architecture. Depending on the type of a page, the Business User Edition portal allows different levels of versatility in the way you organize, share, and interact with it.
There are three types of pages in a portal. These include:

- **Base Portal Page.** Created in the Page Designer and added to the Business User Edition portal by a manager or developer. If a base portal page is created with the Lock Page property off, users can customize it at run time. If the user removes customizations, all changes made by the user are removed, and the base portal page reverts to its default state.

- **Personal Portal Page.** Added to the Business User Edition portal at run time by the user. Personal portal pages are stored in the repository but they are not visible in the Resources tree. Personal portal pages are only visible to the user that has created them.

- **Domain Portal Page.** Created with the Page Designer directly in a domain or folder. A domain page can be copied or added to a portal, in which case it becomes a base portal page. If a page is removed from a portal, it becomes a stand-alone domain portal page and can be edited, moved, unpublished, or hidden.

**Note:** To avoid unwanted behaviors, you should not edit base portal pages in the Page Designer, or move or hide base portal pages in the repository, while users are running these pages in the Business User Edition portal. If you need to edit a base portal page, remove it from the Business User Edition portal, and unpublish it before you begin editing.

### Page Designer Overview

The Page Designer allows you to create domain portal pages inside domains and folders of your choice. This section explains how to use the Page Designer to create a domain portal page. It also describes the different components of the Page Designer interface.

**Procedure:** How to Use the Page Designer to Create a Domain Portal Page

1. On the Home page, in the Resources tree, select a domain or folder where you want to create the page, and then click **Portal Page**.

   The Page Designer opens, and the Add Page dialog box opens inside the Page Designer.

2. Select a page template and, optionally, edit the Title and Name fields.

3. Click **Create**.

   The page displays in the Page Designer.

4. Optionally add content to the page.

   If left blank, panels behave like Easy Selector containers at run time. To learn more about the Easy Selector, see *Using the Easy Selector*.

5. Optionally, unlock the page to allow run time edits. Clear the **Lock Page** check box in the Properties panel.
**Note:** The *Lock Page* option is enabled, by default.

6. Save and close the Page Designer.

A new domain portal page is created and now appears inside the selected domain or folder. It is ready to be added to the portal.

For more information, see *Working With the Business User Edition Portal* on page 313.

**Page Designer Interface**

The following image shows the Page Designer, and the Add Page dialog box.

The Page Designer contains the following components, located from the top of the interface to the bottom:

- Page Templates
- Application menu
- Quick Access Toolbar
- Ribbon
- Canvas
- Properties panel
- Breadcrumb trail

The components are described in the following topics.
Page Templates

Page templates provide a quick way of creating page layouts. When you create a new domain page, the Add Page dialog box opens and displays layout presets that you can choose before adding any content.

**Note:** Page templates are only available for domain pages.

The Add Page window is shown in the following image.

![Add Page Window](image)

The Add Page window contains the following options:

- **Page Templates.** Contains custom and default page templates. Each template is accompanied by a thumbnail, which allows you to preview the layout. The default templates are:
  - 1 Column
  - 2 Column
  - 3 Column
  - 4 Column
  - Fluid Canvas
  - Responsive 2-2
  - Responsive 3-2-2
Responsive 3-3
Responsive 3-3-3
Responsive 4-2
Responsive 4-2-2
Responsive 4-4-2
Single Area

New Page Information. Provides access to the following options:

- **Title.** Identifies the title of the portal page. The default title matches the name of the selected page template.

- **Name.** Identifies the name of the portal page. The default name matches the name of the selected page template.

- **Location.** Changes the location of the portal page in the repository. To change the location, click *Change Location* and navigate to a different domain or folder.

Copy Existing Page. Creates a copy of an existing page in the repository.

Application Menu

The Application button, represented by the BIP icon, opens the Application menu of options. From this menu, you can create a new portal page, open an existing portal page, save the page, or exit the Page Designer.

From the Application menu you can perform the following actions:

- **New Page.** Creates a new portal page.

- **Open Page.** Open an existing portal page in the Page Designer.

- **Save.** Saves the current page.

- **Save As.** Saves the current page as under a different name or location.

- **Exit.** Closes the Page Designer.

Quick Access Toolbar

You can use the Quick Access Toolbar to save your changes to the current portal page.
Ribbon

In the Page Designer, you can use the ribbon to access commands to edit your portal pages and add content. You can also hide the ribbon to maximize space, or launch the online Help content.

The Page Designer ribbon contains the following three tabs:

- **Layout.** Specifies the theme and layout settings.
- **Insert.** Inserts content into the page.
- **Style.** Applies styles to common properties, such as background, border, and font.

Layout Tab

The following image shows the Layout tab, which contains the Preview and Page groups. You can use the options in these groups to modify the theme of your portal page, or to change the layout of your canvas.

![Layout Tab Image](image)

Preview Group

The Preview group contains a single Theme option that launches a menu from which you can customize the theme of your portal page. This includes the following:

- **Portal Theme Files Browser.** Configures CSS files, by applying a predefined theme. You can also create a custom theme. The default theme is Neutral.

- **CSS Editor.** Edits specific components of the existing CSS theme.
Page Group

The Page group contains a single Layout option that launches a menu from which you can customize the layout of your canvas or portal page. For example, you can choose between a column-based layout or a fluid layout. In a column-based layout, dragging a panel results in a drop indicator, showing where the panel goes. In a fluid layout, the content automatically fills the page area in equal proportions. You can manually rearrange and nest these elements on the page. The display area changes its size depending on your browser dimensions.

The Layout menu includes the following options:

- **Single Area.** Creates a free-flowing area, where there is no grid.
- **Fluid Canvas.** Arranges content evenly, and redistributes space as more items are added.
- **One Column.** Stretches content to fill the entire page area.
- **Two Columns.** Divides the page evenly into two columns.
- **Three Columns.** Divides the page evenly into three columns.
- **Four Columns.** Divides the page evenly into four columns.

When you choose any option other than Single Area, any items that you add to the page automatically snap to place in the layout.

Insert Tab

You can use the Insert tab to add containers or content to your portal page. The Insert tab is shown in the following image.

![Insert Tab Image]

The Insert tab contains the following two groups:

- **Containers.** Adds a panel, accordion, tabbed, responsive, or easy selector container to the page.
- **Content.** Inserts content, for example visualizations, reports, charts, documents, dashboards, pages, and URLs. You can also add images and text.
Style Tab

You can use the Style tab to configure styling of objects, options for the background and borders, as well as fonts and colors of the text. This tab functions in the same way as does the Style tab in the Portal Designer.

The following image shows the Style tab.

State

From the State group, you can choose which of the available states you are styling for an object. The state options include the following:

- **Normal.** This is the default state of an object in which an event, such as a hover, is not occurring, or if styling for that event is not defined.

- **Active.** This is the state in which the object is currently in use. An example is the background color of the current page tab.

- **Hover.** This is the state in which the mouse cursor is resting on the object.

Background

You can use an image, a color, or a combination of options to style the background of an object.

Image

The Image button is a split button. When you click Image, the Open dialog box appears, and you can select an image from your repository. When you click the menu, the Background Image Options open. Here, you can change or remove the image.

Click Change Image to launch the Open dialog box. From this dialog box, select an existing image in the Repository to use as the background, and click Open.
Repeat

You can use the Select Background Repeat menu to choose whether or not to repeat the background. The options in this menu include the following:

- **None.** Displays the background image only once.
- **Everywhere.** Repeats the background image horizontally and vertically. This is the default value.
- **Horizontally.** Repeats the background image horizontally.
- **Vertically.** Repeats the background image vertically.

Position

You can select a background position using a visual menu if you do not choose to repeat the image on the page. For example, you can position the background image at the bottom of the window, on the right. This feature is similar to Menu Bar positioning.

The default background position is upper left.

Background Color

The Background Color icon launches the color selection dialog box, where you can set a page background color. The same icon is used in the Border and Font groups to set the border and font colors, respectively.

Reset Background

The Reset Background icon resets the background styling to the theme settings, for the currently selected state. The same icon is used in the Border and Font groups, to reset those groups.

Border

In addition to color and reset, the Border group contains style and width options.

Style

When you click the Style menu, the Select Border Style menu opens. From this menu, you can choose from nine border styles. This includes None, solid border, dotted border, dashed border, groove border, and more. As you hover over each option, the canvas refreshes with a preview to show the border style.
Width

You can use the Width controls to set the border thickness in pixels (px). If the style is set to none, which is the default for most objects, the Width control has no effect.

Color

The Border Color icon launches the color selection dialog box, where you can set the Border color.

Reset Border

The Reset Border icon resets the border styling to the theme settings for the currently selected state.

Font

You can use the Font group to choose the Font family, modify the size of the font, and apply bold, italic, or underlined formatting.

In addition, the Font group contains the following options:

Color

The Font Color icon launches the color selection dialog box, where you can set the font color.

Reset Font

The Reset Font icon resets the font styling to the theme settings for the currently selected state.
Canvas

The following image shows the canvas area of the Page Designer. Here, you design your portal pages.

Properties Panel

The Properties panel appears near the bottom of the window, below the canvas. It contains properties that apply specifically to the currently selected item.

Breadcrumb Trail

The breadcrumb trail appears at the bottom of the Page Designer window. It serves two purposes:

- It indicates the currently selected item.
- You can use it to change the currently selected item.

Click any portion of the breadcrumb trail to change the currently selected item on the page canvas. This feature is another way to select an item, in addition to selecting it through the canvas. It is especially useful when you are working with hidden or layered content.
Page Components

The page is made up of different components, such as columns, containers, and resources. This section describes the different components of a page and their properties.

Portal Page Properties

The portal page, while not a component itself, does have properties that you can set.

The following are the properties of a portal page.

- **Title.** Identifies the title or label shown in the navigation menu and any tree that lists pages in a portal.

- **Page Icon.**
  - This is an icon displayed to the left of the page name throughout the software. You can turn it on or off. It is disabled, by default.
  - The maximum display size of the icon is 16 x 16 pixels. Upload an image that is visible at that size.
  - Change the page icon by clicking the preview icon or the *Change Image* button.

- **Lock Page.** Turns off customization on the page. Customization includes moving content and adding content.
  
  **Note:** The Lock Page check box is selected by default. Clear it to grant permission to end users from moving and adding content.

- **Refresh on Click.** Refreshes the page when you click the page title. This feature is useful if another page changes the parameters used by the reports on this page. When you switch back, the reports rerun with the appropriate parameters.

- **Show in Navigation.** Hides the page from the navigation. You can use this property to create a Home page for a portal that displays the first time that a user runs the portal, but the user cannot navigate to it again.

- **Prevent Layout Change.** Restricts layout changes on unlocked pages at run time. This option is only active when the Lock Page option is cleared.

- **Relative Path.** References a specific path for the content that was added to a page and allows you to move the page in the repository without losing any content or resources.

- **Show Refresh.** Displays the Refresh option in the page menu at run time.

- **Margins.** Sets page margins in pixels or as a percentage. Use the Same for All option to set equal margins on all four edges of a page.
Comments. Controls the placement of the comments on a page. The options include: none, top, bottom, left, and right.

Container Defaults. Opens the Container Defaults dialog box, where you can set a default size, appearance, and list of behaviors for all containers on a page.

Columns
You can set the following properties for columns in a portal page.

- **Column Number.** Indicates the column that is selected on the page, using a label.
- **Width.** Sets the width of a column in pixels or as a percentage.
- **Lock Width.** Prevents a designated column width from being changed at run time. This option is disabled, by default.
- **Container Padding.** Sets the space between either container and the column edge (left and right of each container, the top of the first container, and the bottom of the last container) or each other (vertical space between each container). These work like page margins, but are set only in pixels.
- **Freeze Column.** Prevents users from adding content to the column or any of the containers inside this column at run time. It also prevents users from removing any content or containers from this column at run time. This option is not available when the Lock Page option is selected.
- **Show Easy Selector.** Activates the Easy Selector function at run time. When you enable this property, the Browse For Folder dialog box opens, and you can select a folder that is available from the Easy Selector option at run time.

Select Folder. Opens the Browse For Folder dialog box, where you can select a folder that is available from the Easy Selector option at run time.

Containers
There are five types of containers that you can add to a portal page. These include:

- **Panel.** A simple container that can hold a single piece of content.
- **Accordion.** A compound container that can hold one or more pieces of content. It uses accordion panes to switch between the content.
- **Tabbed.** Similar to the accordion, but uses tabs to switch between the content.
- **Responsive.** A compound container that responds to the layout changes based on the size of the browser or device.

- **Easy Selector.** A simple container that a flexible way of adding content to a portal at runtime without opening the Resources tree.

**Panels**

A panel container holds a single piece of content, as shown in the following image.

![Sales by State](image)

The panel consists of three sections:

- Overall panel
- Title bar
- Content Area
If you hover over a panel in Page Designer, the change panel type button appears, as shown in the following. This button opens a menu, where you can select a different type of panel.

![Panel Change Button](image)

**Note:** When adding pages created in the WebFOCUS Designer, the change panel type button opens over the Refresh and Filter option for the page. However, when you run the portal page, these options are accessible.

To change the title of the panel, right-click the title bar and click *Change Title*, as shown in the following image.

![Change Title](image)

When you select a panel or container on the canvas, the properties panel refreshes, and provides access to the properties that you can use to modify or customize the container.

You can use the Properties tab to modify the size of a panel, set responsive properties, adjust the behavior of a panel on the portal page, and control the appearance of the panel on the portal page. These properties include the following:

- **Size.** In a single area layout, this is both height and width in pixels. In column-based layouts, this is height only. You can set the height, in pixels, to Auto, Dynamic, or a numeric value. The Dynamic height option is only available when you use a responsive container.

- **Responsive Properties.** Opens the Responsive Panel Properties dialog box, where you can edit the layout of the responsive container.
Behaviors. Configures how the panel behaves. By default, all options are on. The options that require a menu click are available by hovering over the title bar and accessing the menu at the upper-right (in accordion and tabbed containers, each area has a menu as well). The options are as follows:

- **Move.** If selected, allows you to move a panel on a page at run time.
- **Resize.** If selected, allows you to resize a panel at run time.
- **Minimize.** Adds the Minimize option to the panel drop-down menu.
- **Maximize.** Adds the Maximize option to the panel drop-down menu.
- **Refresh.** Adds the Refresh option to the panel drop-down menu.
- **Hide.** Adds the Hide option to the panel drop-down menu.
- **Delete.** Adds the Delete option to the panel drop-down menu. When a user deletes a panel, they delete it only from their version.
- **Show Comments.** Displays comments on a panel, and adds the Show/Hide Comments option to the panel drop-down menu, if selected.

Appearance. You can control the following options:

- **Hide Panel.** When this option is selected, the panel is not initially visible. The user can add it by clicking *Hidden Content* in the page shortcut menu or the Menu Bar. You can use the Hidden Content feature to give the user a choice of widgets to view on their page.

- **Freeze Container.** Prevents users from adding content to and removing content from the container at run time. This option also restricts any interaction with the container at run time except minimizing, maximizing, and restoring the panel to its original size. This option is not available when the Lock Page option is selected.

Using the Title tab of the Properties panel, you can modify the title of the panel, create a panel icon, and control the appearance of the title or menu. These properties include the following:

- **Title.** Displays the text in the title bar. When you add content, it automatically changes to the current title of that content. You can edit this field to override the automatic change.

- **Panel Icons.** Works just like the page icon. It is disabled by default.

- **Change Image.** Allows you to select a different image for the icon.
Appearance. Controls the following options:

- Hide Title Bar. Hides the title bar to save space. This feature is useful when you have only a single piece of content on a page.

- Show Menu Icons. Determines whether the icons that display with the options in a container shortcut menu are visible.

You can use the Content tab of the Properties panel to change the content area of the panel, enable automatic refreshes of the content within the panel, and apply the styling from the portal to all content items on the portal page. These properties include the following:

- Content Area. The properties for the Content Area differ based on the type of content. A blank panel has a blank properties panel.

- Auto Refresh. Refreshes the content automatically. This property is off by default. When it is enabled, the default time is 30 seconds.

- Dynamic Report Styling. Applies the style of the portal to all reports that run within the portal. This property is off by default.

When you select a tabbed or accordion container, you can modify properties on the Tabs or Areas tab. These properties include the following:

Tabs/Areas Tab. Contains the properties that apply to tabs and areas. This tab is only visible in the properties panel of a tabbed or accordion container. Here you can style different areas of the container by selecting Buttons or Bar. You can also hide the new tab button from a tabbed container, or the new area button from an accordion container, to restrict adding more tabs and areas to this container at run time.
**Accordion Container**

The accordion container can hold more than one piece of content, as shown in the following image.

In the preceding image, notice how the chart fits perfectly in the container. InfoAssist has an option to AutoFit charts. When enabled, it accepts the sizing from the portal. This prevents the person who develops the chart and the person who uses it from having to coordinate sizing. Additionally, you can easily resize the container and see the entire chart.

The title bar and content area properties are the same. The overall properties have an additional section labeled Area.

In the Area section, you can use the icons in the order in which they appear to add, rename, delete, and reorder the areas. You can also create a new area using the new area bar in the container or delete containers using the menus. You must use the Properties panel to rename or reorder the areas.

**Note:** When you click the New Area bar multiple times to add new areas, you may need to resize the container to view the bar, as it could be covered by newly created areas.

There is also an additional Properties panel, the Pane Title Bars, which is accessible only through the breadcrumb trail. This feature lets you style the title bars of the areas. They are all styled together, but you can style the different states to distinguish the currently active one from the one on which the mouse pointer is resting.
Tabbed Container

The tabbed container can hold more than one piece of content, as shown in the following image.

![Panel 1](image)

The tabbed container has all the same properties as the accordion container. Instead of the Pane Title Bars properties, it has a property panel called Tab Bar. You can access this property panel by clicking it.

Unlike the Pane Title Bars, it is not blank. You can choose to style the buttons or the bar.
Responsive Container

The responsive container is designed to help you build a responsive portal that automatically adapts to different screen sizes and mobile devices, providing an optimal viewing experience for users everywhere. You can build your responsive portal on your desktop, and make it available to users on different platforms. The following image shows an example of a responsive portal displayed on a desktop, tablet, and smart phone.

The responsive container intuitively changes its layout when you change the size of your browser. The default width and height of the container, and the inserted items, are pre-configured to offer the best positioning of the elements on the screen. You can manually change the dimensions of the items in the Responsive Item Properties dialog box. You can also change the layout options in the Responsive Panel Properties dialog box.

Responsive Item Properties

The Responsive Item Properties dialog box provides options to change the dimensions of an individual item within the responsive container. You can access the Advanced Responsive Item Properties dialog box at design time by clicking the Responsive Properties button in the Properties panel.

The properties for a responsive item are:

- **Custom CSS Classes.** Enables custom CSS classes for the item.
- **Width.** Defines the width of the item.
- **Height.** Defines the height of the item.
- **Margin.** Defines the space between the adjacent items.
- **Shrink.** Defines the ability of the item to shrink if necessary.
- **Grow.** Defines the ability of the item to grow if necessary.
- **Basis.** Specifies the initial size of the item, before any available space is distributed according to the responsive factors.
- **Minimum Width.** Sets the minimum width of the specified element. This setting overrides the Width setting.
- **Maximum Width.** Sets the maximum width of the specified item. This setting overrides the Width setting.
- **Minimum Height.** Sets the minimum height of the specified item. This setting overrides the Height setting.
- **Maximum Height.** Sets the maximum height of the specified item. This setting overrides the Height setting.
- **Self Align.** Provides access to the following options:
  - **Auto.** Intuitively places the item in the best available space inside the responsive container.
  - **Start.** Aligns the item to the left side of the responsive container.
  - **End.** Aligns the item to the right side of the responsive container.
  - **Center.** Aligns the item to in the center of the responsive container.
  - **Stretch.** Stretches the item to fill the available space inside the responsive container, while respecting width and height constraints.
  - **Baseline (text).** Aligns the baseline of text inside the responsive container.

**Note:** In a responsive layout, setting fixed dimensions for items is not recommended, because the viewport width and height continually change from device to device. Responsive layouts need to adapt to this change, whereas fixed dimensions create too many constraints. For this reason, you must only set a range between minimum and maximum width and height, defining an amplitude with which the item can vary in size.
Easy Selector Container

The easy selector container provides a simple way to add content to a portal at run time, without opening the Resources tree. It also gives you the option to control which items users can access. When you insert an easy selector container into a page at design time, the Browse For Folders dialog box opens, as shown in the following image. Here you can select a folder that users can access at run time.

![Easy Selector Container Image]

To change a target folder, click the Change Folder button in the Properties panel.

Content

You can add content to a page in a few ways. The first way is to use the ribbon. Navigate to the Insert tab and choose a type of content in the Content group. The second way is to insert a blank panel, area, or tab container, and use the WebFOCUS Resources panel to populate it. From this panel, you can drag content to the portal page.

**Note:** When you click, and drag one or multiple resources or folders from the WebFOCUS Resources panel to a blank page, a tabbed container is created, showing each resource as a separate tab.

The other three options (Image, Resource Tree, and Text) place their content in the content area that is selected, if applicable. Alternatively, they create a new panel with the content on the page.
WebFOCUS Resources

The WebFOCUS Resource option opens the Resources tree on the right-hand side of the window. The tree shows you the content stored in the Repository. You can access this content in the Domains section of the tree. Alternatively, you can find a resource that you marked as a Favorite.

The Resources tree is docked on the right. When it is docked, you can keep it open, close it, or unpin it so that it collapses to the side.

Text

The last type of content is text. The text area is simple to use. All styling is applied to all the text. You cannot style individual words or characters.

The text area has no properties other than the content type and the Area ID.

Working With the Business User Edition Portal

The first page that you see after signing in to the Business User Edition is the Home page. If you add a new personal portal page and sign out of the portal with the new portal page in focus, the new portal page opens, by default, the next time you sign in. You can create new portal pages to display the content that is available to you.

Procedure: How to Add a New Personal Portal Page

From the Home page, click the Add Page icon, as shown in the following image.
A blank page and the WebFOCUS Resources panel opens. You can drag content from the Resources tree to the portal page.

**Procedure: How to Add a New Base Portal Page**

1. In the Explorer, on the Home page, right-click a domain portal page, and then click Publish.

   For more information on how to create domain portal pages, see *How to Use the Page Designer to Create a Domain Portal Page* on page 292.

2. On the Menu bar, click Resources.

   The WebFOCUS Resources panel opens.

3. Right-click your published portal page, and then click Add to Portal.

   The confirmation message appears, indicating that the portal page is added to the portal.

4. Click OK to close the confirmation message.

   The portal refreshes, the new page appears in the new tab.

   **Note:** The domain portal pages added to the Business User Edition portal behave as base portal pages. Base portal pages are locked, by default, at design time to prevent users from making run-time changes.

**Procedure: How to Add Content to the Business User Edition Portal at Run Time**

1. Navigate to the page that you want to populate with content.

2. On the Menu bar, click Resources.

   The WebFOCUS Resources panel opens.
3. Drag an item, such as report, chart, or page created in the WebFOCUS Designer, to the portal page. Use the shaded area to position the item on the portal page, as shown in the following image.

![Image of drag and drop functionality in WebFOCUS Designer](image)

**Note:** When you drag one item on top of another and position your cursor in the center of the other item, you have a choice to either replace the existing item or add the new item as a new tab. If you choose the latter, a tabbed container is automatically created. If you multi-select several items and drag them to a portal page, they display as tabs within a single panel. You can refresh or delete each tab individually. You can rearrange content by moving it on the portal page with your pointer. Optionally, you can change the layout of the portal page by right-clicking the page title, and then clicking *Page Layout*. The default layout of the personal portal pages is Fluid Canvas.

4. After you finish adding content to the portal page, close the WebFOCUS Resources panel.
Accessing Page Shortcut Menu Options

Right-click the page title of a personal portal page or an unlocked base portal page to access a shortcut menu options. The shortcut menu opens, as shown in the following image.

<table>
<thead>
<tr>
<th>Change Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move Left</td>
</tr>
<tr>
<td>Move Right</td>
</tr>
<tr>
<td>Page Layout</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Refresh</td>
</tr>
</tbody>
</table>

**Change Title**

Renames the selected portal page.

**Move Left**

Moves the selected portal page to the left.

**Move Right**

Moves the selected portal page to the right.

**Page Layout**

Allows you to choose a portal page layout to align your content into the desired number of columns.

**Delete**

Deletes the selected portal page.

**Note:** The Home page does not have shortcut menu options, since this is a static base page in the portal.

Using WebFOCUS Designer

These topics introduce WebFOCUS Designer, and how you can begin using it to create pages and InfoApps.
Introducing WebFOCUS Designer

WebFOCUS Designer is a web-based development tool that you can use to create interactive, responsive pages, using content that you or other members of your organization create. This content can be added to a page by utilizing drag-and-drop actions. With the interactive canvas, you can resize and rearrange resources with ease. Additionally, you can use the integrated filter control capability to create instant, compelling applications and InfoApps from your content.

WebFOCUS Designer is shown in the following image.

Navigating the WebFOCUS Designer

The WebFOCUS Designer features a modern user interface with intuitive navigation, streamlined content creation, and the flexibility to build filtered responsive pages that are instantly compatible with any browser or mobile device.
The WebFOCUS Designer Interface

The WebFOCUS Designer interface is shown in the following image.

The WebFOCUS Designer consists of the following components:

- Designer toolbar
- Resource selector
- Canvas
- Page toolbar
- Properties panel

Designer Toolbar

The Designer toolbar provides access to general properties and interface controls that you use to help develop content in the WebFOCUS Designer, as shown in the following image.

The following table lists and describes the controls that you can access from the Designer toolbar.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="application.png" alt="Icon" /></td>
<td><strong>Application Menu.</strong> Opens a menu that you can use to open an existing page, create a new page, save the current page, and close the WebFOCUS Designer.</td>
</tr>
<tr>
<td><img src="save.png" alt="Icon" /></td>
<td><strong>Save.</strong> Opens the Save dialog box, where you can save the page to a specific location in your environment.</td>
</tr>
<tr>
<td><img src="preview.png" alt="Icon" /></td>
<td><strong>Preview.</strong> Shows the page in preview mode, allowing you to view how the page will appear when run. To exit the preview mode of the Designer, click the back arrow.</td>
</tr>
<tr>
<td><img src="filter.png" alt="Icon" /></td>
<td><strong>Quick Filter.</strong> Configures filters that automatically appear when new unbound parameters are found in the content on the page. The badge icon shows the number of parameters available.</td>
</tr>
<tr>
<td>![Icon](filter config.png)</td>
<td><strong>Page Filter Configuration.</strong> Opens the Page Filter Configuration dialog box, where you can choose to display filters in a filter bar above your content or in a modal window.</td>
</tr>
<tr>
<td><img src="info.png" alt="Icon" /></td>
<td><strong>Info Mode.</strong> Enables the informational mode that changes the view of all content items on the canvas to display their paths in the repository and parameters configured within these items.</td>
</tr>
<tr>
<td><img src="help.png" alt="Icon" /></td>
<td><strong>Help.</strong> Launches the online Help content.</td>
</tr>
<tr>
<td><img src="resources.png" alt="Icon" /></td>
<td><strong>Resources.</strong> Hides or shows the Resource selector.</td>
</tr>
<tr>
<td><img src="properties.png" alt="Icon" /></td>
<td><strong>Properties.</strong> Hides or shows the Properties panel.</td>
</tr>
</tbody>
</table>

**Resource Selector**

You can use the Resource selector to access content, containers, and controls for your page. The Resource selector has the following tabs:

- Containers
- Content
- Controls
The Containers tab is shown in the following image.

Using this tab, you can select empty containers, which you can drag to the canvas, and populate with the content of your choice. The types of containers available to you include:

- Panel
- Tabbed
- Carousel
- Accordion
- Grid

The Content tab is shown in the following image.
This tab shows your Resources tree, where you can navigate to your content by expanding and collapsing folders, selecting content items, and dragging to the canvas.

The Controls tab is shown in the following image.

![Controls Tab](image)

Using this tab, you can add a text label or a Submit button to your page.

**Canvas**

The canvas is the design area. It provides a responsive grid for all your containers and content and resizes automatically to fit any browser or device. The canvas is shown in the following image.

![Canvas](image)

When you right-click the grid area, you access a shortcut menu of options that include the following:

- **Settings.** Opens Section Settings inside the Properties panel, which you can use to make the current section collapsible.

- **Style.** Opens the Style tab inside the Properties panel, which you can use to apply styles to the current section.
Delete section. Deletes the current section.

Insert section above. Inserts a section before the current section.

Insert section below. Inserts a section after the current section.

The Page toolbar is located above the canvas. Here you can edit the page title by double-clicking the text and typing the new text. You can hide the page title by disabling Title in the Properties panel.

The Page toolbar also contains two options, described in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh icon" /></td>
<td><strong>Refresh.</strong> Refreshes the content on the canvas.</td>
</tr>
<tr>
<td><img src="image" alt="Filter icon" /></td>
<td><strong>Filter.</strong> Toggles the page filter, which can be displayed as a filter bar or a filter modal window. This option is only visible when filters are added to the page.</td>
</tr>
</tbody>
</table>

You can hide the options by disabling Toolbar in the Properties panel. To hide the Page toolbar completely, disable both Title and Toolbar in the Properties panel.
Properties Panel

You can use the Properties panel to configure properties for the element that you selected on the page. An example of the Properties panel for a page is shown in the following image. Under the Settings tab, you can toggle the title and toolbar visibility. Under the Style tab, you can configure page style and page heading.

Creating and Editing Pages in WebFOCUS Designer

Using the responsive grid, drag-and-drop operations, and other features, arranging content on a page in WebFOCUS Designer is quick.

Creating Pages in WebFOCUS Designer

You can create pages in WebFOCUS Designer that you can add to a portal or portal page to share with other users in your organization. Additionally, pages that you create in Designer can be run as content items from the Home page or directly from a browser. You can share a Designer page as a stand-alone repository resource or a URL.
**Procedure**: How to Create a Page Using WebFOCUS Designer

1. To launch WebFOCUS Designer, from the Home page, in the Resources tree, select the domain or folder where you want to create the page, and then click Page.

   The New Page dialog box opens, as shown in the following image.

   ![New Page Dialog Box](image)

2. Choose a template for your page. The options include Blank, Grid 2-1, Grid 3-3-3, Grid 4-2-1, and InfoApp 1.

   Designer opens, and the canvas shows the template that you selected.

**Editing Pages in WebFOCUS Designer**

After creating a page in WebFOCUS Designer, you can edit it at any time, in one of the following ways:

- From the Home page, select the domain or folder where the page resides. Right-click the page, and click *Edit*.

- From the Home page, select the domain or folder where the page resides, and then click *Page*. In the New Page dialog box, click *Copy an Existing Page*. In the Open dialog box, click the name of the page, and then click *Open*.

- From WebFOCUS Designer, click the Application Menu button, and then click *Open*. In the Open dialog box, click the name of the page, and then click *Open*.

**Note**: You can only use WebFOCUS Designer to edit pages that were created in this tool.
Adding Content to a Page

In the WebFOCUS Designer, you can create interactive pages or InfoApps, using content that you create in InfoAssist as well as images and URLs to external content. You can also add content to these pages using content that was created by another user in your organization. You can access the content that is available to you from the Content tab in the Resource Selector.

Procedure:  How to Add Content to a Page

1. From the Resources tree, in the WebFOCUS Designer, drag a content item of your choice to the canvas such as, a chart.

   As you drag the item to your canvas, a shaded placement area appears, as shown in the following image.

   ![Page Heading](image)

2. Repeat Step 1 to add more content to your page.

   After adding content to your page, you can resize or rearrange items, add a heading, or add filters. Before closing the page, be sure to save any changes.

Creating Multi-Content Containers

In the WebFOCUS Designer, you can create multi-content containers that show multiple content items at the same time. For example, you can create a carousel that rotates images or an accordion container that maximizes space on your page.

The multi-content container types include:

- **Tab.** Displays content items using tabs that you can click to view secondary content items.
Procedure: How to Create a Multi-Content Container

1. Add a content item to your page.
2. Drag a new content item to your page, and place it over the existing container.
   - The Add Content dialog box opens, and presents the following options.
     - **Replace content.** Replaces the content item with the new one.
     - **Add content as new tab.** Creates a tabbed container.
     - **Add content as new slide.** Converts the container to a carousel, and adds content as slides.
     - **Add content as new accordion area.** Creates an accordion container.
     - **Cancel.** Closes the Add Content dialog box.
3. Select an option to modify the container.
   - The item refreshes and shows the multi-content container. You can modify the container title and adjust the placement on your page.

**Note:** Once you have selected a new tab, new slide, or new accordion area, the options in this menu only allow you to replace an item or add an item.
Resizing Content on a Page

You can resize content on a page at any time using the sizing handles and the shaded placement area that appear on the canvas. When you hover over an item on the canvas, a series of handles appear. Drag a handle in the direction that you want to resize the item, as shown in the following image.

Hiding Content From Devices

You can choose to hide certain content items from smaller devices, especially when dealing with large or multi-faceted items like maps or visualizations. When an item is hidden from a device, the other items around it re-flow into the empty space and retain the responsive layout.

Procedure: How to Hide a Content Item From Devices

1. In WebFOCUS Designer, select a large item that you want to hide from small-screen devices.

2. In the Properties panel, in the Setting tab, under the Show On property, click the device icon to remove it from the list of devices on which this item will be shown.

   Note: All three device buttons are selected, by default, making the item visible on all devices. Manually clear the buttons to hide the item from specific device types.
An example of hiding a large item from mobile phones and tablets is shown in the following image.

3. Save the page.
4. Run the page on a device, from which the item was hidden.
The item does not display. All remaining content items rearrange to cover the empty space, as shown in the following image.
Previewing Pages

As you create pages in the WebFOCUS Designer, you can preview how the page will appear when run by clicking the Preview button. This opens a preview mode of the Designer, which is shown in the following image.

In preview mode, you can interact with your content, view tooltips, as well as access menu options only available when the page is run. You can also explore the responsive capabilities of the page by adjusting the width of your browser. These functions are not available when you create the pages, as interactive features are disabled. The Maximize / Restore button behaves in the same way when you create a page or preview a page, by maximizing the item to fill the entire canvas. If you save the page while an item is maximized, it will appear maximized the next time that you open or run the page, by default.

To exit the preview mode of the Designer, click the arrow.

Dividing Pages into Sections

The WebFOCUS Designer canvas uses a responsive grid layout that you can divide into sections to organize your content, and achieve multiple, complex layouts. You can also collapse selected sections to allow users to maximize space on a page.
When you open a blank page, only one section displays inside the canvas. To add more sections, right-click the canvas and then click *Insert section above* or *Insert section below*.

When a section is selected, a red dotted line appears to indicate the border of the section, as shown in the following image.

![Section Border](image)

To delete a section, right-click the section, and then click *Delete section*.

To make a section collapsible, enable the Collapsible setting in the Properties panel. Right-click the section, and click *Settings*, or click *Properties* on the toolbar to open the Properties panel. You must enable the Collapsible setting for each section that you want to make collapsible.

When the page is run, you can expand or collapse sections using the section indicator, which is shown in the following image.

![Section Indicator](image)

When you save the page, the collapsed state of the section is saved and will appear collapsed the next time you open or run the page.
Editing Page and Contain Properties

The Properties panel displays the properties for the element that is selected. To access container properties, click a container or item with the Properties panel open. To access page properties, click the page header or the toolbar. If the page header and the toolbar are hidden, you can access page properties by clicking the canvas outside a grid section.

The following properties are available for pages.

Settings tab:

- **Title.** Toggles between hiding and showing the title in the header.
- **Toolbar.** Toggles between hiding and showing the page toolbar.

Style tab:

- **Theme.** Allows you to select a theme for the page. The options are Default, Light, and Midnight. Administrators can configure additional themes that will be available to users from this property.
- **Margin.** Controls the size of the margin between the border of the page and the content.
- **Max Width.** Controls the maximum width of the page.
- **Page Heading Style.** Provides a selection of typeface styles for the page heading.

The following properties are available for containers and items.

Settings tab:

- **Title.** Toggles between hiding and showing the title.
- **Toolbar.** Toggles between hiding and showing the container toolbar.

Style tab:

- **Container Style.** Allows you to choose a color style for the selected container or item.

Using Repository Widgets

The repository widgets provide additional innovative ways of using your content and incorporating it into your page. There are two repository widgets currently available in WebFOCUS Designer.

- **Explorer.** Allows you to put the WebFOCUS Explorer onto your page and use the WebFOCUS Home Page features to navigate your content. A page that displays the Explorer widget can replace the default Workbench page in the Business Intelligence Portal.
**Link tile.** Layers content in such a way that one content item becomes a click-through tile that opens another content item. This feature is especially useful when you need to incorporate a large or Insight-enabled item into a page and display it on all devices.

**Procedure:** How to Use the Explorer Widget

1. Open WebFOCUS Designer and select the Blank template.
2. From the Content tab of the Resource Selector, from the Repository Widgets area, drag the *Explorer* widget onto the canvas.
   
   The widget displays on the page and incorporates the full view of the WebFOCUS Explorer.
3. Maximize your widget container to fill your page.
4. Optimize the look of the page by removing the page and container titles and toolbars.
   a. Select the widget container on the canvas, open the Properties panel, and then disable the Title and Toolbar options.
   b. Select the page and disable the Title and Toolbar options in the Properties panel.

   An example of a completed page is shown in the following image.

5. Save your page.

   The page can now be added to a portal as described in *Add a Designer Page to a Portal* or used as a standalone item.
**Procedure:** How to Use the Link Tile Widget

1. From the Content tab of the Resource Selector, from the Repository Widgets area, drag the Link tile widget onto the canvas.

   The widget displays as an empty placeholder on the page.

2. With the Link tile placeholder selected, open the Properties panel.

   The Link Tile properties display, as shown in the following image.

   ![Link Tile Properties](image)

3. Click the ellipsis icon next to the Background option and navigate to the content item that you choose to display on the page.

   **Note:** Pick an image or a content item that you want users to see when the page loads. Note that any interactive features in the content are disabled when it displays in the Link Tile background.

4. Click the ellipses icon next to the Content option and select the target item. This content will run when users click on the Link Tile panel.

5. Determine how the target item will display by setting the Target option to **Viewer** or **New Window**.

6. Evaluate the behavior of the click-through action in the Preview mode.

7. Exit the Preview mode and save your page.

**Working With Filters in WebFOCUS Designer**

Creating a page filter in WebFOCUS Designer is a quick and intuitive process. Whenever you add parameterized content item to the canvas, such as a report with parameters or chart with parameters, the Designer recognizes the parameters and creates filters for them automatically. The tool then notifies you of any available filters with a notification, and a badge count is overlaid on the Quick Filter button, as shown in the following image.

![Filter Notification](image)
There are three ways to add filters to a page in WebFOCUS Designer:

- Automatically, by clicking the *Quick Filter* button.
- Manually, by creating an empty filter bar or filter modal window and populating it with select filters.
- Manually, inside a Grid container.

**Procedure:**  How to Automatically Add Filters to a Page Using the Quick Filter Button

1. In the Resource selector, drag a parameterized item of your choice from the Resources tree to the canvas.

   The Quick Filter button appears on the toolbar with the badge icon showing the number of unbound filters.

2. Optionally, add more content with the same set of parameters.

3. Click the Quick Filter button.

   The filter bar with all available filters appears above your content.

4. Optionally, customize your filter bar as described below.

   - Right-click a cell to access shortcut menu options, as shown in the following image.

     ![Shortcut Menu Options](image)

     The available options are:

     - **Add filter controls.** Opens the Add Filter Controls dialog box, where you can choose from the list of available controls and add them to the filter grid.

     - **Insert row above.** Inserts an empty row above the current one in the filter grid.

     - **Insert row below.** Inserts an empty row below the current one in the filter grid.
Style. Opens the Properties panel, where you can customize grid style and cell alignment.

Delete cell. Deletes the current cell.

Delete grid. Deletes the entire filter bar.

Right-click a control to access shortcut menu options, as shown in the following image.

![Shortcut menu options](image)

The available options are:

- **Edit label.** Makes the label of the control an editable text.
  
  **Note:** Another way to edit a control label is to double-click the field, type the new text, and press Enter.

- **Convert.** Opens the Convert Control To dialog box, where you can choose between various control types.

- **Settings.** Opens the Properties panel, where you can customize label position, label alignment, and control object width.

- **Style.** Opens the Properties panel, where you can customize cell styling options.

- **Delete control.** Deletes the current control.

Drag any filter cell to a new location in the grid.

Multi-select two controls, right-click one of them, and then click Combine to combine the two controls into one. An example of two combined controls is shown in the following images.

![Combined controls](image)
Drag a control into a cell with other controls. This action puts two separate controls into one cell. The drag marker is shown allowing you to position one control in front or behind another control. You can separate the controls again by dragging one control out of the cell.

5. Save your changes.

**Procedure: How to Add Filters to a Page Manually**

1. In the Resource selector, drag a parameterized item of your choice from the Resources tree to the canvas.

   The Quick Filter button appears on the toolbar with the badge icon showing the number of unbound filters.

2. Optionally, add more content with the same set of parameters.

3. Click the Page filter configuration button.

   The Page Filter Configuration dialog box opens.

4. Click **Create empty filter bar**, as shown in the following image.

   ![Page Filter Configuration dialog box](image)

   **Note:** If you prefer a floating modal window instead of a filter bar, click **Create empty filter modal window**.

5. Right-click inside any filter cell, and then click **Add filter controls**.
The Add Filter Controls dialog box opens, and lists all available controls selected by default, as shown in the following image.

![Add Filter Controls dialog box](image)

6. Clear the controls that you want to exclude.

7. Optionally, change the types of your controls where applicable by selecting a desired option in the Control column, as shown in the following image.

![Control types](image)

**Note:** When working with button sets, keep in mind that they look best when positioned in a single line.

8. Click Add filter controls.

The controls are added to the filter bar.

9. Save your changes.

**Procedure:** How to Add Filters to Page Using a Grid Container

1. In the Resource selector, drag a parameterized item of your choice from the Resources tree to the canvas.

The Filter button appears on the toolbar with the badge icon showing the number of available filters.
2. Optionally, add more content with the same set of parameters.

3. In the Resource selector, click the Containers button.

4. Drag the Grid container onto the canvas.

5. Right-click inside the grid container, and then click Add filter controls.

   The Add Filter Controls dialog box opens, and lists all available controls selected by default.

6. Clear the controls that you want to exclude.

7. Click Add filter controls.

   The controls are added to the grid container.

   **Note:** You can also drag a control from the filter bar to a grid container directly, if the filter bar is open and populated with controls.

8. Optionally, move and resize your grid container and content to achieve the desired alignment.

   An example of a simple layout featuring a grid container with filter controls is shown in the following image.

9. Save your changes.

**Configuring Filter Grid Properties**

You can configure the properties of the filter grid using the Properties panel, which is content-sensitive. For example, when you click a filter cell, the cell style properties open in the Properties panel. When you click a filter control, the general and style properties for this control open in the Properties panel.
The Properties panel for a cell is shown in the following image. When you configure these properties, you modify the alignment of content within a cell or change the style layout of the filter grid.

The properties for a grid cell are:

- **Cell Content Alignment.** Controls the alignment of the label and control inside the cell. The options include top, middle, bottom, left, center, and right.

- **Grid Style.** Controls the grid layout of the filter bar. The options include 1-Column, 2-Column, 3-Column, 4-Column, and 6-Column.
The Properties panel for a filter control is comprised of two tabs: general and style properties. The settings tab is displayed in the following image. Using these properties, you can define the type of filter control that shows on the page, add a tooltip or placeholder text, and set the default value.

The settings tab contains the following properties:

- **General Settings.** This section includes the following options:
  - **Type.** Displays the type of the control.
  - **Tooltip.** Displays a tooltip when you hover over the filter control.
  - **Global name.** Designates a global name to the control.

- **Control Settings.** This section includes the following options:
  - **Optional.** Toggles between optional and mandatory control.
  - **Placeholder Text.** Displays a placeholder text inside the control selection field.
  - **Search.** Adds a search field to the filter drop-down menu.

  **Note:** If the select list contains 50 or more values, the Search option is enabled automatically.
- **Selection controls.** Adds *Select All* and *Clear* buttons to the filter drop-down menu. This property is only available for multiple select lists.

  **Note:** The Selection controls and Show All options cannot be selected at the same time.

- **Data Settings.** This section includes the following options:

  - **Show All option.** Adds an All option to the control that the user can select. This option is hidden when the Selection controls option is enabled.

    **Note:** Choosing this option results in the parameter receiving a _FOC_NULL value. If this parameter is used in a WHERE condition, it results in the WHERE condition being removed from the request and all data values for this field displaying the page.

  - **Display text.** Allows you to specify a custom value for the Show All option in the control. The default text is *All*.

  - **Default value.** Displays the default value of the control. You can edit this field and override the control value.

  - **Parameters.** Shows the name of the parameters that were used for this control.
The style tab is displayed in the following image. Similar to the properties of a cell, you can modify the positions of labels in a control, define the alignment, and set the object width.

The style properties are:

- **Label Position.** Controls the position of the filter label in the relation to the control. The options are above, right, left, and no label.

- **Label Alignment.** Controls the alignment of the filter label. The options are left, right, and center.

- **Direction.** Controls the alignment of the elements inside the control. This property is available for radio button, checkbox and button set controls. The options are horizontal and vertical. The vertical option is enabled by default when the control has five or more values.
Label/Control Split. Controls the space ratio between the label and control inside the cell. This option is only available when the label position is set to right or left.

Control Object Width. Sets the width of the control in relation to the filter cell. The options are:

- Auto. Adjusts the width of the control automatically to accommodate the name of each value.
- Max. Fills the entire filter cell. This is the default value.
- Percentages. Set the control width to various percentages, as they relate to the filter cell.

Control Object Height. Sets the maximum height of the control. If the list of elements exceeds the maximum height of the control, a scrollbar is added to this control. This property is available for radio button, checkbox and button set controls when their Direction property is set to vertical. The default value is 150px. You can change this value as necessary.

Using Filters in WebFOCUS Designer

WebFOCUS Designer filter controls are versatile and allow you to facilitate multiple filtering scenarios. Depending on the needs of your enterprise and on the specifics of the data that you are using, you can configure filter controls to fit your unique needs. Examples below show you different types of controls and how to use them.

Choosing an Event Model for Your Page Filter

WebFOCUS Designer supports two event models for passing parameters to your page content:

- On-selection Change. Whenever you change a value of any filter control on the page, parameterized content refreshes to reflect your selection. This model is enabled, by default.

- Submit Button. After you make all desired changes to filter controls on the page and click the Submit button, parameterized content refreshes to reflect all your selections. This model can be enabled by dragging a Submit button control into the filter grid.

Procedure: How to Use One-selection Change Filters

1. Add filters to a page as described in How to Automatically Add Filters to a Page Using the Quick Filter Button on page 335.
2. Click the Preview button.
The preview mode is activated, allowing you to interact with content and filters.

3. Make filter selections.

Each time you make a selection, the content refreshes to reflect it.

**Note:** Notice that the filter controls are chained in such a way that each selection automatically reflects the available choices in other filters. In our example, we set *Category* to *Televisions*. Now, the Product Model filter only shows models of televisions, as shown in the following image. WebFOCUS Designer chains controls automatically, if the parameters are defined in the metadata layer with the WITHIN keyword to relate them.

4. Exit the preview mode and save your changes.

**Procedure:** How to Use Filters With a Submit Button

1. Add filters to a page, as described in *How to Automatically Add Filters to a Page Using the Quick Filter Button* on page 335.

2. From the Resource selector, click the *Controls* tab, and then drag the *Submit* button onto the filter grid.

   The Submit and Reset buttons display in the filter grid.
3. Optionally, customize the Submit and Reset buttons in any of the following ways:

- Align the Submit and Reset buttons by selecting the cell in which the buttons reside and customize the Cell Content Alignment option on the Style tab of the Properties panel. In this example, we selected Align control bottom and Align control center.

- Add a tooltip to the buttons by selecting each one and populating our the Tooltip field on the Settings tab of the Properties panel.

- Customize the width of the buttons in relation to the filter cell by selecting one of the options under the Control Object Width property. In this example we selected 50%.

**Note:** You can delete one or both buttons by right-clicking them and clicking Delete.

4. Click the **Preview** button.

The preview mode is activated, allowing you to interact with content and filters.

5. Make filter selections and click **Submit**.

The content refreshes to reflect all your selections upon clicking the Submit button, as shown in the following image.

![Filter selections preview](image)

6. **Click Reset.**

The filters return to their default values.

7. Optionally, click **Submit** again to refresh the content with the default values.
Note: If you deleted the Reset button in the previous step, you must select default values manually, and then click Submit to return to the default state.

8. Exit the preview mode and save your changes.

Working With Required Parameters

When you have required parameters in your content, WebFOCUS Designer interprets them as required filter controls. Required controls are marked in red, prompting you to make a selection for the request to be processed. The image below shows an example of a required filters control.

![Required Parameter Example](image)

With a required parameter in place, your content does not refresh until you select filter values.

There are two ways to create a required filter control:

- By adding a required parameter to a chart or report in InfoAssist.
- By converting an optional control to a required one in WebFOCUS Designer.

Procedure: How to Add a Parameter to a Content Item

1. On the WebFOCUS Home Page, on the actions bar, click Report or Chart.
   
   The Open dialog box opens.

2. Select a data source in the Open dialog box and click Open.
   
   InfoAssist opens.
3. Create a report or chart.
   
   To learn more about creating content in InfoAssist, see the *WebFOCUS InfoAssist User's Manual*.

4. On the Data tab, click Filter.

   The Create a filleting condition dialog box opens.

5. Double-click the *Double-click or press F2 to edit* text, select a field, leave the condition at *Equal to*, and then click *Value*.

   The drop-down dialog box opens.

6. Set the Type field to *Parameter* and select the *Dynamic* radio button.

7. Optionally, select the *Select multiple values at runtime* check box to create a multiple select filter control and *Optional* check box to create an optional filter control.

   In our example, we are creating a multiple select required control. An example of a complete configuration is shown in the following image.

![Create a filleting condition dialog box](image)

8. Save your changes and exit InfoAssist.

9. In WebFOCUS Designer, in the Resource selector, drag your new content item to the canvas.

   The content item does not load. Instead, a blank container displays a message: *A required parameter is missing*. The Quick Filter button appears on the toolbar with the badge icon showing one available filter.
10. Click the *Quick Filter* button.

The filter bar with one filter appears above the content item. The filter control is marked in red and the *Make a selection* text displays inside the control field.

11. Click the *Preview* button.

The preview mode opens.

12. Select one or more values from the list.

The filter control is no longer red. It displays your selections. The content refreshes to reflect the filter values, as shown in the following image.

13. Exit the preview mode and save your changes.

**Procedure: How to Convert an Optional Filter Control to a Required One**

1. In WebFOCUS Designer, add filters to a page, as described in *How to Automatically Add Filters to a Page Using the Quick Filter Button* on page 335.

2. Click an optional filter control and then click the *Properties* button.

The Properties panel opens.

3. In the Settings tab, disable the *Optional* setting and then disable the *Show All option* setting.

The filter control is marked in red and the *Make a selection* text displays inside the control field.
4. Click the Preview button.
   The preview mode opens. The content does not refresh.

5. Select a value for the required filter control.
   The content refreshes to reflect your selection.

6. Exit the preview mode and save your changes.

**Working With Single and Multiple Select Lists**

There are two types of list controls in WebFOCUS Designer:

- **Single Select List.** Allows you to pick a single value at run time.

- **Multiple Select List.** Allows you to pick multiple values at run time.

An example of a single select list control is shown in the following image.

Once you have made a selection in a single select list, your content instantly refreshes to reflect that selection.

An example of a multiple select list control is shown in the following image.

Once you have made all your selections in the multiple select list, you must click outside of the control for the content to refresh.
You can customize your list controls with the search feature by enabling the Search setting in the Properties panel. Once enabled, it adds the search field to your list and allows you to quickly navigate to a specific value. Simply start typing any word or syllable and all values that contain it will display. When a list contains 50 or more values, the search feature is enabled automatically. You can disable it at any time by disabling the Search setting in the Properties panel.

If a list contains 200 or more values, the paging feature is added to the bottom of the control. When paging is active, 10 values display per page. An example of a long list with the paging feature enabled is shown in the following image.

![City: All](image)

You can further enhance a multiple select list by enabling the Selection controls option in the Properties panel. Once enabled, it adds the Select all and Clear buttons to the list. This feature is especially useful when you need to eliminate just a few values from your results. You can click Select All, clear the values that you need to eliminate, and click outside of the control to refresh your content.
If the *Selection controls* and *Search* features are enabled at the same time, you can use the *Select all* button to select all search results, as shown in the following image.

![Product Model:](image)

**Working With Slider Controls**

A slider control is a horizontal track with a marker that you can slide between a minimum and maximum value. This versatile control is often used to choose a value within a fixed range. An example of a slider control is shown in following image.

![Min MPG:](image)

**Procedure: How to Create a Slider Control**

1. On the WebFOCUS Home Page, on the actions bar, click *Report* or *Chart*.
   The Open dialog box opens.

2. Select a data source in the Open dialog box and click *Open*.
   InfoAssist opens.

3. Create a report or chart.
   To learn more about creating content in InfoAssist, see the *WebFOCUS InfoAssist User’s Manual*.

4. On the *Data* tab, click *Filter*.
   The Create a filleting condition dialog box opens.

5. Create two parameters representing minimum and maximum values and make them optional.
In this example we create the minimum and maximum parameters for the MPG field in the car report. An example of the completed filtering condition is shown in the following image.

6. Save your changes and exit InfoAssist.

7. One the Home Page, right-click your new content item, and then click *Edit with text editor*. The Text Editor window opens.

8. Edit the syntax by providing the data range values.
An example of the modified syntax is shown in the following image.

9. Save your changes and exit the Text Editor.

10. In WebFOCUS Designer, in the Resource selector, drag your new content item to the canvas.

   The Quick Filter button appears on the toolbar with the badge icon showing two available filters.

11. Click the *Quick Filter* button.
The slider controls display in the filter grid, as shown in the following image.

12. Optionally, combine two controls together. Multi-select both controls, right-click one of them, and then click *Combine*.

Your controls are combined. You can edit the label to reflect your new combined control. An example of the combined slider control is shown in the following image.

13. Save your changes.
Working With Date Controls

Parameters that contain date ranges are recognized by WebFOCUS Designer as date range controls. An example of the date range controls on the page is shown in the following image.

The calendar feature inside a date control allows you to select a specific date value. Once you pick a specific date, it is always spelled out, so that it can be supported by all internationalized applications.

Optionally, you can combine two date control into one date range control. To do so, multi-select two date controls and then click Combine. An example of a combined date range control is shown in the following image.
Using Global Name to Synchronize Filter Controls

The Global Name property is a powerful tool that allows you to quickly synchronize filter control values between different pages. The Global Name property is configured on the Settings tab of the Properties panel for a filter control. Once enabled, it allows you to match your filter selections across multiple pages at run time within the same browser session.

Procedure: How to Configure Global Name Filter Control Property

1. In WebFOCUS Designer, add filters to a page, as described in How to Automatically Add Filters to a Page Using the Quick Filter Button on page 335.

2. Click a filter control that you want to synchronize and then click the Properties button. The Properties panel opens.

3. In the Settings tab, populate the Global Name field, as shown in the following image.

   ![Global Name Field](image)

   **Note:** You can choose any text as a global name for your control. Combined controls, such as date ranges and slider controls, have a single global name property.

4. Optionally, repeat step 3 for all the filter controls that you want to synchronize.

5. Save the page.

6. Create a second page, populate it with parameterized content, and add the same set of filter controls as you did in step 1.

   **Note:** To streamline this process, you can use the Save As option to create a new version of the existing page, leave the configured filters intact, and replace the content on the canvas. Make sure the Global Name values are identical between the filter controls on both pages.

7. Save the second page and exit WebFOCUS Designer.

8. Run one of your newly created pages.
9. Select filter control values.

An example of the filter control selections is shown in the following image.

![Filter Control Selections](image1.png)

10. Run the second page.

The page runs with the same filter control values as the ones you have selected on the previous page, as shown in the following image.

![Filter Control Selections](image2.png)

11. Optionally, change the filter control values on the second page and see how they synchronize with the ones on the first page.
Creating Report Queries With InfoAssist

You can create a new report query directly from Excel by accessing the WebFOCUS Quick Data Add-in. Specify connection attributes and the data source for your query, and then build your report using InfoAssist. You can place multiple queries in the same worksheet, or spread them out over multiple worksheets in a workbook.

There are limitations with queries that overlap. However, there are data layout options available in the Query properties of Excel that can assist with overlapping queries. This behavior is governed by Excel, not WebFOCUS Quick Data.

**Note:** Quick Data is a WebFOCUS Business User Edition option, which requires a separate license and installation. For more information about licensing Quick Data, contact your Information Builders representative.

**Procedure:** How to Create a New Report Query in InfoAssist

1. Open an Excel file.
2. Select a cell in which to place the query results.
3. With the Add-Ins tab selected, click the *WebFOCUS* option in the Excel menu, and then click *Create Query*.

   You can also right-click any cell and select *Create WebFOCUS Query*.

4. In the Web Server Connection dialog box, specify the desired Web Server URL and connection settings, and then click *Next*.

   **Note:** Do not end the URL with the / sign.

5. If prompted for sign-in credentials, sign in with your WebFOCUS Business User Edition username and password.

   The next screen opens, where you can select a folder to open a list of available data sources.

6. Select a folder and click *Next*. 
7. In the Data Source Selection dialog box, select a Master File, as shown in the following image, and then click Finish.

InfoAssist opens, where you can build a query and run it to return the output data to Excel.

**Example: Creating a New Report Query in InfoAssist**

This example covers multiple aspects of creating a new report query using the WebFOCUS Quick Data tool from an Excel file.

1. Open an Excel file, select a cell in which to place the query results, select the Add-ins tab, click the WebFOCUS option in the Excel menu, and click Create Query.

The Web Server Connection dialog box opens.

2. In the Web Server URL field, type the URL for a web server in your reporting environment, or select one from the drop-down list. An example of a Web Server URL is:

   http://localhost:26000

   **Note:** Do not end the URL with the / sign.

3. Click Next.

4. Select a folder to open a list of available data sources. In this example, we use the Retail Samples folder. Click Next.

5. In the Data Source Selection dialog box that opens, select WF_RETAIL_LITE from the Data Source list, and click Finish.

   InfoAssist opens.

6. Drag fields from the Data pane to the Query Pane to create a report.

After you perform the steps up to this point, the InfoAssist window looks similar to the following.

8. Click the Save button.
The report query data is transferred to the Excel file, as shown in the following image.

9. Click the drop-down arrow to the right of the Name Box. You will see named ranges that are automatically added to the query, as shown in the following image.
Named ranges are added to the entire data table. The named range for the entire data table is QDATA1.

10. Select QDATA1 from the Name Box. The data in the table is automatically highlighted.


Ribbon Command Reference

The ribbon is contextual and changes depending on the type of file that you are developing. This topic describes each of the available ribbons and commands for each InfoAssist tool.

Ribbon Commands for Reports

When creating and customizing reports in Report mode, you can use the following ribbons and commands to customize report functionality.

Home Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format Group</td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Switches to Chart mode. Converts a report to a chart using the fields specified in the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Indicates that you are in Report mode.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report.</td>
</tr>
<tr>
<td>Design Group</td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the report.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the report on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a report into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Report Group**

| Theme        | Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the *Use Default Stylesheet* button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking *Options* in the Application main menu. |

---

Information Builders
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Opens a Report Style dialog box for applying global styling to the entire report. For more information about styling reports, see <em>Styling Reports</em>.</td>
</tr>
<tr>
<td>Banded</td>
<td>Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Adds a grand total row to the bottom of the report to sum numeric data in each column.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>Adds a grand total column to the right side of the report to sum numeric data in each row.</td>
</tr>
</tbody>
</table>

**Format Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination Group</strong></td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 234.</td>
</tr>
<tr>
<td>Chart</td>
<td>Switches to Chart mode. Converts a report to a chart using the fields specified in the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Indicates that you are in Report mode.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report.</td>
</tr>
<tr>
<td><strong>Navigation Group</strong></td>
<td></td>
</tr>
</tbody>
</table>
## Command Reference

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Generates standard browser output. This is the default.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking <em>Table of Contents</em> opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time. You can also select options to view the entire report or remove the table of contents.</td>
</tr>
<tr>
<td>Freeze</td>
<td>Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output.</td>
</tr>
<tr>
<td>Pages On Demand</td>
<td>Provides access to two distinct features, depending upon the output type that you have selected.</td>
</tr>
</tbody>
</table>

### Features Group

<table>
<thead>
<tr>
<th>Feature Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Popup</td>
<td>Displays pop-up titles when the mouse pointer hovers over a column title in the report output.</td>
</tr>
<tr>
<td>Accordion</td>
<td>Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.</td>
</tr>
<tr>
<td>Repeat Sort Value</td>
<td>Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.</td>
</tr>
<tr>
<td>Stack Measures</td>
<td>Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors. For more information, see <em>Using Active Technologies</em> on page 158.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508-compliant.</td>
</tr>
</tbody>
</table>

**Run with Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Drill</td>
<td>Enables you to navigate through different levels within the dimension hierarchy of your data source. Click <em>Auto Drill</em> to enable the functionality. For more information, see <em>Using Auto Drill</em>.</td>
</tr>
</tbody>
</table>

**Auto Linking Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Auto Linking</td>
<td>Enables auto linking. For more information, see <em>Using the Auto Linking Feature to Link Content</em>.</td>
</tr>
<tr>
<td>Auto Link Target</td>
<td>Sets procedure as an available target for auto linking.</td>
</tr>
</tbody>
</table>

**Data Tab**

**Calculation Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Join Group</strong></td>
<td></td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Missing Data</td>
<td>This option is disabled for reports.</td>
</tr>
<tr>
<td><strong>Data Source Group</strong></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document. This option is activated when you add a HOLD file. This option is unavailable, by default.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports. This option is activated when you add a HOLD file. This option is unavailable, by default.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Edit Slicers dialog box to the General tab, where you can set</td>
</tr>
<tr>
<td></td>
<td>general options for your slicers.</td>
</tr>
<tr>
<td></td>
<td><strong>Record Limit Group</strong></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td>Record Limit</td>
<td>Opens the Edit Slicers dialog box to the Record Limit tab, where you can</td>
</tr>
<tr>
<td></td>
<td>set record limits for your slicers.</td>
</tr>
<tr>
<td></td>
<td><strong>Group Number Group</strong></td>
</tr>
<tr>
<td>Group n</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the</td>
</tr>
<tr>
<td></td>
<td>default slicer group to which you can drag fields to create slicers. To</td>
</tr>
<tr>
<td></td>
<td>access slicer group options, click Group n to open the Edit Slicers dialog</td>
</tr>
<tr>
<td></td>
<td>box where you can rename the slicer group and modify the order of the</td>
</tr>
<tr>
<td></td>
<td>slicers in the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Layout Tab</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Page Setup Group</strong></td>
</tr>
<tr>
<td>Margins</td>
<td>Enables you to set margin values by choosing Normal (1 inch all around),</td>
</tr>
<tr>
<td></td>
<td>Narrow (.5 inch all around), Moderate (.5 inch left or right), Wide (1.5</td>
</tr>
<tr>
<td></td>
<td>inch left or right), or Custom. Choosing Custom opens the Margins dialog</td>
</tr>
<tr>
<td></td>
<td>box, where you can set specific margins as needed.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
</tbody>
</table>

Creating Content 369
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Enables you to select page numbering options. You can choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- No Lead (no space for headers)</td>
</tr>
<tr>
<td></td>
<td>- On (page numbers only in headers)</td>
</tr>
<tr>
<td></td>
<td>- Off (space for headers, but no page numbering)</td>
</tr>
<tr>
<td></td>
<td>The Page Numbers value is overridden by header and footer text options.</td>
</tr>
<tr>
<td>Report Group</td>
<td></td>
</tr>
<tr>
<td>Cell Padding</td>
<td>Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see Use Cell Padding in a Report.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>Limits the width of columns in a report to be no wider than the largest value in each column. AutoFit Column is selected, by default.</td>
</tr>
</tbody>
</table>

**View Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Group</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the report.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the report on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the report.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a report into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
</tbody>
</table>

**Show/Hide Group**

| Resources                      | Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane. |

**Data Panel Group**

| Logical                        | Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias. |
| List                           | Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference. |
| Structured                     | Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias. |

**Query Panel Group**

<p>| Areas 2x2                       | Displays data in a two column by two-row grid. |
| Areas 1x4                       | Displays data in a one column by four-row grid. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
</tbody>
</table>

**Output Window Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active reports, charts, documents, and visuals to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

**Filter Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the report.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Prompt    | Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a report. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:  
  - **Simple.** This is used for prompts using Text Input. This is the default value.  
  - **Static.** This is used for prompts using Selection. This option allows you to select multiple values at run time.  
  - **Dynamic.** This is used for prompts using Data Values. This option allows you to select multiple values at run time.  
  - **Optional.** This is used for prompts using Single or Multiselect parameters. |

<table>
<thead>
<tr>
<th>Sort Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Rank</td>
<td>Inserts a rank column immediately to the left of the report if a Sort By field is selected. It also adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field, and the Sort By field that is created during ranking. This option is activated when you click on a measure or dimension.</td>
</tr>
</tbody>
</table>
## Command Reference

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Group</strong></td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td><strong>Limit</strong></td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td><strong>Break Group</strong></td>
<td></td>
</tr>
<tr>
<td>Page Break</td>
<td>Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select Reset Page Numbers, which allows you to reset page numbers on a page break to start at 1. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Line Break</td>
<td>Inserts a line in the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Sub Header</td>
<td>Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Sub Footer</td>
<td>Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td><strong>Style Group</strong></td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Opens the Font list, which you can use to change the font.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Font Size</td>
<td>Opens the Font Size list, which you can use to change the numeric value for the font size.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Opens the Color dialog box, where you can select the font color.</td>
</tr>
<tr>
<td>Style Reset</td>
<td>Resets all settings to the default settings from the template.</td>
</tr>
<tr>
<td>Bold</td>
<td>Applies bold font formatting to the selected text.</td>
</tr>
<tr>
<td>Italic</td>
<td>Applies italic font formatting to the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Justify Left</td>
<td>Aligns the text to the left of the report.</td>
</tr>
<tr>
<td>Justify Center</td>
<td>Aligns the text to the center of the report.</td>
</tr>
<tr>
<td>Justify Right</td>
<td>Aligns the text to the right of the report.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Opens the Color dialog box, where you can select the background color for the report.</td>
</tr>
<tr>
<td>Data Style</td>
<td>Styles only the data for the selected data source field.</td>
</tr>
<tr>
<td>Title Style</td>
<td>Styles only the column title for the selected data source field.</td>
</tr>
<tr>
<td>Data + Title</td>
<td>Styles both the data and the column title for the selected data source field.</td>
</tr>
</tbody>
</table>

**Format Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>The default value for the data format of the selected measure is Decimal. Use the drop-down menu to select Alphanumeric, Integer, or More options to open the Field Format Options dialog box.</td>
</tr>
<tr>
<td>Change currency options</td>
<td>Changes the currency options for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percent</td>
<td>Specifies the value of the field as a percentage. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Comma</td>
<td>Specifies the use of commas for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Increase Decimal Places</td>
<td>Increases the number of decimal places that display for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Decrease Decimal Places</td>
<td>Decreases the number of decimal places that display for the selected field. This option is activated when you click on a measure.</td>
</tr>
</tbody>
</table>

**Display Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Enables you to apply an aggregation function to a field in a report. Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.</td>
</tr>
</tbody>
</table>
Within

Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.

Column(s)

This option is disabled for reports.

Links Group

Drill Down

Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure.

Ribbon Commands for Charts

When creating and customizing charts in Chart mode, you can use the following ribbons and commands to customize chart functionality.

Home Tab

Command Description

Format Group

Output File Format Displays a drop-down menu of all supported output formats.

Chart Indicates that you are in Chart mode.

Report Switches to Report mode. Converts a chart to a report using the fields specified in the chart.

File Creates an image file from a chart. This option is disabled by default and is only enabled for HTML format.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the chart.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the chart on the canvas as you create the chart. You can use the Live Preview to add, remove, and arrange fields, as well as style the chart.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Theme</td>
<td>Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking Options in the Application main menu.</td>
</tr>
<tr>
<td>Style</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Banded</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>This option is disabled for charts.</td>
</tr>
</tbody>
</table>

**Format Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Destination Group</td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 234.</td>
</tr>
<tr>
<td>Chart</td>
<td>Indicates that you are in Chart mode.</td>
</tr>
<tr>
<td>Report</td>
<td>Switches to Report mode. Converts a chart to a report using the fields specified in the chart.</td>
</tr>
<tr>
<td>File</td>
<td>Creates an image file from a chart. This option is disabled by default and is only enabled for HTML format.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Chart Types Group</strong></td>
<td></td>
</tr>
<tr>
<td>Bar</td>
<td>Changes the chart type to a bar chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Changes the chart type to a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Changes the chart type to a line chart.</td>
</tr>
<tr>
<td>Area</td>
<td>Changes the chart type to an area chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Changes the chart type to a scatter chart.</td>
</tr>
<tr>
<td>Choropleth</td>
<td>Changes the chart type to a choropleth map.</td>
</tr>
<tr>
<td>Proportional Symbol</td>
<td>Changes the chart type to a proportional symbol (bubble) map.</td>
</tr>
<tr>
<td><strong>Map Group</strong></td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td>Provides terrain options and various other geographical views. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Demographic Layers</td>
<td>Allows you to apply one or more pre-defined demographic layers, which can narrow the scope of your data using these underlying layers of demographic categorization. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Reference Layers</td>
<td>Enables you to define one or more reference layers, which creates borders based on your geographical selection. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Features Group</strong></td>
<td></td>
</tr>
<tr>
<td>3D Effect</td>
<td>Sets the three-dimensional view to on or off. The 3D Effect feature is disabled for 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This is the default. This option is not available for maps.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Toggles between a vertical display or horizontal display of a chart. For more information, see Rotate a Chart. The Rotate feature is disabled for pie, scatter, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This option is not available for maps.</td>
</tr>
<tr>
<td>Reference</td>
<td>Opens a drop-down menu that provides the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the appropriate Reference Line dialog box, where you can set the specific X-axis or Y-axis value, type the text that you want, and position the reference line on a chart. For more information, see Display a Static Reference Line. The Reference feature is disabled for pie, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This option is not available for maps.</td>
</tr>
<tr>
<td>Annotate</td>
<td>Opens a drop-down menu that provides the Add an annotation option. Selecting this option opens the Annotation dialog box, where you can type the text that you want and position the annotation on a chart. For more information, see Display Annotations. The annotation option is not available in HTML5. This option is not available for maps.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Grid</td>
<td>Opens a drop-down menu allowing you to expand options for Horizontal or Vertical Gridlines. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking <em>More Options</em> opens the Format Grid Lines dialog box. This option is not available for maps. For more information, see <em>Formatting Gridlines</em>.</td>
</tr>
<tr>
<td>Frame &amp; Background</td>
<td>Opens the Frame &amp; Background dialog box where you can edit the background style and frames for charts. The dialog contains different options depending on the chart type selected. For more information, see <em>Formatting a Frame and a Background</em>.</td>
</tr>
<tr>
<td>Gauges</td>
<td>Opens the Gauge dialog box where you can edit your gauge chart. This button is only available when a gauge chart type is selected. This option is not available for maps. For more information, see <em>Style a Gauge Needle</em>.</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options, such as menu items, graph engine, and colors. This button is available when the output type is set to active report. This option is not available for maps.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508 compliant. This option is only available for reports and charts when the output type is HTML, HTML5, or PDF. For documents, the output type must be set to PDF. The chart features are unavailable when designing a chart that will be output in active report format. This option is not available for maps.</td>
</tr>
</tbody>
</table>

**Labels Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes</td>
<td>Opens a drop-down menu, where you can enable and rotate horizontal and vertical axis labels, and stagger horizontal axis labels. You can also edit the axis labels by clicking <em>More Horizontal Axis Options</em> or <em>More Vertical Axis Options</em>. For more information, see <em>Format Axis Labels</em>. This option is not available for maps.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens a drop-down menu, where you can select the Show Legend option to display the legend on the chart, or clear your selection to hide the legend, change the default legend position, and change the default legend orientation. For more information, see <em>Format Legend Dialog Box</em>.</td>
</tr>
<tr>
<td><strong>Interactive Group</strong></td>
<td></td>
</tr>
<tr>
<td>Interactive Options</td>
<td>Opens the Interactive Options dialog box, which enables you to specify animation and mouse over effects in your chart. This option is only available for HTML5 and active outputs. This option is not available for maps.</td>
</tr>
<tr>
<td><strong>Run with Group</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Drill</td>
<td>Enables you to navigate through different levels within the dimension hierarchy of your data source. Click <em>Auto Drill</em> to enable the functionality.</td>
</tr>
<tr>
<td><strong>Note:</strong> Auto Drill functionality requires the specification of at least one dimension sort field in the request. For more information, see <em>Using Auto Drill</em>.</td>
<td></td>
</tr>
<tr>
<td>Insight</td>
<td>Enables you to activate Insight, a powerful visualization tool that allows for the interactive selection of measures and dimensions. This allows you to create dynamic charts in real-time. This feature is available in HTML5 Chart mode only. Click <em>Insight</em> to enable the feature, and then click <em>Run</em> to launch it. For more information, see <em>Using Insight to Analyze Dynamic Charts</em> on page 43.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Auto Linking Group</strong></td>
<td></td>
</tr>
<tr>
<td>Enable Auto Linking</td>
<td>Enables auto linking.</td>
</tr>
<tr>
<td>Auto Link Target</td>
<td>Sets procedure as an available target for auto linking.</td>
</tr>
<tr>
<td><strong>Data Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td><strong>Calculation Group</strong></td>
<td></td>
</tr>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
<tr>
<td><strong>Join Group</strong></td>
<td></td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box, enabling you to set filtering options. Filter options include Where, Where Total, the And conjunction, and the Or conjunctions in a single expression.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Missing Data</td>
<td>Includes options for how to display missing values in charts.</td>
</tr>
</tbody>
</table>

**Data Source Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document. This option is only enabled if the chart was created from a HOLD file.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports. This option is only enabled if the chart was created from a HOLD file.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Edit Slicers dialog box to the General tab, where you can set general options for your slicers.</td>
</tr>
<tr>
<td><strong>Record Limit Group</strong></td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Record Limit</td>
<td>Opens the Edit Slicers dialog box to the Record Limit tab, where you can set record limits for your slicers.</td>
</tr>
</tbody>
</table>

**Group Number Group**

| Group n            | Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers. To access slicer group options, click Group n to open the Edit Slicers dialog box where you can rename the slicer group and modify the order of the slicers in the group. |

**Layout Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Setup Group</strong></td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>Enables you to set margin values by choosing Normal (1 inch all around), Narrow (.5 inch all around), Moderate (.5 inch left or right), Wide (1.5 inch left or right), or Custom. Choosing Custom opens the Margins dialog box, where you can set specific margins as needed.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report or chart. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>This option is disabled for charts.</td>
</tr>
</tbody>
</table>

**Size & Arrange Group**
### Command Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height</td>
<td>Sets the height of the chart.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the chart.</td>
</tr>
<tr>
<td>Auto Overflow</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Lock the height and width aspect ratio. With the aspect ratio locked, changing the width automatically changes the height to keep the component to scale, and changing the height automatically changes the width.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>Expands the chart, at design time, when additional fields are added. At run time, the chart is resized dynamically to fit into the container in which it is placed. AutoFit is enabled, by default.</td>
</tr>
<tr>
<td>Align</td>
<td>This option is available in Document mode only.</td>
</tr>
<tr>
<td>Relative Position</td>
<td>This option is available in Document mode only.</td>
</tr>
</tbody>
</table>

### View Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the chart.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the chart on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the chart.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a chart into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane.</td>
</tr>
<tr>
<td><strong>Data Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td><strong>Query Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Areas 2x2</td>
<td>Displays data in a two column by two-row grid. This option is disabled for charts that use the new field container syntax.</td>
</tr>
<tr>
<td>Areas 1x4</td>
<td>Displays data in a one column by four-row grid. This option is disabled for charts that use the new field container syntax.</td>
</tr>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
<tr>
<td><strong>Output Window Group</strong></td>
<td></td>
</tr>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

**Note:** The Format group is disabled in Chart mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Group</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the chart.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a chart.</td>
</tr>
</tbody>
</table>
### Command | Description
--- | ---
Prompt | Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a chart. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:

- **Simple.** This is used for prompts using Text Input. This is the default value.
- **Static.** This is used for prompts using Selection. This option allows you to select multiple values at run time.
- **Dynamic.** This is used for prompts using Data Values. This option allows you to select multiple values at run time.
- **Optional.** This is used for prompts using Single or Multiselect parameters.

### Sort Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order.</td>
</tr>
<tr>
<td>Rank</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. This option is enabled for dimension fields only.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added.</td>
</tr>
</tbody>
</table>

### Format Group

**Note:** These options are disabled for charts.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value. This option is disabled for charts.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square. This option is only available for measure fields or dimensions (alpha field only) that are in a numeric field container. Otherwise, aggregations will not display.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down. This option is only available for measure fields.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column. This option is disabled for charts.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query Design pane shortcut menu for a Multi-graph component. This option is only enabled when the multi-graph field container is populated.</td>
</tr>
</tbody>
</table>

**Links Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure. This option is available for measure fields only. If you are working in PDF format, this option is disabled.</td>
</tr>
</tbody>
</table>

### Series Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Group</td>
<td></td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current chart.</td>
</tr>
<tr>
<td>Style Group</td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
<tr>
<td>Properties Group</td>
<td></td>
</tr>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines. Clicking More Data Label Options opens the Format Labels dialog box, where you can further edit your data labels.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Type</td>
<td>Opens a drop-down menu with the following options for selecting different chart types: None (default), Bar, Line, and Area.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you make a change to the chart type using the Type button on the Series tab, changes to the chart type on the Format tab are overwritten.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
<tr>
<td>Equation</td>
<td>Displays the associated mathematical equation for the selected trendline on the chart. The equation is not available in HTML5.</td>
</tr>
</tbody>
</table>

**Line Group**

<table>
<thead>
<tr>
<th>Smooth Line</th>
<th>Draws the chart using smooth lines.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect Lines</td>
<td>Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart.</td>
</tr>
<tr>
<td>Marker</td>
<td>Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see <em>Change the Appearance of a Marker</em>.</td>
</tr>
</tbody>
</table>

**Pie Group**

**Note:** The following options are only enabled when you are working with a pie chart.

<table>
<thead>
<tr>
<th>Expand</th>
<th>Expands pie slices.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>

**Ribbon Commands for Documents**

When creating and customizing documents in Document mode, you can use the following ribbons and commands to customize document functionality.
## Home Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Group</strong></td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Determines whether chart-specific functionality is available in the InfoAssist tool. The default name Chart (data source) is given for each new chart created in a given InfoAssist session, where data source is the name of the underlying data source you are using. You can rename the chart by right-clicking Chart in the Query pane and clicking Rename.</td>
</tr>
<tr>
<td>Report</td>
<td>Determines whether report-specific functionality is available in the InfoAssist tool. The default name Report (data source) is given for each new report created in a given InfoAssist session, where data source is the name of the underlying data source you are using. You can rename the report by right-clicking Report in the Query pane and clicking Rename.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report component of a document.</td>
</tr>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Once you are in Document mode, it is selected by default in the Design group. The document displays on the canvas, to which you can add text, images, lines, reports, and charts.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Clipboard Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Paste</td>
<td>Enables you to paste a text, report, or chart object that you have copied to or placed on the clipboard.</td>
</tr>
<tr>
<td>Cut</td>
<td>Enables you to cut a text, report, or chart object from your document, placing it on the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Enables you to copy a text, report, or chart object to the clipboard.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Enables you to duplicate a text, report, or chart object in your document, placing it on the clipboard.</td>
</tr>
</tbody>
</table>

**Report Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theme</td>
<td>Opens a dialog box where you can select a theme to style your report or chart. You can use the default stylesheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking <em>Options</em> in the Application main menu.</td>
</tr>
<tr>
<td>Style</td>
<td>Opens a Report Style dialog box for applying global styling to the entire report. This option is disabled for charts in Document mode. For more information about styling reports, see <em>Styling Reports</em>.</td>
</tr>
<tr>
<td>Banded</td>
<td>Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report. This option is disabled for charts in Document mode.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Adds a grand total row to the bottom of the report to sum numeric data in each column. This option is disabled for charts in Document mode.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>Adds a grand total column to the right side of the report to sum numeric data in each row. This option is disabled for charts in Document mode.</td>
</tr>
</tbody>
</table>
## Insert Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pages Group</strong></td>
<td></td>
</tr>
<tr>
<td>Page</td>
<td>Adds a new page to a document.</td>
</tr>
<tr>
<td><strong>Reports Group</strong></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>Inserts a report placeholder on the canvas.</td>
</tr>
<tr>
<td>Chart</td>
<td>Inserts a chart placeholder on the canvas.</td>
</tr>
<tr>
<td>Existing Report</td>
<td>Opens the Open dialog box, where you can browse to the report that you want to insert in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td><strong>Objects Group</strong></td>
<td></td>
</tr>
<tr>
<td>Text Box</td>
<td>Inserts an inline text object in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Image</td>
<td>Opens the Open dialog box, where you can browse to the image that you want to insert in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td><strong>active dashboard Prompts group</strong></td>
<td></td>
</tr>
<tr>
<td>Drop Down</td>
<td>Inserts a drop-down control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>List</td>
<td>Inserts a list control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Inserts a check box control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Radio Button</td>
<td>Inserts a radio button control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Text</td>
<td>Inserts a text area control placeholder in the upper-left corner of the canvas.</td>
</tr>
</tbody>
</table>
## Format Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination Group</strong></td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 234.</td>
</tr>
<tr>
<td>Report</td>
<td>Makes report-specific functionality available. In Document mode, if you select a report object, the Report option is enabled on the Home tab and the ribbon options change. For more information, see <em>Ribbon Commands for Reports</em> on page 363.</td>
</tr>
<tr>
<td>Chart</td>
<td>Makes chart-specific functionality available. In Document mode, if you select a chart object, the Chart option is enabled on the Home tab and the ribbon options change. For more information, see <em>Ribbon Commands for Charts</em> on page 377.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report component of a document.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Navigation Group</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Table</td>
<td>Generates standard browser output. This is the default. This option is only available for reports in Document mode.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking <em>Table of Contents</em> opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time. You can also select options to view the entire report or remove the table of contents. This option is unavailable for charts in Document mode, and is disabled for reports in Document mode.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Freeze</td>
<td>Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output. This option is unavailable for charts in Document mode, and is disabled for reports in Document mode.</td>
</tr>
<tr>
<td>Pages On Demand</td>
<td>Provides access to two distinct features depending upon the output type that you have selected. This option is available for reports in Document mode.</td>
</tr>
<tr>
<td><strong>Features Group</strong></td>
<td></td>
</tr>
<tr>
<td>Title Popup</td>
<td>Displays pop-up titles when the mouse pointer hovers over a column title in the report output.</td>
</tr>
<tr>
<td>Accordion</td>
<td>Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.</td>
</tr>
<tr>
<td>Repeat Sort Value</td>
<td>Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.</td>
</tr>
<tr>
<td>Stack Measures</td>
<td>Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors. For more information, see Using Active Technologies on page 158.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508-compliant.</td>
</tr>
<tr>
<td><strong>Run with Group</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Drill</td>
<td>This option is disabled in Document mode.</td>
</tr>
</tbody>
</table>
## Command Reference

### Insight
- **Description**: This option is disabled in Document mode.

### Data Tab

#### Calculation Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
</tbody>
</table>

#### Join Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
</tbody>
</table>

#### Filter Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box, enabling you to set filtering options. Filter options include Where, Where Total, the And conjunction, and the Or conjunctions in a single expression.</td>
</tr>
</tbody>
</table>

#### Display Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing Data</td>
<td>Includes options for how to display missing values in charts.</td>
</tr>
</tbody>
</table>

#### Data Source Group
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td><strong>Record Limit Group</strong></td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td><strong>Group Number Group</strong></td>
<td></td>
</tr>
<tr>
<td>Group n</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers.</td>
</tr>
</tbody>
</table>
## Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Setup Group</strong></td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report or chart. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Enables you to select page numbering options. You can choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- No Lead (no space for headers)</td>
</tr>
<tr>
<td></td>
<td>- On (page numbers only in headers)</td>
</tr>
<tr>
<td></td>
<td>- Off (space for headers, but no page numbering)</td>
</tr>
<tr>
<td></td>
<td>The Page Numbers value is overridden by header and footer text options.</td>
</tr>
<tr>
<td>Adaptive Dashboard</td>
<td>Available on for Active Documents, allows you to create responsive content within a fixed layout designed to make the dashboard easier to use while navigating on mobile devices.</td>
</tr>
<tr>
<td><strong>Size &amp; Arrange Group</strong></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>Sets the height of the selected document component.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the selected document component.</td>
</tr>
<tr>
<td>Auto Overflow</td>
<td>Automatically expands the query area to show all data.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Lock the height and width aspect ratio.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>In Document mode, this option is disabled.</td>
</tr>
<tr>
<td>Align</td>
<td>Opens a drop-down menu of available alignment options, when two or more document components are selected.</td>
</tr>
<tr>
<td>Relative Position</td>
<td>Positions the top-left corner of the lower component, to the bottom-left corner of the higher component, when two or more document components are selected.</td>
</tr>
<tr>
<td>Size and Arrange</td>
<td>Opens the Size and Position dialog box where you can set size and position options for the object in your document.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Padding</td>
<td>Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see <em>Use Cell Padding in a Report</em>.</td>
</tr>
<tr>
<td>Autofit Column</td>
<td>When working with a report component, this option automatically compresses the columns in the report to the width of the widest data instance. Autofit Column is selected, by default.</td>
</tr>
</tbody>
</table>

**View Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>This option is unavailable in Document mode.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>This option is unavailable in Document mode.</td>
</tr>
<tr>
<td>Document</td>
<td>Enables Document mode by default.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Show/Hide Group</strong></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane.</td>
</tr>
<tr>
<td>Ruler</td>
<td>Displays a ruler above the canvas and to the left of the canvas for a document.</td>
</tr>
<tr>
<td>Grid</td>
<td>Displays a grid as a visual aid for aligning objects in a document.</td>
</tr>
<tr>
<td>Relationships</td>
<td>Shows the relative positioning relationship among objects.</td>
</tr>
<tr>
<td><strong>Data Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td><strong>Query Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Areas 2x2</td>
<td>Displays data in a two column by two-row grid. When working with the new field container syntax, this option is unavailable.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Areas 1x4</td>
<td>Displays data in a one column by four-row grid. When working with the new field container syntax, this option is unavailable.</td>
</tr>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
</tbody>
</table>

**Output Window Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Group</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the report or chart.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a report or chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Prompt</td>
<td>Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a report. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Simple.</strong> This is used for prompts using Text Input. This is the default value.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Static.</strong> This is used for prompts using Selection. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Dynamic.</strong> This is used for prompts using Data Values. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Optional.</strong> This is used for prompts using Single or Multiselect parameters.</td>
</tr>
<tr>
<td>Sort Group</td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order.</td>
</tr>
<tr>
<td>Rank</td>
<td>Inserts a rank column immediately to the left of the report if a Sort By field is selected. It also adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field, and the Sort By field that is created during ranking.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added.</td>
</tr>
<tr>
<td><strong>Break Group</strong></td>
<td></td>
</tr>
<tr>
<td>Page Break</td>
<td>Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select Reset Page Numbers, which allows you to reset page numbers on a page break to start at 1.</td>
</tr>
<tr>
<td>Line Break</td>
<td>Inserts a line in the report output when the primary sort field changes.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes.</td>
</tr>
<tr>
<td>Sub Header</td>
<td>Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes.</td>
</tr>
<tr>
<td>Sub Footer</td>
<td>Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes.</td>
</tr>
<tr>
<td><strong>Style Group</strong></td>
<td></td>
</tr>
<tr>
<td>Note: The options in this group are only available for reports in Document mode.</td>
<td></td>
</tr>
<tr>
<td>Font</td>
<td>Opens the Font list, which you can use to change the font.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Opens the Font Size list, which you can use to change the numeric value for the font size.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Opens the Color dialog box, where you can select the font color.</td>
</tr>
<tr>
<td>Style Reset</td>
<td>Resets all settings to the default settings from the template.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------</td>
</tr>
<tr>
<td>Bold</td>
<td>Applies bold font formatting to the selected text.</td>
</tr>
<tr>
<td>Italic</td>
<td>Applies italic font formatting to the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Justify Left</td>
<td>Aligns the text to the left of the visual.</td>
</tr>
<tr>
<td>Justify Center</td>
<td>Aligns the text to the center of the visual.</td>
</tr>
<tr>
<td>Justify Right</td>
<td>Aligns the text to the right of the visual.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Opens the Color dialog box, where you can select the background color for the visual.</td>
</tr>
<tr>
<td>Data Style</td>
<td>Styles only the data for the selected data source field.</td>
</tr>
<tr>
<td>Title Style</td>
<td>Styles only the column title for the selected data source field.</td>
</tr>
<tr>
<td>Data + Title</td>
<td>Styles both the data and the column title for the selected data source field.</td>
</tr>
</tbody>
</table>

**Format Group**

**Note:** The options in this group are only available for reports in Document mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change currency options</td>
<td>Changes the currency options for the selected field.</td>
</tr>
<tr>
<td>Percent</td>
<td>Specifies the value of the field as a percentage.</td>
</tr>
<tr>
<td>Comma</td>
<td>Specifies the use of commas for the selected field.</td>
</tr>
<tr>
<td>Increase Decimal Places</td>
<td>Increases the number of decimal places that display for the selected field.</td>
</tr>
<tr>
<td>Decrease Decimal Places</td>
<td>Decreases the number of decimal places that display for the selected field.</td>
</tr>
</tbody>
</table>

**Display Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down.</td>
</tr>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query Design pane shortcut menu for a Multi-graph component.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure. This option is disabled in Document mode.</td>
</tr>
</tbody>
</table>

**Series Tab**

In Document mode, the Series tab is enabled for chart components.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Group</td>
<td></td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current chart.</td>
</tr>
<tr>
<td>Style Group</td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
<tr>
<td>Properties Group</td>
<td></td>
</tr>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines. Clicking More Data Label Options opens the Format Labels dialog box, where you can further edit your data labels.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Line Group</strong></td>
<td></td>
</tr>
<tr>
<td>Smooth Line</td>
<td>Draws the chart using smooth lines.</td>
</tr>
<tr>
<td>Connect Lines</td>
<td>Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart.</td>
</tr>
<tr>
<td>Marker</td>
<td>Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see <em>Change the Appearance of a Marker</em>.</td>
</tr>
<tr>
<td><strong>Pie group</strong></td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The following options are only enabled when you are working with a pie chart.</td>
</tr>
<tr>
<td>Expand</td>
<td>Expands pie slices.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>

**Ribbon Commands for Visualizations**

When creating and customizing visualizations in Visualizations mode, you can use the following ribbons and commands to customize visualization functionality.

**Home Tab**

<table>
<thead>
<tr>
<th><strong>Command</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clipboard Group</strong></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Enables you to paste a text, report, or chart object that you have copied to or placed on the clipboard.</td>
</tr>
<tr>
<td>Cut</td>
<td>Enables you to cut a text, report, or chart object from your document, placing it on the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Enables you to copy a text, report, or chart object to the clipboard.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Enables you to duplicate a text, report, or chart object in your document, placing it on the clipboard.</td>
</tr>
</tbody>
</table>

**Data Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calculation</td>
<td>Opens a menu from which you can choose to create Define or Compute fields.</td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join. You can also create blends, which allow you to combine data from local or system resources into your current data source.</td>
</tr>
</tbody>
</table>

**Visual Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Insert</td>
<td>Inserts a new visual. The left side of the Insert button inserts the default visual, which is a stacked bar chart. Click the down arrow next to the Insert button to specify a visual type, such as a chart, grid, or text.</td>
</tr>
<tr>
<td>Change</td>
<td>Opens the Select a Visual menu, from which you can select the type of chart, map, or grid that you want to add to your visualization.</td>
</tr>
</tbody>
</table>
| Swap | Changes the vertical or horizontal orientation of data in a visual. When you add one or more fields to the canvas, Swap is enabled. When you have data fields in the vertical and horizontal field containers, clicking Swap switches the axis of these data fields to display on the opposite axis. When working with matrix charts, the rows and columns are similarly switched when you click Swap. Swap is available for bar, line, area, scatter, bubble, and matrix marker charts. It is also available for grids. **Note:**
- Swap is disabled when the canvas is empty.
- Swap is unavailable for maps. |
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear</td>
<td>Clears the current visual. You can use the split button to select the option to clear a component, or the entire visualization, which clears all visuals on the canvas. If you have created a filter, you can also clear it. The Clear button is disabled until you begin developing a visual on the canvas.</td>
</tr>
<tr>
<td><strong>Storyboard Group</strong></td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Takes a snapshot of the current visual or visualization, adding it to the storyboard.</td>
</tr>
<tr>
<td>Show</td>
<td>Opens your storyboard as a PowerPoint presentation, where you can choose to view or save your storyboard. All storyboards display in Microsoft PowerPoint format.</td>
</tr>
<tr>
<td><strong>Format Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Report Group</strong></td>
<td></td>
</tr>
<tr>
<td>Theme</td>
<td>Opens the Templates dialog box, where you can select a theme to style your grid. You can use the default style sheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a styling theme for your grid or an application theme to style all visualizations created.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Adds a grand total row to the bottom of the grid object to sum numeric data in each column.</td>
</tr>
</tbody>
</table>

**Features Group**

*Note:* These options do not display for grids or maps, with the exception of Frame & Background.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reference</td>
<td>Opens the reference menu, where you can access the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the Reference Line dialog box, where you can set the following: the X-axis or Y-axis value, the text that you want to appear, and the position of the reference line on a chart.</td>
</tr>
<tr>
<td>Grid</td>
<td>Opens the grid menu, where you can access the Horizontal or Vertical Gridlines options. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking More Grid Lines Options opens the Format Grid Lines dialog box.</td>
</tr>
<tr>
<td>Frame &amp; Background</td>
<td>Opens the Frame &amp; Background dialog box, where you can edit the background style and frames for charts. This dialog box contains different options depending on the chart type that you have selected.</td>
</tr>
</tbody>
</table>

**Labels Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes</td>
<td>Opens the Axes menu, where you can enable and rotate horizontal and vertical axis labels, as well as stagger horizontal axis labels. You can also edit the axis labels by clicking More Vertical Axis Options or More Horizontal Axis Options. This option does not display for grids or maps.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens the Legend menu, where you can select the Show Legend option to display the legend on the chart. You can also clear your selection to hide the legend. In addition, you can change the default legend position and orientation. This option displays for maps but does not display for grids.</td>
</tr>
</tbody>
</table>

**Interactive Group**

**Note:** These options do not display for grids or maps.
### Interactive Options

Opens the Interactive Options dialog box, which enables you to specify animation and mouse over effects in your chart.

### View Tab

#### Show/Hide Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel, expanding the size of the canvas to occupy the area where the Resources panel typically appears. When you click the Resources button again, the Resources panel displays and the chart, map, or grid adjusts accordingly.</td>
</tr>
</tbody>
</table>

#### Data Panel Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
</tbody>
</table>

#### Report Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>
### Field Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> Options on the Field tab are contingent on the visual type that you select.</td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Select an existing filter in the Filter pane and choose <em>Exclude</em> to remove, but not delete, the filter from the visual.</td>
</tr>
<tr>
<td>Include</td>
<td>Select an existing filter in the Filter pane and choose <em>Include</em> to restore the filter, which was previously excluded from the visual.</td>
</tr>
<tr>
<td><strong>Sort Group</strong></td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>Down</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. For grids, this option is activated when you select a dimension.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Hides a selected field.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Specifies an aggregation for a specific field. Commonly used options include: Sum, Average, Count, Minimum, and Maximum.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Specifies conditional styling to the selected field.</td>
</tr>
</tbody>
</table>

### Series Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Group</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> This group is not available for grids. For maps, this group is disabled.</td>
<td></td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current visualization.</td>
</tr>
<tr>
<td><strong>Style Group</strong></td>
<td></td>
</tr>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
<tr>
<td><strong>Properties Group</strong></td>
<td></td>
</tr>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
<tr>
<td><strong>Line Group</strong></td>
<td></td>
</tr>
<tr>
<td>Smooth Line</td>
<td>Draws the chart using smooth lines.</td>
</tr>
<tr>
<td>Connect Lines</td>
<td>Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Marker</td>
<td>Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see Change the Appearance of a Marker.</td>
</tr>
</tbody>
</table>

**Pie Group**

*Note:* The following options are only enabled when you are working with a pie chart.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expand</td>
<td>Expands pie slices.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>
Feedback

Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor, Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.